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Important Information

Avid recommends that you read all the information in this ReadMe file thoroughly before
installing or using any new software release.

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which
contains the latest information that might have become available after the documentation was
published.

If you are upgrading to this version of the Interplay software, see “Database Changes for

Upgrading Systems Earlier than v2.3” on page 23.

Before installing software, see “Installing and Configuring Interplay Software” on page 19
and “Upgrading Interplay Software” on page 19.
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Legal Notices

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may
only be used in accordance with the license agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 5,309,528; 5,355,450;
5,396,594; 5,440,348; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,577,190; 5,584,006; 5,640,601; 5,644,364; 5,654,737;
5,724,605; 5,726,717, 5,745,637, 5,752,029; 5,754,851, 5,799,150; 5,812,216, 5,828,678; 5,842,014; 5,852,435; 5,986,584,
5,999,406; 6,038,573; 6,141,007; 6,211,869; 6,532,043; 6,546,190; 6,596,031; 6,747,705; 6,763,523; 6,766,357; 6,847,373;
7,081,900; 7,403,561; 7,433,519; 7,555,557; 7,562,099; D352,278; D372,478; D373,778; D392,267; D392,268; D392,269;
D395,291; D396,853; D398,912; and 8,082,226. Other patents are pending.

Avid products or portions thereof are protected by one or more of the following European Patents: 0506870; 0635188; 0674414;
0752174; 1111910; 1629675. Other patents are pending.

This document is protected under copyright law. An authorized licensee of Avid Interplay may reproduce this publication for the
licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for
commercial purposes, such as selling copies of this document or providing support or educational services to others. This document
is supplied as a guide for Avid Interplay. Reasonable care has been taken in preparing the information it contains. However, this
document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept
responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change without
notice.

Copyright © 20012 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:

APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION
MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER
RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:

Copyright © 1988—1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE,
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS
PROVIDED “"AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Copyright (C) 1989, 1991 by Jef Poskanzer.
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Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice
appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1995, Trinity College Computing Center. Written by David Chappell.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice
appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1996 Daniel Dardailler.

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any
purpose. It is provided "as is" without express or implied warranty.

Modifications Copyright 1999 Matt Koss, under the same license as above.
Copyright (c) 1991 by AT&T.

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the
supporting documentation for such software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR,
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:

© 2010 Nexidia Inc. All rights reserved, worldwide. Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other
trademarks are the property of their respective owners. All Nexidia materials regardless of form, including without limitation,
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the
exclusive property of Nexidia Inc. or its licensors. The Nexidia products and services described in these materials may be covered
by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other
patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:

“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of
reseller’'s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised,
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.”

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source
Code:

©1993-1998 Altura Software, Inc.
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The following disclaimer is required by Ultimatte Corporation:

Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.
This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:

JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection
with Avid Interplay.

Interplay Production Streaming Server includes Live555, which is covered by the GNU Lesser General Public
License. “Live555 is Copyright (c) 1996-2011, Live Networks, Inc. and is licensed under the terms of the GNU
Lesser General Public License, which is included with this product.”

This product includes software developed by Indiana University Extreme! Lab (http//:www.extreme.indiana.edu/)/

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks

003, 192 Digital I/0, 192 1/O, 96 1/0, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive I, Assistant
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid
DNxHD, Avid DS Assist Station, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid Remote
Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Axiom, Beat Detective, Beauty
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Boom, Bruno, C|24, CaptureManager, ChromaCurve,
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command]|8, Conectiv,
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, Dazzle, Dazzle Digital Video Creator, D-Command, D-Control, Deko,
DekoCast, D-Fi, D-fx, Digi 003, DigiBase, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Development Partners,
Digidesign Intelligent Noise Reduction, Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial,
DigiSnake, DigiSystem, Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange,
DPP-1, D-Show, DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase,
Expander, ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame
Chase, FXDeko, HD Core, HD Process, HDPack, Home-to-Hollywood, HYBRID, HyperControl, HyperSPACE, HyperSPACE
HDCAM, iKnowledge, Image Independence, Impact, Improv, INEWS, iNEWS Assign, INEWS ControlAir, Instantwrite, Instinct,
Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording
Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, ISIS, IsoSync, iS9, iS18, iS23, iS36, ISIS, IsoSync, KeyRig,
KeyStudio, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, Luna, MachineControl, Magic Mask,
Make Anything Hollywood, make manage move | media, Marquee, MassivePack, Massive Pack Pro, M-Audio, M-Audio Micro,
Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMatch, MediaMix, Media Reader, Media Recorder, MEDIArray,
MediaServer, MediaShare, MetaFuze, MetaSync, MicroTrack, MIDI I/O, Midiman, Mix Rack, MixLab, Moviebox, Moviestar,
MultiShell, NaturalMatch, NewsCutter, NewsView, Nitris, NL3D, NLP, Nova, NRV-10 interFX, NSDOS, NSWIN, Octane, OMF, OMF
Interchange, OMM, OnDVD, Open Media Framework, Open Media Management, Ozone, Ozonic, Painterly Effects, Palladium,
Personal Q, PET, Pinnacle, Pinnacle DistanTV, Pinnacle GenieBox, Pinnacle HomeMusic, Pinnacle MediaSuite, Pinnacle Mobile
Media, Pinnacle Scorefitter, Pinnacle Studio, Pinnacle Studio MovieBoard, Pinnacle Systems, Pinnacle VideoSpin, Podcast Factory,
PowerSwap, PRE, ProControl, ProEncode, Profiler, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, Pro Tools, QuickPunch,
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, Scorefitter, ScriptSync,
SecureProductionEnvironment, Serv|LT, Serv|GT, Session, Shape-to-Shape, ShuttleCase, Sibelius, SIDON, SimulPlay,


http://www.apache.org/
http://jcifs.samba.org/
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SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, Solaris, SoundReplacer, SPACE, SPACEShift,
SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, Strike, Structure, Studiophile, SubCap,
Sundance Digital, Sundance, SurroundScope, Symphony, SYNC HD, Synchronic, SynchroScope, SYNC I/O, Syntax, TDM
FlexCable, TechFlix, Tel-Ray, Thunder, Titansync, Titan, TL Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxider, TL In
Tune, TL MasterMeter, TL Metro, TL Space, TL Ultilities, tools for storytellers, Torq, Torq Xponent, Transfuser, Transit, TransJammer,
Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Video the Web Way, VideoRAID, VideoSPACE, VideoSpin,
VTEM, Work-N-Play, Xdeck, X-Form, Xmon, XPAND!, Xponent, X-Session, and X-Session Pro are either registered trademarks or
trademarks of Avid Technology, Inc. in the United States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries. Apple and are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a
registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks
contained herein are the property of their respective owners.

Avid Interplay Version 2.7 ReadMe « 0130-07648-09 B « Created 9/6/12 « This document is distributed by Avid in
online (electronic) form only, and is not available for purchase in printed form.
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Hardware and Software Requirements

Hardware and Software Requirements

Interplay Server Slot Locations

For information on slot locations for AS3000 servers, see Migrating Avid Interplay Applications
to AS3000 Servers. Also see “Support for AS3000 Servers” on page 17.

For information on the slot locations for SR2500 servers, see the Avid Interplay Software
Installation and Configuration Guide.

Supported Software

The section describes backwards compatibility between editor and Interplay releases. It also lists
the supported software for Avid Interplay v2.7.

Avid Editing Application Compatibility with Interplay Releases
The following Knowledge base articles provide information on compatibility between Interplay
releases and editor releases:
*  See the Knowledge Base article “Interplay and Avid Editor Compatibility.”

+  For details on the operating system (PC and Mac), QuickTime version, and nVidea drivers
supported on the different editor releases, see the Avid editing application Readme and the
Knowledge Base article “Avid Media Composer Version Matrix.”
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Interplay and Supporting Software Components

Hardware and Software Requirements

The following table lists the software components for Interplay v2.7.

Supported Software for Interplay Components and Related Software

Product Version
Avid Interplay products

Avid Interplay Engine v2.7
Avid Interplay Archive Engine v2.7
Avid Interplay Media Indexer v2.7.1
Avid Interplay Access v2.7
Avid Interplay Assist (Windows 7 64 Pro) v2.7
Avid Instinct (Windows 7 64 Pro) v4.5
NVIDIA driver for Assist and Instinct v275.89
Avid Interplay Transfer See “Additional Information for v2.7
Interplay Transfer Upgrades” on page 39.

Avid Interplay Central v1.2.0
Avid Interplay Sphere v1.0
Windows 7 64-bit (Professional) supported for Standalone  Yes
Interplay Transfer

Windows Server 2008 and Windows 7 64-bit Professional ~ SP1

See “Support for AS3000 Servers” on page 17.

Microsoft Windows XP support SP3
Avid Interplay Media Services v2.7
Avid Interplay ProEncode™ v2.7
Avid CaptureManager™ v4.2.1.5
Avid Interplay Capture vl.4
Avid Service Framework vl.5.1
iNEWS Server v3.3.1

11



Supported Software for Interplay Components and Related Software

(Continued)

Hardware and Software Requirements

Product Version
Avid Shared Storage products

Avid Unity MediaNetwork v5.1.3%
Avid ISIS 7000

» System Director « v4.0.1
* Client « v4.l
Avid ISIS 5000

» System Director « v4.0
* Client « v4.l
Avid ISIS 2000

» System Director o v4l
* Client « v4.l
Productivity Tools

Pro Tools 10.0

See “Additional Information About Pro Tools” on page 41

Avid AirSpeed® v2.7.11
Avid AirSpeed Multi Stream v1.8.7
AirSpeed 5000 2.1.0
Avid Low Res Encode bootset v1.5.3.5635
Avid Low Res Encode root disk image v2.3
SGL Flashnet™ server (used for Interplay Archive) v6.4
SGL Flashnet client v6.1
Omneon System Manager 5.5.1.7

AirSPACE™

Avid Thunder®

12
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Supported Software for Interplay Components and Related Software
(Continued)

Product Version

Encoding providers

Telestream FlipFactory™ v7.2 See “Telestream
Support” on page 81.

Anystream™ Agility® v5.8 See “Anystream
Support” on page 82.

a. See “Avid Unity MediaNetwork Compatibility with the Interplay Engine” on page 21.

Intel SR2400 Servers not Supported on Interplay v2.6 and Higher

The final version of Avid Interplay Production which will support the SR2400 platform is v2.5,
released in September 201 1. Interplay Production was shipped on the SR2400 from Nov 2006 to
Sept 2007; this platform was initially replaced by the SR2500 in 2007 and by the AS3000 in
March 2011. Due to the limited capabilities of the SR2400, and the accompanying limited
performance of Interplay Production when using a SR2400, the decision has been made to no
longer support the SR2400 on Interplay Production v2.6 and higher releases.

Using the 32-Bit or 64-bit Service Framework

Interplay v2.7 adds 64-bit OS support for Media Services Engine and the Copy, Move, and
Delivery providers. For additional information, see “New for Interplay v2.7” on page 53.

The following are 64-bit applications and require the 64-bit version of Avid Service Framework:
¢ Media Services Engine v2.7 and higher

*  Copy, Move, and Delivery Providers v2.7 and higher

* Interplay Transcode Provider v2.5 and higher

* Interplay STP Encode Provider v2.5 and higher

*  Avid Media Composer v6.0, Symphony v6.0, NewsCutter v10.0 and higher

* Interplay Assist v2.5 and higher

* Instinct v4.0 and higher

The other Interplay applications that require the Framework are 32-bit applications and can run
with either the 32-bit version or the 64-bit version of Avid Service Framework.
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If you are installing the Lookup Service on an AS3000, Avid recommends that you install the
64-bit version.

Note that some products such as Interplay Capture and Command include 32-bit ASF installers.
In these cases the bundled installers can be used.

For information on running the 64-bit Framework on the same system with a 32-bit application,
see the Interplay Software Installation and Configuration Guide.

SR2500 Windows 7 64-bit image

Avid has completed the qualification of the SR2500 WIN7 64-bit server image for use with the
Interplay 2.5 and higher Transcode and STP Encode Service. See your Avid representative for
information about obtaining the image.

Interplay 2.5 and higher Transcode and STP Encode services are 64-bit applications only. Due to
this customers who have SR2500's with Windows XP running pre-Interplay 2.5 builds have been
unable to upgrade these services to Interplay 2.5 or higher. The qualification of the SR2500
WIN?7 64-bit Image now enables customers to upgrade.

Note: Transfer Engine 2.4.0.1 and later is also supported to run on this image. Interplay Transfer
2.4.0.1 fixed a critical issue with AVCI 100 Send to Playback, WIN7 is required for this fix.

Note that Media Services Engine and providers other than Transcode and STP Encode have not
been qualified on the SR2500 WIN7 64-bit image.

Avid recommends upgrading from 2GB to 4GB of RAM for this image.

Microsoft WIN7 64-bit License: It is the responsibility of the customer to source the license for
the Image.

Windows Server 2003 and Windows Server 2008 Support

The new AS3000 server systems support Windows Server 2008. For additional information, see
“Support for AS3000 Servers” on page 17.

The following Interplay servers support Windows Server 2003 on an SR2500:

* Interplay Engine

* Interplay Archive Engine

* Interplay Media Indexer

*  Avid CaptureManager

«  Serial Control Server (used with CaptureManager)
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Important Information in This ReadMe

All Windows Server 2003 based Interplay servers support Windows 2003 Service Pack 2.

& Avid recommends that you do not apply SP2 to an SR2500 server running Windows Server
2003 SP1. Some SR2500 models experience multiple reboot problems after upgrading to
SP2. If you have already successfully applied SP2 to an SR2500 then you can stay at SP2.
Otherwise, don’t apply the upgrade. Always check with your Avid representative before
upgrading Interplay servers, especially cluster servers.

Upgrading a Cluster System to Windows Server 2003 SP2

A product recovery DVD is available for upgrading a cluster system to Windows Server 2003
SP2. If you plan to use the product recovery DVD to upgrade an existing system, contact your
Avid representative and schedule a maintenance window to perform the operation. The
recommended procedure involves backing up the Interplay database, reimaging both systems,
and rebuilding the cluster without deleting the database. Use “Avid Interplay Product Recovery,
Avid Interplay Engine Cluster”, 0010-09516-04A.

Compatibility of ISIS Systems for Interplay Copy

The following table describes which versions of Avid ISIS shared storage are compatible when
using the Interplay Copy service to copy assets from one workgroup to another.

Workgroup A to or from Workgroup B

ISIS 5000 3.0.x or later ISIS 5000 3.0.x or later
ISIS 7000 2.0.x or later ISIS 7000 2.0.x or later
ISIS 5000 3.0.1 through ISIS 7000 2.2.3.350
3.1.2140

ISIS 5000 systems do not support a 10-Gb connection between the Interplay Copy provider and
the Avid ISIS engine.

Important Information in This ReadMe

The following lists some of the important sections of this ReadMe.
*  “Installer Changes” on page 19

*  “Database Changes for Upgrading to v2.7” on page 22

*  “Best Practices for Performing an Engine Upgrade” on page 20

o “New for Interplay v2.7” on page 53
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International Character Support

*  “Fixed in v2.4” on page 55
e “Limitations” on page 66

*  See the following section for several documentation updates including new information for
Media Indexer: “Documentation Changes” on page 53.

International Character Support

Interplay includes international character support (ICS). ICS allows you to display and input
characters in languages other than English.

Interplay applications are qualified on an English operating system running locales for the
following languages:

*  Simplified Chinese and Traditional Chinese

* Japanese

*  French, Italian, German, and Spanish

In an Interplay workgroup, all clients and applications must use the same locale, either English
or one other locale.

Macintosh systems are not qualified for international character support (ICS) in an Interplay
environment.

Multibyte languages (Simplified Chinese, Traditional Chinese, and Japanese) are not supported
by Interplay Media Services, Interplay ProEncode, or SGL FlashNet. SGL FlashNet v6.4.x
includes support for Simplified Chinese, which is qualified for use with Interplay Archive and
Interplay Restore services V2.6 and later. See also, “International Character Support
Limitations” on page 119.
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Support for AS3000 Servers

The following table lists the AS3000 configurations that apply to Interplay server applications.
All configurations have two processors and 12 GB RAM standard. For information on adding
PCle cards, see the 453000 Setup Guide. For details on installing Interplay software on an

AS3000 see Migrating Avid Applications to AS3000 Servers.

Support for AS3000 Servers

Avid Applications

Operating System

Optional PCle Cards or
Optional Kits

Interplay Engine cluster,
Interplay Archive cluster

Interplay Engine,
Interplay Archive,
GPS Lookup Server

Interplay Transfer Engine,
Interplay Media Services,
Interplay Media Services
providers: Copy, Move,
Transcode, Archive, etc.

Interplay Media Indexer (64-bit)

Interplay Capture Server,
Media Services Engine®
Airspeed Multi Stream Device
Services Server

Interplay Streaming Server

Windows Server 2008 R2 SP1
Enterprise

Windows Server 2008 R2 SP1 Standard
x64

Windows 7 Pro SP1 64 Bit

Windows Server 2008 R2 SP1 Standard
x64

Windows Server 2008 R2 SP1 Standard
x64

Windows Server 2008 R2 SP1 Standard
x64

Memory expansion kit - increase
memory of each AS3000 in the
cluster to 32 GB RAM (add 6x4GB
DIMMs for a 36GB total) Avid part
number: 7010-30391-01

Fibre Channel card:
ATTO CTFC-41ES-BR1?

NA

Move and Copy providers:
Myricom 10G-PCIE-8B-S
10 Gb Ethernet.

NA

Interplay Capture:

Timecode w RCA Connector
Adrienne Electronics
PCle-LTC/RDR.

Starting at Interplay v2.4 there is no
need for an expansion kit for the
Stream Server.

a. The Fibre channel card is also available for other servers when connecting to Avid Unity MediaNetwork.
b. Media Services Engine is qualified on both Windows 7 Pro 64 and Windows Server 2008 R2 Standard.
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Updating System Settings on the Factory Image for Interplay Servers

See Migrating Avid Applications to AS3000 Servers for details on changes that should be made
to the factor image on the AS3000 servers for Interplay. The following table lists the changes that
must be made to the factory image.

Remove Web Switch Server role to

Server Application Server IIS Role Application Server
Interplay Engine Yes Yes
Media Indexer Yes Yes
Streaming Server Yes Yes
General Purpose Server with Avid Yes Yes

Service Framework Lookup Service

In particular, you must remove the Web Server IIS Role from the Interplay Engine system before
installing the Interplay Engine software. The installation will fail if you leave the server role
enabled.

Creating or Locating a Recovery Image

B> >

The location of your AS3000 recovery image depends on the Windows OS and the Avid
application.

*  On Windows 7 systems, the recovery image is on the 16 GB flash drive that ships with the
AS3000 server. Store the flash drive in a safe place.

«  For ISIS systems, see the setup guide for your ISIS product.

*  For all other Interplay servers systems, the recovery image ships on the D: partition of the
system drive. On these systems, a tool for copying the image to a USB Flash drive is located
in the following locations:

- C:\Avid_Recovery_Tool\AvidRecoverylmageTool.exe

- <Interplay Server Installer>Utilities\AvidRecoverylmageTool .exe

For instructions on how to use the tool, see the Readme in the corresponding folder or see the
AS3000 Setup Guide.

For systems that ship with the recovery image on the D: partition, Avid highly recommends
you copy the image to the 16 GB USB flash drive provided with your AS3000.

When you perform a full product recovery of the Avid AS3000 system drive, you lose the
product recovery image and data on the D: partition of the system drive.
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Installer Changes

Installer Changes

The Interplay installation software is no longer available on a USB flash drive. The software is
now available the download center as two separate downloads.

There is a server version and a client version of the installer downloads. See your Avid
representative for instructions for obtaining the software.

The Mac installers for Interplay Access, Media Indexer, and Interplay Transfer client are on
the Interplay Client Installer in the Installers\Mac_Installers folder.

There is an installer for the CaptureManager Vista client. The installer is not on the installer
interface. It is located in the Installers\CM_Client_Vista folder on the Interplay Client
Installer. For additional information, see the CaptureManager Readme file at the top level of
the Interplay Client or Server Installer.

Installing and Configuring Interplay Software

To install the software and begin the configuration of your Interplay environment, use the Avid
Interplay Software Installation and Configuration Guide.

Upgrading Interplay Software

To upgrade the software, see the following topics:

“Best Practices for Performing an Engine Upgrade” on page 20

“Avid Unity MediaNetwork Compatibility with the Interplay Engine” on page 21
“Updating Intel Drivers on Cluster Systems” on page 22

“Database Changes for Upgrading to v2.7” on page 22

“Updating the Avid Interplay Engine Software” on page 28

“Additional Information about Third-Party Licenses” on page 37

“Additional Information for Avid ISIS 7000” on page 38

“Additional Information for the Service Framework Lookup Service” on page 38
“Additional Information for Media Indexer” on page 38

“Additional Information for Interplay Transfer Upgrades” on page 39
“Additional Information for ProEncode Upgrades” on page 39
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Upgrading Interplay Software

Best Practices for Performing an Engine Upgrade

This section lists a number of procedures that can help ensure a smooth upgrade. These can be
particularly useful for sites with Interplay Engine clusters and large databases. In general, it is
useful to get a baseline snapshot of the health of the database and of the Interplay Engine before
performing the upgrade. This allows you to fix any problems before the upgrade begins. It also
provides a record of the state of the system over time. You can use this information for
comparison later if any problems develop after the upgrade.

Back Up the Interplay Database

You use the Interplay Administrator to create backups of the database. However, the
Administrator does not back up the complete database folder. Before you perform an upgrade,
Avid recommends that you create a backup copy of the complete database folder (AvidWG or
AvidAM) and the user database folder (_InternalData). See “Backing Up the Interplay Engine
Database” on page 24.

Send the Database to Avid Engineering for Testing

=

Avid recommends that you contact your Avid representative about sending a copy of your
Interplay database to Interplay engineering for testing. This testing provides a report that
includes the following type of information:

*  An estimation about the duration of the database upgrade/migration
*  An analysis of other database characteristics like object count

* Tips for the upgrade if there are any caveats
Your Avid representative can provide details on which files should be provided for the test.

Sending the database for testing is recommended for all version but should be considered
mandatory for Interplay versions vi.4 and lower.

Examine Log Files Before Performing the Upgrade

In order to analyze the state of the Interplay Engine, you need the relevant log files and the status
of the OS/machine hosting the Interplay Engine or Archive Engine. The easiest way to gather
these logs is to use the Collect tool. The Collect tool is typically run by Avid support. See your
Avid representative for details.

Your Avid representative can examine the Base Analyzer portion of the Collect tool before the
upgrade and determine whether you should make any changes before proceeding with the
upgrade. Save the output of the Collect tool. Besides providing troubleshooting information, the
Collect tool will provide a baseline of system status information that you can refer back to at a
later date.
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Restart the Interplay Engine Before the Upgrade

While not required, this is a good test of the health of the system. In particular, it is useful to
perform a failover of an Interplay cluster system. This can expose any problems with the cluster
services. If there are any problems restarting the system, fix the problems before you begin the
upgrade.

Deactivate the Interplay Database During the Upgrade

If the release requires a database upgrade, it is important to control the timing of when the
database upgrade occurs. if you deactivate the database before upgrading, the database upgrade
will occur when you reactivate the database. See “Database Changes for Upgrading to v2.7” on
page 22.

For the recommended upgrade procedure, see “Updating the Avid Interplay Engine Software” on
page 28.

Check the Logs During a Database Upgrade

The Interplay Engine displays a status bar during a database upgrade/migration. The status bar
appears if you perform the recommended steps and deactivate the database before the upgrade.
For a more accurate indication of how the upgrade is progressing, you can use an application
such as Notepad to periodically view the bottom of the NXNServer.log file in the following
folder:

C:\Program Files\Avid\Avid Interplay Engine\Logs\Machines\<machine_name>
Examine and Archive the Logs After the Upgrade
If you use the Collect tool, examine the Base Analyzer portion after the upgrade. This portion

should run successfully without any errors. Archive the output of the tool as a record of the state
of the system after the upgrade.

Avid Unity MediaNetwork Compatibility with the Interplay Engine
Starting at Interplay v2.2, the Interplay Engine requires an updated version of the

UnityAecifsLibVC7.DLL that is installed as part of a MediaNetwork client installation. The
updated version of that DLL is UnityAecifsLibVC9.DLL.
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This has the following implications for MediaNetwork sites:

* Ifany version of the MediaNetwork client is already installed on the server on which the
Interplay Engine to be installed, the Interplay Engine installer will automatically install the
new .dIl. No further action is required.

* IfInterplay Engine 2.4 or higher is to be installed on a fresh server in a MediaNetwork
environment, you must install the MediaNetwork client before installing the Interplay
Engine.

Updating Intel Drivers on Cluster Systems

Do not install or update Intel® NIC drivers on Interplay Engine cluster systems after the cluster
setup is complete. Due to the technical aspects of changing resources and devices on a cluster,
this can lead to problems with the cluster software and possible data loss. For additional
information, see “Additional Information for Avid ISIS 7000 on page 38.

Database Changes for Upgrading to v2.7

Upgrading from Interplay v2.6 to Interplay v2.7 does not require a database upgrade.

Upgrading from Interplay v2.4 or v2.5 to Interplay v2.7 requires a database upgrade. Make sure
you lock the database when you perform the upgrade as described in “Updating the Avid
Interplay Engine Software” on page 28.

Upgrading from Interplay v2.3 or Earlier

A

Upgrading from v2.3 (or earlier) to v2.7 involves a schema upgrade which can not be reversed.
That means that a full backup of the database must be created before upgrading the Interplay
Engine.

Once migrated, the database cannot be loaded by earlier versions of the Interplay Engine.
If you need to access the database through an earlier version, contact your Avid
representative.

For a very large database, the upgrade process can take up to three hours. For systems earlier
than v2.3, an additional upgrade occurs that can take additional time.

For releases earlier than v2.3 there are additional steps you must take after the upgrade to delete
unused rendered effects. See “Database Changes for Upgrading Systems Earlier than v2.3” on
page 23.

See “Best Practices for Performing an Engine Upgrade” on page 20.
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Free Disk Space for a Database Upgrade

The database migration requires a significant amount of free disk space on the drive that hosts
the _Database folder. You should have twice the amount of free disk space that the _Database
folder occupies on disk.

Database Changes for Upgrading Systems Earlier than v2.3

The upgrade to Interplay v2.3 required a database upgrade. So if you are upgrading a system
earlier than v2.3 to Interplay v2.7, the database upgrade will take effect. The first time you open
the database after the upgrade, the Interplay Engine automatically removes links for rendered
effects (they are replaced as emulated rendered effects by the client application). No media is
deleted. For additional information, see What’s New for Interplay v2.3 or the Interplay Help.

This process significantly reduces the size of the database. For a very large database, the upgrade
process can take up to three hours.

Avid recommends that before you perform an upgrade you contact your Avid representative
about sending a copy of your Interplay database to Interplay engineering for testing. Part of the
testing results will include an estimate of the time it will take to perform the database upgrade.

Because the process of removing the links can take a long time, it is important to follow the
upgrade procedure described in “Upgrading Interplay Software” on page 19. If you follow the
procedure, the database change occurs while you are logged into the Interplay Administrator.
During the process, the Interplay Administrator displays a progress bar. Messages are also
displayed in the Interplay Engine log file, nxnserverlog. You can periodically open the log file
with Notepad to monitor the progress.

During the database upgrade, the Interplay Engine also determines if there are rendered effects
that are not currently in use and moves these rendered effects to one or more subfolders in the
Orphan Clips folder. An administrator or media manager can then delete these assets and their
media. For more information about options for deleting, see “Deleting Unused Rendered Effects
After an Upgrade” on page 35.
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Upgrading from Interplay v1.x Releases

Starting at Interplay v2.1, you no longer need to upgrade to v1.6.2 before performing the final
upgrade to the latest version of the Interplay Engine.

Upgrading from Interplay v1.1.4 Though v1.1.6

The Interplay v1.1.6 ReadMe instructions for a cluster upgrade required that you create or
modify a registry key value during the upgrade to prevent the Interplay Engine from failing over
while the system was updating the database. This step is no longer required. You should check
whether the registry key exists on both nodes and delete it.
To delete the registry key value:

1. Open regedit on the active node.

2. Delete the following registry key.

HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\Workgroup\
Avid Workgroup Resource DLL

3. Perform the same operation on the non-active node.

The deletion is effective immediately and does not require a restart.

Backing Up the Interplay Engine Database

You use the Interplay Administrator to create backups of the database (see the Avid Interplay
Engine and Avid Interplay Archive Engine Administration Guide). However, the Administrator
does not back up the complete database folder. Before you perform an upgrade, use the following
procedures to create a backup copy of the complete database folder (AvidWG or AvidAM) and
the user database folder (_InternalData).

Before you create a backup copy, determine the location of the database folder and whether the
database was split between the Interplay Engine and a shared storage workspace.
To determine the location of the database folder:
1. On the Interplay Engine, open a Command Prompt and type the following command:
net share

All shares on the system are displayed. By default, WG_Database$ (a hidden administrative
share) represents the root folder of the database.

- For a non-cluster system, the root folder is usually D:\Workgroup_Databases.
- For a cluster system, the root folder is S:\Workgroup_Databases

2. Navigate to the root folder and double-click the AvidWG folder (or AvidAM folder for an
Archive Engine).
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By default, this folder includes all database folders and files, as shown in the following
illustration:

[E:ETB k File Falder 12M16/2007 1:00 AM
[T _Buckets File Folder 11/14/2007 2:36 PM
I3 _Checkln File Falder 11/14/2007 2:36 PM
| _Database File Folder 12M18/2007 B:37 PM
I _Handaover File Falder 11/14/2007 2:36 P
I3 _Import File Folder 11/14/2007 236 PM
1) _Master File Falder 11/14/2007 2:36 P
|53 _PropertyHandover File Folder 11142007 5:20 PM
) _PropertyStare File Falder 11/14/2007 3:57 P
25 &avidhf G rif File Folder 11/14/2007 2:36 PM
AIiasConfig.HmI TKE  HML Docurnent 12A18/2007 B3 PM A
AvidWG.pro 1KE PRO File 11A14/2007 2236 P A
FolderLacations. sml TKE  HML Docurnent 11/14/2007 236 P A

You need to back up the entire AvidWG folder.
If the AvidWG folder includes only the _Database folder, then the Interplay Engine is using
a split database.

For some split databases, the Workgroup_Databases folder might incorrectly include all
database folders. To verify if the split database is active, open both _PropertyStore folders and
check for recent timestamps. The folder on shared storage should show recent activity. For more
information about split databases, see the “Recommendation for Database Storage” in the Avid
Interplay Engine and Avid Interplay Archive Engine Administration Guide.
To determine the location of the second (split) database folder:
P Navigate to the workgroup.xml file and open it in a text editor.

This file is located in the Interplay Engine installation directory, for example,

- C:\Program Files\Avid\Avid Interplay Engine\Data\Apache\Conf\workgroup.xml
(non-cluster systems)

- S:\WorkgroupData\Apache\conf\workgroup.xml (cluster systems).
Both database paths should be listed, for example:

- \nterplayServer\WG_Database$

- \UnityServer\WorkspaceName
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Both of these folders hold an AvidWG folder. You need to back up both AvidWG
folders.

To make a backup copy of the database on a non-cluster system:
1. Open the Interplay Administration tool.
2. Use the following steps to lock the database:
a. Click Lock/Unlock Databases.
b. Select the database in the Unlocked Databases list.
c. Click Lock Database.
. Click Menu and click Manage Databases.
. Select the AvidWG database and click Deactivate. Select AvidAM for an Archive Engine.
. Click Menu and click the Restart Server view.

. Click Restart Server and close the Interplay Administration tool.

N N B W

. Use a backup tool to make a copy of the following folders and record their location.

Interplay Engine or Interplay Archive Engine

Folder Name Default Location
AvidWG (Interplay Engine database) D:\Workgroup_Databases\AvidWG
AvidAM (Archive Engine database) D:\Workgroup_Databases\AvidAM

_InternalData (user database if engine is a \D:\Workgroup_Databases\ InternalData
Central Configuration Server)

Interplay Engine (Split Database)

Folder Name Default Location
AvidWG (_Database folder only) D:\Workgroup_Databases\AvidWG
AvidWG (all other database folders) \UnityServer\WorkspaceName\AvidWG

_InternalData (user database if engine is a \D:\Workgroup_Databases\_InternalData
Central Configuration Server)

Use a backup tool that can handle long path names (longer than 255 characters). For example,
perform a backup with Robocopy (from the Microsoft Windows Resource Kit) or use a tool such
as 7-ZIP (free download) to zip the folder.
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Depending on the size of your database, this kind of backup can take a long time. To save time
you can temporarily move the _Backups folder from within the AvidWG (or AvidAM) folder. to
another location. After you perform the copy you can move the folder back under AvidWG.
To make a backup copy of the database on a cluster system:
1. Open the Interplay Administration tool.
2. Use the following steps to lock the database:
a. Click Lock/Unlock Databases.
b. Select the database in the Unlocked Databases list.
c. Click Lock Database.
. Click Menu and click Manage Databases.
. Select the AvidWG database and click Deactivate. Select AvidAM for an Archive Engine.
. Close the Interplay Administration tool.
. Click Start and select Programs > Administrative Tools > Cluster Administrator.
. Open the Groups folder.
. Select the Avid Workgroup Server group.

O© 0 3 & »n K~ W

. Select the Avid Workgroup Engine Monitor resource and take it offline.

10. If you performed the previous step correctly, drive S: should still be accessible within the
Windows environment. If it is not available, use the Cluster Administration tool to put drive
S: online by clicking on the disk resource within the “Avid Workgroup Server Group” and
selecting online.

11. Use a backup tool to make a copy of the following folders and record their location.

Interplay Engine or Interplay Archive Engine

Folder Name Default Location
AvidWG (Interplay Engine database) S:\Workgroup_Databases\AvidWG
AvidAM (Archive Engine database) S:\Workgroup_Databases\AvidAM

_InternalData (user database if engine is a \S:\Workgroup_Databases\_InternalData
Central Configuration Server)

27



Upgrading Interplay Software

Interplay Engine (Split Database)

Folder Name Default Location
AvidWG (_Database folder only) S:\Workgroup_Databases\AvidWG
AvidWG (all other database folders) \UnityEngine\WorkspaceName\AvidWG

_InternalData (user database if engine is a S:\Workgroup_Databases\_InternalData
Central Configuration Server)

Use a backup tool that can handle long path names (longer than 255 characters). For example,
perform a backup with Robocopy (from the Microsoft Windows Resource Kit) or use a tool such
as 7-ZIP (free download) to zip the folder.

Depending on the size of your database, this kind of backup can take a long time. To save time
you can temporarily move the _Backups folder from within the AvidWG (or AvidAM) folder. to
another location. After you perform the copy you can move the folder back under AvidWG.

12. Before you perform the upgrade, bring all of the resources inside the cluster resource group
online. Right-click the resource group and select Bring Online.

For more information on the Cluster Administration tool, see the Avid Interplay Failover
Guide.

Updating the Avid Interplay Engine Software

The following topics describe how to update the Interplay Engine and Interplay Archive Engine
software:

*  “Upgrading an Interplay Engine Cluster or Interplay Archive Engine Cluster” on page 28
*  “Checking the Server Execution User Account on a Cluster System” on page 30

+  “Upgrading a Non-Cluster Interplay Engine or Interplay Archive Engine” on page 31

*  “Activating the Database” on page 32

*  “Verifying the Upgrade” on page 34

Upgrading an Interplay Engine Cluster or Interplay Archive Engine Cluster

A

The process described here is similar to a rolling update except that the database is locked and
deactivated before you begin.

If you are using a roaming profile, it is important to install both nodes in exactly the same
order.
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If the Interplay Engine includes the /3GB switch in the boot.ini file, the Interplay Engine
installer displays a message that this switch is obsolete and asks if you want to remove it.
Click Yes. If the boot.ini file contains more than one /3GB string in the same boot.ini line,
the switch is not removed and you need to edit the boot.ini file by hand. Changes to the
Interplay Engine have made use of the /3GB switch obsolete.

To upgrade an Interplay Engine cluster or Interplay Archive Engine Cluster:

1.

Verify that you have a valid backup as described in “Backing Up the Interplay Engine
Database” on page 24.

. If you took the Avid Workgroup Engine Monitor resource offline when you performed a

backup, bring all of the resources inside the cluster resource group online. Right-click the
resource group and select Bring Online. For more information, see the final steps in
“Backing Up the Interplay Engine Database” on page 24.

. Check the Server Execution User account. See “Checking the Server Execution User

Account on a Cluster System” on page 30. Check the Avid Workgroup TCP COM Bridge
service login, the Cluster service login, the Avid Workgroup Engine Monitor service login,
and the registry key value that the installer uses. All four values should match.

If you deactivated your database when backing it up in Step 1, proceed to Step 7.

4.
5.

Open the Interplay Administrator tool on the Active node.

Use the following steps to lock the database:

a. Click Lock/Unlock Databases.

b. Select the database in the Unlocked Databases list.

c. Click Lock Database.

Use the following steps to deactivate the database:

a. Click Menu in the Interplay Administration tool and click Manage Databases.

b. Select the AvidWG database and click Deactivate. For an archive database, select
AvidAM.

. Use the Interplay v2.7 Server Installer to update the Interplay Engine or Interplay Archive

Engine software. Use the following procedure:
a. Determine which is the active node (first node).
b. Use the following procedure to move all resource groups to the active node:

In the Cluster Administrator, open the Groups folder and check the owner column for
the following groups: Avid Workgroup Server group, Cluster group, and the MSDTC
group. If they are not on the active node, right-click the group entries under the Groups
folder and select Move Group for each entry.
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c. Run the Interplay Installer on the non-active node (second node). Select the Custom
install option. Select the defaults but make sure you supply the correct Server Execution
User values when prompted. See “Checking the Server Execution User Account on a
Cluster System” on page 30. Restart as requested and continue with Part 2 of the
installation. The installer will ask you to restart again after Part 2.

d. Perform the installation on the first node while it is online. Use the Custom install
option and specify the correct Server Execution User when prompted.

e. During the installation, the installer displays a dialog box that asks you to move the Avid
Workgroup Server group to the second node. Move the group, then click OK in the
installation dialog box to continue. Restart as requested and continue with Part 2 of the
installation. The installer will ask you to restart again after Part 2.

f.  After you move the group, bring the Interplay Engine online by right-clicking the “Avid
Workgroup Server” group and selecting “Bring Online.”

After completing the previous steps, both nodes in the cluster are updated to the new
software version.

After you update both nodes, follow the procedure in “Activating the Database” on page 32.

Checking the Server Execution User Account on a Cluster System

The Server Execution User is a Windows operating system user account that is used to run the
Interplay Engine process. The account was set up when the Interplay Engine software was
initially installed. If the NXNServerUser.exe tool has never been used to change the Server
Execution user on your cluster system, you can skip this section. If you aren’t sure whether the
account was ever changed, use the procedure in this section to check the values.

& If the four values in this section do not match and you accept the default Server Execution
User during the upgrade, the cluster will not fail over after you complete the upgrade,

For additional information, see “Additional Information About the Server Execution User” on
page 40.

To determine the Server Execution User name on a cluster system:

1.

Right-click My Computer and select Manage.

2. Select Services.
3.
4. Click the Log On tab.

Right-click Avid Workgroup TCP COM Bridge and select Properties.

The Log On tab contains the name of the Server Execution User.

Right-click the Cluster service, select Properties, and click the Log On tab. This is the
Windows user account that is running the cluster service.
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On a cluster system, the Windows user account that is running the cluster service and the
account that is running the Avid Workgroup Engine Monitor must match the Server Execution
User account. To determine these accounts, repeat steps 1 to 5 for the services “Cluster Service”
and “Avid Workgroup Engine Monitor.”

6. Check the following registry key value on each node:

HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\Workgroup\
Avid Workgroup Server

Check the ExecutionUser value. The Interplay Engine installer uses this value as the default
value for the Server Execution User. If this value does not match the TCP COM Bridge
value, it means that the Server Execution user has been changed at some point since the
original Interplay Engine installation. In this case, use the Custom install option and do not
use the value that automatically appears when the system asks for the Server Execution User
name.

If all three values match, then either the Server Execution User was never changed at this site
or the cluster-aware version of the NXNServerUser.exe tool was used to change the user. In
this case you can either use the Typical install option or use the Custom install option and
accept the Server Execution user value that the installer displays.

If the account names are different, use the Custom install option when you upgrade the
Interplay Engine software and supply the correct credentials of the Cluster Service name and
password when prompted. Use the Cluster Service’s regular domain name, such as
“MYDOMAIN\ServerUser” and not the fully qualified domain name, such as
“MYDOMAIN.com\ServerUser”.

If you don’t know the correct password for the Server Execution User account and you have
to change the value during the upgrade, use the cluster-aware version of the
NXNServerUser.exe to change the user before you perform the upgrade. See “Changing the
Server Execution User in a Clustered Environment” on page 40.

Upgrading a Non-Cluster Interplay Engine or Interplay Archive Engine

If the Interplay Engine includes the /3GB switch in the boot.ini file, the Interplay Engine
installer displays a message that this switch is obsolete and asks if you want to remove it.
Click Yes. If the boot.ini file contains more than one /3GB string in the same boot.ini line,
the switch is not removed and you need to edit the boot.ini file by hand. Changes to version
2.3 of the Interplay Engine make use of the /3GB switch obsolete.

To update the Avid Interplay Engine software:

1. Verify that you have a valid backup as described in “Backing Up the Interplay Engine
Database” on page 24.

If you deactivated your database when backing it up in Step 1, proceed to Step 5.
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2. Open the Interplay Administrator tool.

3. Use the following steps to lock the database:

a.
b.
c.
d.

Click Lock/Unlock Databases.

Select the database in the Unlocked Databases list.

(Option) Type a Lock comment explaining why you are locking the database.
Click Lock Database.

4. Use the following steps to deactivate the database:

a.

Click Menu in the Interplay Administration tool to see the display of Administration
tool views.

Click Manage Databases.

Select the AvidWG database and click Deactivate. For an archive database, select
AvidAM.

5. Use the Interplay v2.7 Server Installer to update the Interplay Engine software. Follow the
onscreen instructions. For additional information, see the Avid Interplay Software
Installation and Configuration Guide.

6. After you update the software, follow the procedure in “Activating the Database” on
page 32.

Activating the Database

After you perform the upgrade, you must activate the database. The Interplay Engine software
performs any necessary database updates when you activate the database.

1. Use the Interplay Administrator tool to activate the database and perform the database
upgrade as follows:

a.
b.

C.

Open the Interplay Administrator tool on the system running the Interplay Engine.
Click Manage Databases.
Type the following in the “Database (.pro) file to activate” text box.

\\engine_name\WG_Database$\AvidWG\AvidWG.pro
\\engine_name\WG_Database$\AvidAM\AvidAM.pro (for an archive engine)

For a split database, type:
\Avid_Unity_server_name\workspace_name\AvidWG\AvidWG.pro

where Avid_Unity_server_name is the File Manager for Avid Unity MediaNetwork or
the System Director for Avid Unity ISIS.

% You can also browse to the appropriate .pro file and then click Activate. On a cluster you must
browse from the network, not from the mount.
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d. The following example shows the pathname on a system that does not have a split

database. The system name is wgb-ab.

A3 Avid Interplay Administrator

File  Help

a'_:} Interplay Server &2 Database & ‘3 Manage Databases @

Activate Database

Database (pro) file to activate: 1R1wgb—ab‘;WG_Database$RAVidWGRAVidWG.prDI

{4 Load Database on Activation

Make sure the option “Load Database on Activation” is checked.

Click Activate.

The upgrade begins. The system displays a dialog box with a progress bar that bounces
from side to side while the database is being updated.

For an accurate indication of how the database upgrade is progressing, you can use an

application such as Notepad to periodically view the bottom of the NXNServer.log file in
the following folder:

C:\Program Files\Avid\Avid Interplay Engine\Logs\Machines\<machine_name>

The system will automatically unlock the database if you have Load Database on Activation
selected.

g.

The database upgrade can take up to several hours, depending on the size and
complexity of the database. It is important not to interrupt or stop the Interplay Engine
or perform a failover during the upgrade process. This could result in problems with the

database. To recover from a failed or interrupted upgrade, you need a valid backup of
the old database.

2. To verify that you can log onto the database, do the following:

a.

b.

Click Menu in the Interplay Administration tool.

Click Manage database Roles. The Manage Database Roles view opens.
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7% Avid Interplay Administrator

File  Help

Q.:} Interplay Server & User Management & @ Manage Database Roles

@ General Role &ssignment ) Special Access Faolders

Database UserfGroup
& Docwg WYl Users and Groups
» @ﬂ AvidviG (on Docwg as Administrat &i Lsers
» 8 administrators
8 Assistants

Database icon

Click the AvidWG icon (AvidAM for archive database).

d. You can tell that you have successfully logged onto the database when the database icon
displays a green check mark and the users and roles are displayed as shown in the above
illustration.

If you do not deactivate the database before the software upgrade, any automatic database
upgrades begin on your first login to the Interplay Engine after you update the software. This
occurs the first time you log onto the database with any client (for example, Interplay Access or
Interplay Assist). After you type your username and password at the login screen, the system
stays at a “Connecting” status while it performs the upgrade. In this case, the system does not
display any messages indicating that the upgrade is in progress. Do not exit the application, shut
down the system, or fail-over the Interplay Engine while the upgrade is being performed.

Verifying the Upgrade

To verify the upgrade:
1. Navigate to the following location:
C:\Program Files\Avid\Avid Interplay Engine\Logs\Machines\<machine name>
2. Open the NXNServer.log file in Notepad.
3. Search for the text “success”. There should be a message similar to the following:

Database AvidWG has been successfully updated from version xxxxx to
YYyyy

where xxxxx and yyyyy are the old and new releases, respectively. The message could also
say “successfully corrected”. Messages such as the following are part of the upgrade process
and can be ignored.

Can"t open file "S:\Workgroup_Databases\AvidWG\_Database\Avidxxx.xxx"
for reading
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Deleting Unused Rendered Effects After an Upgrade

Starting at Interplay v2.3, the Interplay Engine does not include rendered effects as links in the
database. Instead, they are displayed as emulated rendered effects in Interplay Access. For more
information, see What’s New for Interplay v2.3 or the Interplay Help.

The first time you open the Interplay database after an upgrade from a version earlier than v2.3,
the Interplay Engine automatically removes links for rendered effects. In a large database, this
can take several hours (see “Activating the Database” on page 32). During this process, the
engine also determines if there are rendered effects that are not currently in use and moves these
rendered effects to one or more subfolders in the Orphan Clips folder. An administrator or media
manager can then delete these assets and their media.

Each numbered subfolder contains 2,000 rendered effects each (except for the last subfolder,
which can contain less). The resulting folder structure looks like the following:

¥ £ Orphan Clips
¥ I Upgrade - Rendered Effects

B 001

B 002

An administrator or media manager has two options for deleting the unused rendered effects:
»  Using the standard deletion procedure in Interplay Access.

*  Using a Windows command-line tool, which deletes both metadata and media. This tool has
two advantages compared to deleting in Interplay Access:

- Deletion is faster (for example, there are fewer client-server round-trips with the tool
and no need to refresh the user interface)

- You can run the tool as a scheduled task. This is especially useful if there are a large
number of unused rendered effects (several thousand or more).

The Windows command-line tool (delete_obsolete_rendered_effects.exe) is located in the
following folder:

drive:\Program Files\Avid\Avid Interplay Engine\Server
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The syntax of the tool is described in the following in-line help:

L s s

delete_obsolete_rendered_effects - Deletes obsolete rendered effects.
delete _obsolete_rendered_effects [user:] [psw:] [maxAssets:] [maxTime:]

This tool automates the deletion of rendered effects (including media) that
were moved to the Orphan Clips folder during the database upgrade from
versions prior to Interplay 2.3.

Options:
user:<user name> Name of the user to logon to AvidWG with
psw:<password> Password of the user to logon to AvidWG with
maxAssets:<number> (optional) Maximum number of rendered effects

to delete
maxTime:<minutes>  (optional) Maximum run time in minutes; tool will
stop deletion when this period is exceeded

The maxAssets: and maxTime: options are useful if this tool is run as a
scheduled task, e.g. using Windows Task Scheduler.

To run the delete tool:

1. On the Interplay Engine system (or for a cluster system, on the online node), open a
Windows Command Prompt.

2. Navigate to the location of the tool. For example, type
cd C:\Program Files\Avid\Avid Interplay Engine\Server

3. Type the command line for the tool and press Enter, using the following syntax:
delete_obsolete_rendered_effects [user:] [psw:] [maxAssets:] [maxTime:]
If you want to direct the output of the tool to a file, append the following to the command:
>> output_file.txt

For example, to run the program for one hour and print the output in a file named results.txt,
type the following and press Enter:

delete_obsolete_rendered_effects user:administrator psw:admin
maxTime:60 >>results.txt

If you want to schedule the tool to run at a particular time, use a program such as Windows Task
Scheduler.
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Additional Information about Third-Party Licenses
Avid installs third-party licenses used for Interplay Access in the following directory:
C:\Program Files\Avid\Avid Interplay Access\LicenseFiles

For Interplay v2.7 a new license for POCO C++ Libraries is not in the LicenseFiles folder and
will be added for the next release. For additional information see “POCO C++ Libraries
License” on page 37.

POCO C++ Libraries License

The POCO C++ Libraries are open source software, licensed under the Boost Software License
1.0. A very liberal license that encourages both commercial and non-commercial use.

The Boost Software License 1.0

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of
the software and accompanying documentation covered by this license (the "Software") to use,
reproduce, display, distribute, execute, and transmit the Software, and to prepare derivative
works of the Software, and to permit third-parties to whom the Software is furnished to do so, all
subject to the following:

The copyright notices in the Software and this entire statement, including the above license
grant, this restriction and the following disclaimer, must be included in all copies of the
Software, in whole or in part, and all derivative works of the Software, unless such copies or
derivative works are solely in the form of machine-executable object code generated by a source
language processor.

THE SOFTWARE IS PROVIDED "AS IS”, WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND
NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR
ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR
OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.
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Additional Information for Avid ISIS 7000

This section includes important information about Avid ISIS 7000.

NIC Drivers, Upgrades, and Mounting Drives

The following information applies to Avid ISIS:

Do not install or update Intel NIC drivers on Interplay Engine cluster systems after the
cluster setup is complete. Due to the technical aspects of changing resources and devices on
a cluster, this can lead to problems with the cluster software and possible data loss.

The ISIS Readmes recommend that you update the Intel Pro MT/PT drivers on ISIS clients.
This statement does not apply to Interplay Engine cluster systems. The Intel drivers on
cluster systems do not require updating for this release. Doing so could compromise the
integrity of the cluster. In general, do not update the hardware drivers on a cluster system
unless instructed to do so by Avid Customer Support.

The Avid Unity ISIS Setup Guide includes an appendix titled “Avid Unity Upgrade
Guidelines”. Refer to that guide before you upgrade to ISIS.

For information on mounting drives, see the Avid Interplay Software Installation and
Configuration guide.

Additional Information for the Service Framework Lookup Service

If you have more than 10 clients in your Avid Service Framework environment (including Avid
editing applications, Avid Instinct, and Avid Assist), Avid recommends that you put the Service
Framework Lookup Service on a separate server such as a General Purpose Server. See the
Interplay Software Installation and Configuration Guide for information on installing the
Lookup Service on a separate server.

Avid recommends that if you install the Lookup Service on an AS3000, use the 64-bit Service
Framework installer. See “Using the 32-Bit or 64-bit Service Framework™ on page 13.

Additional Information for Media Indexer

For new Media Indexer features, see What’s New for Interplay v2.7 or the Interplay Help.

Media Indexer Servers and Avid Unity MediaNetwork

The 64-bit SR2500 Media Indexer is supported on Avid Unity Media Network v5.1.
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Media Indexer File Count

Interplay supports 64-bit Media Indexer servers. The following table shows the supported file
count. Avid recommends that you have no more than two Media Indexers in the High
Availability group (HAG).

Number of files that can be

Media Indexer System indexed by the MI HAG
AS3000 5 million
Intel SR2500 64-bit 2.4 million

Replacing 32-Bit Media Indexers with 64-Bit Media Indexers

See the Interplay Best Practices Guide for a procedure to replace 32-bit Media Indexers with
64-bit Media Indexers.

Additional Information for Interplay Transfer Upgrades

Before you upgrade Interplay Transfer to a new release: If your configuration includes playback
and ingest through a third-party DHM, you must check with the third-party vendor to determine
if an updated DHM is required. Existing third-party DHMs might need to be rebuilt using the
latest DHM SDK for compatibility with the latest version of the Interplay Transfer Engine and
the Interplay Transfer Client.

Additional Information for ProEncode Upgrades

>

Bug Number: no number. ProEncode service installation cannot be performed over the
network.

Workaround: .After you install ProEncode, copy the ProEncode.zip file to the local drive on
the Media Services Engine and install the service locally. For details, see “Installing a Service
Description” in the Interplay Media Services Setup and User’s Guide or the Interplay Help.
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Additional Information About the Server Execution User

The Server Execution User is a Windows operating system user account that is used to run the
Interplay Engine processes. The Server Execution User is set up the first time that you install the
Avid Interplay Engine software and has the following features:

The account must have local administration rights on the operating system for the Interplay
Engine Server (both nodes on a cluster). The Interplay Engine installation software asks you
for a user name and password and automatically adds the account to the Administrator
Group. Usually this is a domain account that has already been created. The account must
have the following local security policy settings:

Act as part of the operating system
Back up files and directories
Restore files and directories

Adjust memory quotas for a process
Log on as a service

Increase scheduling priority

On a cluster system the account must have these permissions on both nodes. The
account must be a local Administrator on both nodes.

Ideally this should be an account that human users do not use to log onto the system.
This will prevent accidental changes to the Server Execution User user account during
normal administration duties. For example, if someone changes the password by
mistake, users may not be able to access the Interplay database.

An account with an identical user name and password must have read/write access to the
Avid Unity workspaces that contain media. You use the Avid Unity ISIS or Avid Unity
MediaNetwork Administration tool to create this account.

In order to prevent accidental changes to the Server Execution User account during normal
administration duties, Avid recommends that you use a dedicated Windows user account such as
“Incompensation” as a Server Execution User and cluster service user. This account should not
be used for administrative logins to the Interplay engine hardware.

Changing the Server Execution User in a Clustered Environment

To change the Server Execution User account in a clustered environment:

1. Create the domain user and assign the following local security policies for that user on each

node of the cluster:

Act as part of the operating system

Back up files and directories
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- Restore files and directories

- Adjust memory quotas for a process
- Logon as a service

- Increase scheduling priority

You can view and set these rights at All Programs > Administrator Tools > Local Security.
Click on Local Policies and click on User Rights Assignment. Add the user to each of the
above user rights assignments. The user must be a local Admin on both nodes.

. Make sure that a matching Unity account exists that has read/write access to the Avid Unity

workspaces.

3. Shut down the offline node two).

. Run the NXNServerUser.exe tool on the active node (node one). The tool is located in the

following directory on the Avid Interplay Installer:
Installers\AssetMgr\Tools

Select Custom, follow the on screen prompts, and restart node one.

. Shut down node one and start up node two.
. Run the NXNServerUser.exe tool on node two and then restart node two.

. Start up node one.

For more information on the NXNServerUser.exe tool, see the Avid Interplay Engine and
Avid Interplay Archive Engine Administration Guide.

Additional Information About Pro Tools

This section contains important information about the Pro Tools Interplay Integration Plugin
(also known as the Pro Tools Interplay Option) that is available on the Interplay Client installer.

System Requirements and Compatibility

Using the Pro Tools Interplay Option with an Interplay system requires the following;

Mac OS 10.6.8 or later
Or Windows 7
Pro Tools HD software, or Pro Tools Software with Complete Production Toolkit

Optional Avid Pro Tools|HD or HD Native hardware

For information on using Pro Tools in an Interplay environment, see the Pro Tools Avid Interplay
Guide and the Interplay Best Practices Guide.
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You can obtain the guide via on the Avid Knowledge Base. Search the Knowledge Base for
“Interplay Requirements with Pro Tools”. That document includes a chart matching Pro Tools
releases with Interplay releases and supported operating systems.

New Interplay Support Features in Pro Tools 10.0

Pro Tools 10.0 supports the following new features in an Interplay environment:

You can export an AAF directly to a third-party playback server for immediate live
playback. This feature requires the following supporting software:

- Avid Service Framework 1.3 or later
- Interplay Transfer 2.4 or later
- Interplay Web Services 2.2 or later

- Pro Tools Send to Playback Plugin (available on the Pro Tools Interplay Client page of
the Interplay Client installer)

The Pro Tools Send to Playback Plugin requires a Web Services license and installation. See
your Avid representative for additional information. For additional information about Web
Services, see the following Avid web page:

http://www.avid.com/us/partners/AvidInterplay APIs

Media can be saved to your choice of available Interplay workspaces. You can also restrict
access to some Interplay workspaces to ensure media is not written to or overwritten in
specified workspaces.

There is no longer a limitation where Pro Tools can only check out a sequence that was
explicitly “checked in for Pro Tools”. Any sequence that has been checked into Interplay can
now be checked out to Pro Tools.

Pro Tools 10 provides the Match Timecode option when exporting, in cases where the
session start does not match the start of the destination sequence on Interplay. When this
option is selected, this will take the timecode in/out points of the destination sequence on
Interplay, and export those same timecode positions from the Pro Tools session to the
sequence.

For additional information, see the Pro Tools Avid Interplay Guide on the Knowledge Base
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Support for Symantec Endpoint v12.1

Interplay v2.x supports the Antivirus and Spyware components of Symantec™ Endpoint v12.1 on
servers and clients.

Interplay does not support the following components:

*  Proactive Threat Protection

*  Network Threat Protection

When you perform an installation, enable and disable the installation options as shown in the
following illustration. An X means that the Symantec installer will not install the component.

ﬁ Symantec Endpoint Protection Client @
Custom Setup

\/Symantec.

Select the program features you want installed.

Clidk on an icon in the list below to change how a feature is installed.

Feature Description
Installs Network Threat
Protection components.

=== | Core Files
EI ------- | Virus, Spyware, and Basic Download
i Advanced Download Protectic
COutlook Scanner
Motes Scanner

POP3/SMTP Scanner This feature requires OKE on
- %= | Proactive Threat Protection YOE;Eh?Ld drivel. IEEthSTin 2
i : subfeatures selected. The
E S subfeatures require 870KE on
your hard drive.
4 [ m = P
Install to:

C:'Program Files (x86)\Symantec\Symantec Endpoint Protection',
Space [ < Back H Mext = l [ Cancel ]

The following Knowledge Base article describes how to install and configure Symantec
Endpoint v12.1 in an Interplay environment:

Using Antivirus Software in an Interplay Environment, Support for Symantec Endpoint v12.1

Installing on a Non-Cluster Interplay Engine

On an Interplay Engine you must disable real-time scanning of the following folders:

D:\Workgroup_Databases
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This is represented by the hidden administrative share \\<Servername>\WG_Database$.

& Configure the exclusion folders before Symantec runs the first scan.

Installing on an Interplay Engine Cluster

You can install Symantec v12.1 on a cluster. Exclude the following locations from the virus
scanning:

*  Q:\ (Quorum disk)

+  C:\Windows\Cluster

*  S:\Workgroup_Databases (database)
«  RNMSDTC disk)

Use the following guidelines for installing on a cluster:
e Perform the Symantec installation when the node is offline.
*  Bring the node online to configure Symantec and identify the exclusion folders as listed

above.

& Configure the exclusion folders on both nodes before Symantec runs the first scan.

Installing on a Streaming Server

If you are installing Symantec on an Interplay Streaming Server v2.4 and higher, exclude the
folder C:\Program Files (x86)\Avid\Avid Interplay Streaming Server from scanning by virus
protection software. Scanning for virus protection could cause disruptions to the Interplay
Streaming Server and could cause it to shut down. For additional information on the Streaming
Server, see the Interplay Software Installation and Configuration Guide.

Limitations
The following limitations exist for installing Symantec v12.1 in an Interplay environment.
Upgrading from Symantec 11.x

There is a known issue with upgrading from Symantec EndPoint v11.x to v12.1. After the
upgrade, the “Disable Symantec Endpoint Protection” option is grayed out on the Symantec
Endpoint Protection icon in the system tray. Refer to TECH169398 on Symantec’s support web
page for additional information.
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To avoid this problem, uninstall Symantec v11.x before you install Symantec v12.1. Before you
perform the uninstall, open the Symantec application and take note of the exclusion folders. You
will need to set up these same exclusion folders after the installation.

On an Interplay Engine identify the Exclusion folders before the first scan

On Symantec v12.1, if you fail to exclude the Workgroup_Database folders before the first scan,
the scan can create conflicts between Symantec and the Interplay database. The result is that you
cannot log into Access or the Interplay Admin tool and the system displays an error message
including the text “Class not registered”.

If this problem occurs you must reinstall the Interplay Engine software. You can reinstall the
Interplay Engine software over the existing installation.

Installing Symantec on ISIS Clients Running Windows Vista

If you install the Advanced Download Protection option on a Vista system, you may have to
disable “Download Insight” before updating the ISIS client from the ISIS Management Console.
Download Insight protects your system against files that are downloaded or executed from web
browsers. On a Windows 7 system, Symantec displays a dialog box asking whether you want to
allow the ISIS client installer to run. However, on a Vista system, Symantec may simply block
the installer.

This problem does not occur if you run the ISIS Client installer from the ISIS installation kit.

To solve the problem on a Vista system you can disable Download Insight before installing the
ISIS client. Then you can turn it back on after the installation. The option is available via the
Change Settings > Virus and Spyware Protection portion of the Symantec interface. See the
Symantec documentation for details.

Troubleshooting Firewalls and Avid Interplay

Firewalls on client machines interfere with Avid Interplay’s TCP/IP communications.

Symptoms
*  The list of servers does not appear, for example, when you are connecting to a new database.
*  Connection establishment to the server fails.

Cause

These problems can be caused by personal firewalls installed on the client machine. A typical
example for such a firewall is ZoneAlarm® from ZoneLabs " or the Windows XP, Windows
Vista, or Windows 7 firewall.
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These applications intercept all outgoing and incoming network traffic and decide whether to let
the traffic go through or block it. The effect is that applications like Avid Interplay fail to connect
to their servers.

Typically when the client looks for available Avid Interplay Engines in the network, no servers
can be retrieved. When the client is looking for servers, a UDP broadcast is sent out on port
8321.

Solution

Usually these personal firewalls can be configured to allow all network traffic for specific
applications. This should be done for Avid Interplay locally or for Internet access depending on
which servers Avid Interplay should connect to.

For information about ports used by Avid Interplay, see “Avid Interplay Port Usage” in the
Interplay Help and the Interplay Software Installation and Configuration Guide.

Operating Points for Sony XDCAM HD and
XDCAM EX

The Interplay Best Practices Guide describes the end-to-end workflow for Sony XDCAM HD
and Sony XDCAM EX Long GOP material. This section lists the operating points that are
supported for this Interplay release.

The supported MPEG-2 operating points are based on the Sony XDCAM and XDCAM EX
systems. For the end-to-end workflow, Interplay supports 14 operating points that are the basic
rates for broadcast applications. Any additional XDCAM or XDCAM EX resolutions are
supported in a standalone editor configuration only.

Interplay supports all 14 operating points. However, not all of the operating points have been
qualified on video servers. See “Operating Points Qualified for Omneon Servers” on page 49
and “Operating Points Qualified for AirSpeed Multi Stream” on page 49.
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The following table shows all of the operating points supported by Interplay. Audio is as
specified in XDCAM HD/XDCAM EX: PCM uncompressed audio sampled at 48 kHz. Bit
widths can be either 16 bit and 24 bit. The audio is encoded as monaural tracks (not stereo pairs).

Interlaced or Frame MPEG Profile Bit Sub-

H \") Progressive Rate and Level Rate sample Sony Product

1920 1080 Interlaced 59.94  422P@HL 50 CBR 4.2.2 XDCAM HD Phase III

1440 1080 Interlaced 59.94 MP@HL 35 VBR 4.2.0 XDCAM HD

1920 1080 Interlaced 59.94 MP@HL 35 VBR 4.2.0 XDCAM EX

1440 1080 Interlaced 59.94 MP@H-14 25 CBR 4.2.0 XDCAM HD & EX
(HDV)

1440 1080 Interlaced 59.94 MP@HL 18 VBR 4.2.0 XDCAM HD

1920 1080 Interlaced 50 422P@HL 50 CBR 422 XDCAM HD Phase 111

1440 1080 Interlaced 50 MP@HL 35 VBR 4.2.0 XDCAM HD

1920 1080 Interlaced 50 MP@HL 35 VBR 4.2.0 XDCAM EX

1440 1080 Interlaced 50 MP@H-14 25 CBR 420 XDCAM HD & EX
(HDV)

1440 1080 Interlaced 50 MP@HL 18 VBR 4.2.0 XDCAM HD

1280 720  progressive 59.94  422P@HL 50 CBR 422 XDCAM HD Phase IIT

1280 720  progressive 59.94 MP@HL 35 VBR 4.2.0 XDCAM EX

1280 720  progressive 50 422P@HL 50 CBR 4.2.2 XDCAM HD Phase III

1280 720  progressive 50 MP@HL 35 VBR 4.2.0 XDCAM EX
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The following table lists how these operating points are displayed in different applications:

AirSpeed Multi Stream
Record Template

Video Frame Bit Avid Editing Name (Service Interplay Media

Format Rate Rate Application Name? Framework)® Services Profile Name

10801 59.94 50 XDCAM HD 50Mbits MXF XDCAM-HD 50mb 1080i XDCAM-HD 50mbps
10801 60

10801 59.94 35 XDCAM HD 35Mbits MXF XDCAM-HD 35mb 1080i XDCAM-HD 35 60i

10801 5994 35 XDCAM EX 35Mbits MXF XDCAM-EX 35mb 1080i XDCAM-EX 35mbps
1080i 60

10801 59.94 25 HDV 1080i MXF HDV 25mb 10801 HDV 1080i 60

10801 59.94 18 XDCAM HD 17.5 Mbits XDCAM-HD 17.5mb 10801 XDCAM-HD 17.5 60i

MXF

10801 50 50  XDCAM HD 50Mbits MXF XDCAM-HD 50mb 1080i XDCAM-HD 50mbps
1080i 50

10801 50 35 XDCAM HD 35Mbits MXF XDCAM-HD 35mb 1080i XDCAM-HD 35 50i

10801 50 35 XDCAM EX 35Mbits MXF XDCAM-EX 35mb 1080i XDCAM-EX 35mbps
1080i 50

10801 50 25 HDV 1080i MXF HDV 25mb 10801 HDV 1080i 50

10801 50 18 XDCAM HD 17.5Mbits XDCAM-HD 17.5mb 10801 XDCAM-HD 17.5 501

MXF

720p 5994 50 XDCAM HD 50Mbits MXF XDCAM-HD 50mb 720p  XDCAM-HD 50mbps
720p 60

720p 59.94 35 XDCAM EX 35Mbits MXF XDCAM-EX 35mb 720p  XDCAM-EX 35mbps 720p
50

720p 50 50 XDCAM HD 50Mbits MXF XDCAM-HD 50mb 720p  XDCAM-HD 50mbps
720p 50

720p 50 35 XDCAM EX 35Mbits MXF XDCAM-EX 35mb 720p XDCAM-HD 35mbps

720p 50

a. For Avid editing applications, the video format and rate are determined by the project settings.
b. For AirSpeed Multi Stream record templates, the frame rate is determined by the channel configuration.
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Operating Points for Sony XDCAM HD and XDCAM EX

Operating Points Qualified for Omneon Servers

The following table lists the operating points qualified for Omneon servers in an Interplay
environment.

Interlaced or Frame MPEG Profile Bit Sub-
H v Progressive Rate and Level Rate sample Sony Product
1920 1080 Interlaced 59.94  422P@HL 50 CBR 422 XDCAM HD Phase 111
1920 1080 Interlaced 50 422P@HL 50 CBR 422 XDCAM HD Phase IIT
1280 720  progressive 59.94  422P@HL 50 CBR 422 XDCAM HD Phase IIT
1280 720  progressive 50 422P@HL 50 CBR 4.2.2 XDCAM HD Phase III

Operating Points Qualified for AirSpeed Multi Stream

The following table lists the operating points qualified for AirSpeed Multi Stream in an Interplay
environment.

Interlaced or Frame MPEG Profile Bit Sub-

H \") Progressive Rate and Level Rate sample Sony Product

1920 1080 Interlaced 59.94  422P@HL 50 CBR 4.2.2 XDCAM HD Phase III

1440 1080 Interlaced 59.94 MP@HL 35 VBR 4.2.0 XDCAM HD

1920 1080 Interlaced 59.94 MP@HL 35 VBR 4.2.0 XDCAM EX

1440 1080 Interlaced 59.94 MP@H-14 25 CBR 4.2.0 XDCAM HD & EX
(HDV)

1440 1080 Interlaced 59.94 MP@HL 18 VBR 4.2.0 XDCAM HD

1920 1080 Interlaced 50 422P@HL 50 CBR 422 XDCAM HD Phase 111

1440 1080 Interlaced 50 MP@HL 35 VBR 4.2.0 XDCAM HD

1920 1080 Interlaced 50 MP@HL 35 VBR 4.2.0 XDCAM EX

1440 1080 Interlaced 50 MP@H-14 25 CBR 420 XDCAM HD & EX
(HDV)

1440 1080 Interlaced 50 MP@HL 18 VBR 4.2.0 XDCAM HD

1280 720  progressive 59.94  422P@HL 50 CBR 422 XDCAM HD Phase IIT

1280 720  progressive 50 422P@HL 50 CBR 422 XDCAM HD Phase III
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Operating Points for Sony XDCAM HD and XDCAM EX

Operating Points Qualified for Interplay Transfer Playback

%

Due to variations in FTP servers, Avid cannot guarantee that the GENERIC_FTP and OP1A
_EXPORT profiles will work with all FTP servers. In addition to specific playback devices, we
have also tested with FileZilla and Linux Vsftpd FTP servers.

Note that the GENERIC_FTP_PROFILE and the OP1A_EXPORT_PROFILE expect that the
files on the FTP server will have an ".mxf" extension, and that these profiles will not work with
servers that don't.

The Grass Valley K2 does not use MXF extensions and the OP1A_EXPORT_K2 profile was
created to handle that and other differences with that server. This profile may work with other
servers that don't use the extension, but this cannot be guaranteed and it is best to try it first.

The following table lists the operating points qualified for Interplay Transfer Generic FTP
playback.

For Interplay v2.5, Avid has not qualified AVC-Intra FTP for any specific video servers. Support
is for Generic FTP only.

Generic_FTP_Profile - DHM Workflows

H Interlaced / Frame Rate
Format Ingest Playback W NTSC/PAL Progressive NTSC/PAL
DV 25 Yes Yes 720 480/576 Interlaced 29.97, 25
DV 50 Yes Yes 720 480/576 Interlaced 29.97,25
IMX 30 Yes Yes 720 486/576 Interlaced 29.97, 25
IMX 40 Yes Yes 720 486/576 Interlaced 29.97, 25
IMX 50 Yes Yes 720 486/576 Interlaced 29.97, 25
DNxHD 145 Yes Yes 1920 1080 Interlaced 59.94
DNxHD 120 Yes Yes 1920 1080 Interlaced 50
*XDCAM HD Phase III Yes No 1920 1080 Interlaced 59.94, 50
4:2:2 50Mbps CBR
AVC-Intra 50 Yes Yes 1440 1080 Interlaced 59.94, 50
AVC-Intra 50 Yes Yes 960 720 Progressive 59.94, 50
AV C-Intra 100 Yes Yes 1920 1080 Interlaced 59.94, 50
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Operating Points for Sony XDCAM HD and XDCAM EX

Generic_FTP_Profile - DHM Workflows

H Interlaced / Frame Rate
Format Ingest Playback W NTSC/PAL Progressive NTSC/PAL
AVC-Intra 100 Yes Yes 1280 720 Progressive 59.94, 50
*XDCAM HD Phase III  Yes No 1280 720 Progressive 59.94, 50
4:2:2 50Mbps CBR
*XDCAM HD EX Yes No 1280 720 Progressive 59.94, 50

35Mbps VBR

* Playback of XDCAM HD formats cannot be performed with GENERIC_FTP_PROFILE.

Avid has qualified the supported XDCAM HD formats with the Omneon Spectrum and Grass
Valley K2 servers. OP1A_EXPORT profile was used for Omneon playback,
OP1A_EXPORT_K2 was used for K2 playback, and GenericFTP was used for ingest.

Avid has qualified the OP1A_EXPORT profile with the Omneon server and the
OP1A_EXPORT_K2 Profile with the Grass Valley K2 server. These profiles may work with
other devices that play and record Sony compliant media, but variations have been found and
these are the only servers that we can guarantee will work. Deviations from the Sony XDCAM
HD specification may result in clips not being recognized as the correct format, longer splicing
and encoding times on export, or failure to work.

OP1A_Export - DET Workflows to Omneon and Other FTP Servers

Frame
Interlaced / Rate Profile

Format Ingest Playback W H Progressive NTSC/PAL and Level
XDCAM HD Phase III No Yes 1920 1080 Interlaced 59.94, 50 422@HL
4:2:2 50Mbps CBR

XDCAM HD Phase III No Yes 1280 720 Progressive 59.94, 50 422@HL
4:2:2 50Mbps CBR

XDCAM HD EX No Yes 1280 720 Progressive 59.94, 50 MP@ML

4:2:0 35Mbps VBR

The following table lists the K2 media server playback formats available when setting up an FTP
Server profile using Server Type: OP1A_EXPORT_K2. For information about working with a
K2 server, see the document Working with a Thompson Grass Valley K2 Media Server.
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Operating Points for Sony XDCAM HD and XDCAM EX

OP1A_Export_K2 - DET Workflows to Grass Valley K2

Frame
Interlaced / Rate Profile

Format Ingest Playback W H Progressive NTSC/PAL and Level
XDCAM HD Phase III  Yes Yes 1920 1080 Interlaced 59.94, 50 422@HL
4:2:2 50Mbps CBR

XDCAM HD Phase III  Yes Yes 1280 720  Progressive 59.94, 50 422@HL
4:2:2 50Mbps CBR

XDCAM HD EX Yes Yes 1280 720  Progressive 59.94, 50 MP@ML

4:2:0 35Mbps VBR

Supported Formats for Sony XDCAM Profile - used only with Sony XDCAM Decks

H Interlaced / Frame Rate
Format Ingest Playback W NTSC/PAL Progressive NTSC/PAL
DV 25 Yes Yes 720 480/576 Interlaced 29.97, 25
DV 50 Yes Yes 720 480/576 Interlaced 29.97,25
IMX 30 Yes Yes 720 486/576 Interlaced 29.97, 25
IMX 40 Yes Yes 720 486/576 Interlaced 29.97, 25
IMX 50 Yes Yes 720 486/576 Interlaced 29.97, 25
HD 1080i 17.5 Mbps Yes No 1440 1080 Interlaced 59.94, 50
HD 1080i 25 Mbps Yes No 1440 1080 Interlaced 59.94, 50
HD 1080i 35 Mbps Yes No 1440 1080 Interlaced 59.94, 50
HD 1080p 17.5 Mbps*  Yes No 1440 1080 Progressive 23.976
HD 1080p 25 Mbps? Yes No 1440 1080 Progressive 23.976
HD 1080p 35 Mbps?® Yes No 1440 1080 Progressive 23.976
XDCAM HD Phase III ~ Yes No 1920 1080 Interlaced 59.94, 50
4:2:2 50Mbps CBR
XDCAM HD Phase III ~ Yes No 1280 720 Progressive 59.94, 50

4:2:2 50Mbps CBR
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New for Interplay v2.7

a. Half height clips (1440x540) are not supported for 1080p formats.

New for Interplay v2.7

For information about the new features in Interplay Production version 2.7, see What’s New for
Interplay v2.7 on the Knowledge Base and in the Interplay Help.

Additional 64-Bit Support

Interplay v2.7 introduces support for 64-bit versions of the following software:
*  Media Services Engine v2.7 and higher
*  Copy, Move, and Delivery Providers v2.7 and higher

Note that the v2.7 versions of these applications are only supported on a 64-bit OS. Currently,
these applications have only been qualified on the AS3000 platform.

Interplay Sphere

Interplay v2.7 introduces support for Interplay Sphere. For additional information see the
following documentation:

*  Avid Interplay Sphere Installation and Configuration Guide

»  Interplay Common Playback Service Version 1.2.3 Installation & Configuration Guide
*  Avid Interplay Sphere Remote News Editing Workflow Guide

*  The Help for your Media Composer v6.5 or NewsCutter v10.5 application

*  The Interplay v2.7 Help

Documentation Changes

Avid Instinct Does Not Support STP Encode

“Performing Send-to-Playback as a Background Process from an Avid Editing Application” in
the Avid Interplay Media Services Setup and User’s Guide states that the option “PWT” is
referred to as “High Priority” in Interplay Assist and Avid Instinct. STP Encode is supported in
Interplay Assist, but not in Avid Instinct.
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Fixed in v2.6

Fixed in v2.6

>

Bug Number: UDevC0016879. Using View > Show Shared/Unshared Clips in Access. The
system returned zero results for “show shared clips” in the “Shared/unshared clips in folder”
dialog box. The “show unshared clips” option also returned zero results. This has been fixed.

Bug Number: UDevC00164682. (Avid editing systems) You can now send a 10801 59.94
sequence to playback if it contains a DNxHD 444 1080p clip.

Bug Number: UDevC00165757. QuickTime files that you import in a 720p/23.976 project on
an Avid editing system can now link to partially restored media.

Bug Number: UDevC00165498. Interplay Access now supports streaming play of up to 16
tracks of MPEG1 Layer 2 audio.

Bug Number: UDevC00155898. Media Indexer: Previously, when the MIs in the HAG were
indexing, changes made to the HAG leader did not apply to the secondary MI until the secondary
MI finished indexing. This has been fixed.

Bug Number: UDevC00163256. (Interplay Assist) An Interplay user whose login name uses
Simplified Chinese characters can now log in to Media Services in Interplay Assist.

Bug Number: UDevC00163736. If you send a Transcode provider job from a Media Composer,
and the profile contains Chinese characters, the job now processes.

Fixed in v2.5

>

Bug Number: UDevC00164495. The Interplay Engine uninstaller on a failover cluster node
now completely removes Interplay Engine services, including the Avid Workgroup Monitor
Service.

Bug Number: UDevC00163591. The Resync command in Interplay Access now correctly
checks orphan media in to the Orphan clips folder as expected.

Bug Number: UDevC00158050. (Interplay Engine on Windows Server 2008 R2 systems)

When you use the Manage Databases view in the Interplay Administrator to activate a
deactivated database, you can now click the Browse button to browse for the .pro file.
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Fixed in v2.4

Fixed in v2.4

Fixed in Media Indexer v2.4

>

Bug Number: UDevC00151863. Media Indexer: Due to a problem in a third party library, all or
some communication to and from Media Indexers can become blocked. This can result in media
offline for all media on the node. This has been fixed.

Bug Number: UDevC00155050. Media Indexer: If a resync occurs while an initial scan is in
progress, the Media Indexer may not finish indexing the storage space. This has been fixed.

Bug Number: UDevC00154624. Media Indexer: Some folders are not deleted during nightly
resync. This has been fixed.

Bug Number: UDevC00153191. Media Indexer: Occasionally on startup, Media Indexer stops
any indexing activity. The result is that new material does not come online. This has been fixed.

Bug Number: UDevC0051869. Media Indexer: MI Client requests such as client lookups may
hang temporarily during a Remove Workspace operation. This has been fixed.

Bug Number: UDevC00150060. Media Indexer, Interplay Service Configuration tool: The
right-hand side pane does not display scroll bars in specific cases. This can be a problem when
configuring a Media Indexer from a KVM with a resolution of 1024x768. You cannot access the
Configure button at the bottom of the window. This has been fixed.

Fixed in v2.3

>

Bug Number: UDevC00142012. AVC-Intra resolutions are now supported for send to playback
with Generic FTP profile. Note that Avid has not qualified AVC-Intra FTP for any specific
videos servers. Support is for Generic FTP only.

Bug Number: UDevC00149596. Interplay Transfer logs into Interplay for each Checkin. This
has been fixed.

Bug Number: UDevC00149598. Workgroup-to-workgroup transfer generates duplicate media
files. This has been fixed.

Bug Number: UDevC00149677. Interplay Transfer reports false licensing error. This has been
fixed.
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Fixed in v2.3

Bug Number: UDevC00149682. FTP DHM transfers createMXF OP1a files with duplicate
Package Ulds. This has been fixed.

Bug Number: UDevC00149851. Interplay Transfer quits unexpectedly when performing
multiple workgroup-to-workgroup transfers. This has been fixed.

Bug Number: UDevC00149535. Transfer Engine ingest of XDCAM HD does not handle
precharge (Origin > 0) in MXF. This has been fixed.

Bug Number: UDevC00149548. Transfer Engine start time code and mark in are incorrect for
720p60 XDCAM HD media. This has been fixed.

Bug Number: UDevC00149626. . Transfer Engine cannot ingest non-D10 wrapped IMX from
Omneon. This has been fixed.

Bug Number: UDevC00149574. Assist: Video ID does not populate in original sequence while
sending to playback. This has been fixed.

Bug Number: UDevC00146890. Audio Popping in Assist when playing back grouped track.
This has been fixed.

Bug Number: UDevC00133597. Assist: Runtime Error on launch. This has been fixed.

Bug Number: UDevC00149583. Archive provider: Unable to Archive assets that do not contain
a Headframe. This has been fixed.

Bug Number: UDevC00149099. Stream Publish error's on IPV chunked clips. This has been
fixed.

Bug Number: UDevC00142655. ICS: If you were working with French characters, and you
added text to the Notes and Comments fields in Capture Manager, these comments were not
displayed in Interplay Access. This has been fixed.

Bug Number: UDevC00131380. Interplay Administrator: In the Interplay Administrator, if you
applied new values to a folder in the Editor Export Settings for Pro Tools or the Pro Tools Import
settings, the root folder or another folder on the same level of the database might have shown
incorrect values if it was selected afterwards. This has been fixed.

Bug Number: none. Interplay Access: If you drag an Avid asset from Interplay Access to an
editor bin, the cursor no longer changes to a “no-entry” icon.
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Fixed in v2.2.1

Media Indexer Fixes

For additional information, see “Documentation Changes” on page 53.

Bug Number: none. Changed the locking concept of the internal database access. The service is
now able to handle multiple read requests in parallel instead of just one reader.

Bug Number: none. Disabled security manager to improve performance.

Bug Number: none. Getting file attributes and modification times together with a folder
enumeration in one step. This decreases the network traffic and increases overall performance.

Bug Number: none. Add the ability to recover from a stalled ummdworker process. In previous
releases, the Media indexer could hang if ummdworker process was blocked. This has been
fixed.

Bug Number: UDev144576. Consolidated P2 material was being indexed properly in DS
standalone, but showed offline in Interplay Media Indexer. This has been fixed.

Bug Number: none. Improved logging: Log warning message when folders are found with
more than 5,500 and 10,000 files. For details on the improved logging and for recommendations
on limiting the number of files in a folder, see the Interplay Best Practices Guide.

Bug Number: none. New configuration option added to ignore delete notifications on a global
or workspace basis. See the Interplay Best Practices Guide.

Fixed in v2.2.1

>

Bug Number: UDevC00145803. Standalone Interplay Transfer: Users were unable to send to
AirSpeed Classic from a Standalone Transfer Engine on a Standalone editor. This has been fixed.

This fix also requires a separate AirSpeed IOPeripherals application installer that contains fixes
to the Airspeed 10 Apps. The release version for the AirSpeed 10Peripherals installer is v2.7.2.
Contact you Avid representative for the location of the IOPeripherals installer.

Note that you must specify port 6535 when defining the Playback Device name in the Interplay
Transfer Configuration file. The following illustration shows the correct naming convention
<TMHostname>:6535/<AirSpeed hostname>.
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Fixed in v2.2.1
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Note that you cannot use AirSpeed Classic to send to playback with Ancillary data tracks.

»  Bug Number: UDevC00146093. Cannot Restore sequences from archive if they contain Boris
effects. This has been fixed.

»  Bug Number: UDEVC00145461. Pro Tools Interplay Option: Version comment fields added
during a Checkin to Interplay were not displayed in the Interplay Window. This has been fixed.

»  Bug Number: no number. At Interplay v2.2 for cluster installations, you had to manually install
the Microsoft Runtime C++ Library 2008 as part of the upgrade from Interplay v1.6 or v2.0.
This problem is fixed in Interplay v2.2.1.

»  Bug Number: UDevC00143516. Interplay Engine: Folder property

"CumulChildCountUpperBound" not working correctly. This caused some searches to run very
slow. This problem is fixed.
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Fixed in v2.2.1

Bug Number: UDevC00144173. Interplay Engine: Upgrade from v1.6.4 DB with overlapped
objects to v2.1 not possible. In some cases the database upgrade from v1.6 did not work. This
problem is fixed.

Bug Number: UDevC00145151. Assist Restrictions: Restrictions disappeared after modifying
restriction text. This problem is fixed.

Bug Number: UDevC00145758. AMA Consolidated clips showed as offline in Access after
performing Update from Media Indexer. This problem is fixed.

Bug Number: UDevC00146152. Interplay Engine: Some searches did not return correct results.
This problem is fixed.

Bug Number: UDevC00142459. Omneon: Performing a Generic FTP Send to Playback with a
DNxHD sequence containing Ancillary data to an Omneon Media server fails. The job fails in
the editor's Transfer Status window. This has been fixed.

Bug Number: UDevC00141099. When deleting the Data track from a bin, you get an error
"deleting shared media". This has been fixed.

Bug Number: UDevC00141602. Shotlists created on Assist do not contain the D track when
checked into Interplay and then checked out into an Avid editing application such as NewsCutter.
This has been fixed.

Bug Number: UDevC00141737. Editor generated clips containing a D Track fail Workgroup to
Workgroup transfers. This has been fixed.

Bug Number: UDevC00139908. Send To Playback (STP): Encode fails to complete jobs
containing sequence with D-track masterclips from K2 and Omneon. This has been fixed.

Bug Number: UDevC00141941. Playing back currently ingesting Edit While Capture (EWC)
AirSpeed Multi Stream XDCAM 50mbps clips in an editor generates an AncDataPacetCvtr
error. This has been fixed.

Bug Number: UDevC00141657. Editor/Restore: Restoring ancillary data tracks: If you restore
a D track from Archive and reload the clip in the editor, the data may not be visible until you use
the "Reset Offline Info" command or restart the editor. The D track appears online in Access but
the Ancillary data does not appear in the decoder on the monitor. This has been fixed.

Bug Number: UDevC00141945. Sequences with Ancillary Data previously sent to playback
from an editor to K2 cannot transfer masterclip back to Interplay. This has been fixed.
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Fixed in v2.2

Bug Number: UDevC00141985. Partial Restores of sequences containing Ancillary Data
media, restore without the D-track. This has been fixed.

Bug Number: UDevC00141996. Full Restores of Sequences containing Ancillary Data do not
restore the D Track. This has been fixed.

Bug Number: UDevC00141634. Ancillary Data captures with Interplay Capture do not contain
Ancillary Data or are offline. This has been fixed.

Bug Number: UDevC00141643. Capture Manager gives checkin failed with Dual Res
Ancillary Data captures. This has been fixed.

Bug Number: UDevC00141969. In Assist, sequences and shotlists with Ancillary Data cannot
be sent to playback with XDCAM/Long GOP profiles. This has been fixed.

Bug Number: UDevC00142014. 720p60 media ingested from Omneon via TM is corrupt when
played in editor. This has been fixed.

Bug Number: UDevC00141922. Sequences consisting of Omneon Ingested media gets
Assertion failed: numBytes error when sent to Omneon and AirSpeed Multi Stream. This has
been fixed.

Fixed in v2.2

>

Bug Number: UDevC00135003. (Interplay Access). Previously, under some circumstances, if
you use the Media Services Transcode service from Interplay Access, the wrong resolution dot
might be displayed when you check in a clip. This has been fixed.

Bug Number: UDevC00137711. In previous releases, if a user ran Interplay Assist or Avid
Instinct as an Administrator and later ran the application as a non-Administrator, the Interplay
Transfer client could not download an updated send-to-playback device list (Windows Vista and
Windows 7 only). This problem resulted occurred because the TMclient.ini file was not writable
by a non-Administrator user. This problem has been fixed in the current release.

However, the problem remains if the upgraded Assist or Instinct system still has a TMclient.ini
file that is not writable by a non-Administrator user. In this case, the following dialog box is
displayed after you log in to Interplay.
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Fixed in v2.2

rﬂ Avid Interplay Assist

F&.  Could not write file "C:\ProgramData\Avid\avid Interplay AssistiTMClient.ini™,
Access ig denied.
Please check file permissions and/or delete this file.

=)

You can change the permissions on the file so that the current user has write permission or
simply delete the file. The file will be recreated the next time you log in to Interplay.

Bug Number: UDevC00139527. Transcode Provider: Mixdown jobs run by the Transcode
provider throw "Ampi Subsystem" errors when the Transcode provider is running on the same
system as Media Service Engine or other providers. This has been fixed.

Bug Number: no number. You can now create AVC-Intra material using Interplay Media
Services transcode features.

Bug Number: no number. You can now keep Dynamic Relink on while importing AVC-Intra
material.

Bug Number: UDevC00or , UDevC00139728. Previously, a Macintosh editing system that you
disconnected from the network hung when starting, and you needed to run a Console command
or script to start it. This has been fixed. Now a message is displayed and asks if you want to run
in disconnected mode."

Bug Number: UDevC00135147. Previously, the OK and Cancel buttons did not work correctly
in the Workgroup Properties view in the Interplay Administrator. These buttons are not needed
and have been removed.

Bug Number: UDevC00086641. Interplay Assist: Previously Assist/Instinct on launch set a
default audio level in the Windows volume control. Now it will not change the level you have
already established.

Note: This fix will not work on Windows XP if you are running the application and an Avid
editing application on the same machine, unless you select "Use Windows Mixer" in the Avid
editing application. Use the following steps:

*  Open the Avid editing system.
* In the Settings list, open the Sound Card Configuration settings.

e Select "Use Windows Mixer."
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Fixed in v2.2

»  Bug Number: UDevC00135003. Previously, if you used the Media Services Transcode service
from Interplay Access, the wrong resolution dot might have been displayed when you check in a
clip. This has been fixed.

»  Bug Number: UDevC00132253. (Interplay Window, Assist, Instinct) Previously, if a clip was
checked in without a name, and the clip was returned as a search result in the Interplay Window,
Interplay Assist, or Avid Instinct, the search stopped with an error. This has been fixed.

»  Bug Number: UDevC00134578 . Previously, on Macintosh editing systems running Mac OSX
10.6.2 (Snow Leopard), double-clicking the Interplay Access or Interplay Administrator icon in
the doc displayed Java error messages. This has been fixed.

Media Indexer Fixes

The following problems were fixed in Media Indexer v2.1.1 and v2.1.2 and are also incorporated
into this release.

»  Bug Number: No number. The following changes are made to Media Indexer:
*  Media Indexer now indexes ancillary data files
e Media Indexer now distinguish between "updated" and "new" files found during resync
*  Media Indexer now supports extended "bounds" attributes on the DigitallmageDescriptor
object
»  Bug Number: UDevC00139146. MI Election tests causing THROW:s in diagnostic tools

> Bug Number: UDevC00143116, UDevC00142835, UDevC00142835 . Fixes for deadlock
issues, causing media offline.

»  Bug Number: UDevC00142484. Mac: Fixed a problem causing utest crash/hang on Snow
Leopard.

»  Bug Number: UDevC00142482. Mac: Multiple instances of MI could run on the MAC; A
change was made to prevent this situation.

»  Bug Number: UDevC00142483. Mac: MI can now be manually started and stopped on Mac.
»  Bug Number: UDevC00139146. Fixed a problem where Media Indexer flagged new media as

NEARLINE (showing yellow dots in Access) when an adapter was moved in the MI
configuration or when a backup MI in the HAG copied the configuration of the primary.
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Fixed in v2.2

Bug Number: UDevC00136961. Fixed a span issue that occurred with some 3rd party MXF
audio files coming from tape.

Bug Number: UDevC00117937. Fixed "Unable to find key" errors that could occur on elections
MI config changes. The problem caused missing items in the Health Monitor.

Bug Number: UDevC00140781. Fixed a deadlock that could occur in the HealthProducer
thread when removing an MI from the HAG.

Bug Number: UDevC00138985. Improved MI logging capabilities to hide useless messages
and increase the level of important messages.

Bug Number: UDevC00136806. Implement audit trail for handling of file system operations.

Bug Number: UDevC00136802. Fixed a race condition that could cause file count
discrepancies between the Media Indexers in a HAG.

Bug Number: UDevC00137718. Health Monitor could get stuck on the Media Indexer health
page in some situations when no workers were running. This has been fixed.

Bug Number: UDevC00136765. Local storage Media Indexer. Previously, if you started a local
Media Indexer that contained a HAG entry in its configuration, the MI could get stuck in its
initial scanning state. This has been fixed.

Bug Number: UDevC00135821. Added some logging to help find a number of files
discrepancy in a HAG.

Bug Number: UDevC00134692. UMMDWorker handshake failures can block all media
indexing. This has been fixed.

Bug Number: UDevC00135197. Fix deadlock in MI shutdown.

Bug Number: UDevC00135301. Fixed a problem that caused Media Indexer to spend too much
time performing a getFileAttributes() call during scanning. This fix improves MI scanning
performance.

Fixes for Discrepancies in File Count Between Mis in the HAG

>

>

Bug Number: UDevC00138589. Fixed a problem where the MI ignored listFiles I/O exceptions
in the scan folder thread (causing file count discrepancy).

Bug Number: UDevC00136805. Fixed a race condition between file system and folder monitor
scans (serialized scanning). The problem caused file count discrepancy.
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Bug Number: UDevC00137614. Fixed a race condition between add datasource and commit
that caused an inaccurate file count in the Health Monitor.

Bug Number: UDevC00139325. Fixed a problem where the Health Monitor media files count
was inaccurate when removing storages with duplicate files.

Fixed in v2.1

>

Bug Number: UDevC00111255. If an Interplay Administrator edits a property list for a custom
column (by importing a new file in the Custom MetaData tab of the Property Layout view), an
Interplay Access user needs to close and restart Interplay Access to view the updated property
list. This has been fixed. Press F5 to see the changes immediately.

Bug Number: UDevC00113396. In an Interplay environment, if an Avid editor mounts the
workspaces using UNC, and you used the Move service to move files from one workspace to
another workspace, the Avid editing application’s bin did not show the new location of the
moved files. This has been fixed.

Bug Number: UDevC00132085. Third party search (also known as Federated search) did not
work in Interplay Access. This has been fixed.

Bug Number: UDevC00132324. Folder names that are assigned a color in Interplay Access did
not display colored text in Interplay Assist, Avid Instinct, or the Interplay Window. This has been
fixed

Bug Number: UDevC00132328. Streamable properties are removed from sequences and clips,
after performing a Send to Playback to Airspeed Studio. The assets are not streamable and they
lose the green triangle indicating that they are streamable. The sequence also shows no
masterclip or subclip relatives. This has been fixed.

Bug Number: UDevC00126946. In Interplay Assist, if you create a shotlist, switch to Source
mode, load a clip with a different resolution from the current clip, then select Send Shotlist to
Playback while you are in Source mode, the operation might fail with the error message "One or
more segments are not available in the target resolution." This has been fixed.

Bug Number: UDevC00126315. Selecting Help > Documentation Website on Server does not
open the Interplay User Assistance Center. This has been fixed.

Bug Number: UDevC00130269. Setting many locators on a large shotlist can create
FileNotFound exceptions in workgroup.log. This has been fixed.
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»  Bug Number: UDevC00130379. Clips that are transcoded to MPEG-4 video and published, but
do not include audio, do not play back in the Monitor. A clip might play for a few seconds and
then stop. Workaround: If a clip contains audio, transcode and publish both the video and the
audio. This has been fixed.

»  Bug Number: UDevC00131838. If you want to reinstall the same version of the Interplay
Stream Server, selecting Repair results in error 1722 and the installation fails. This has been
fixed.

»  Bug Number: UDevC00130133. Performing Update Status from Media Indexer does not
update the filemobs. This has been fixed.

»  Bug Number: UDevC00130670. Performing an AAF Export of non published clip in Access
generated a Null Pointer Exception error. This has been fixed.

»  Bug Number: UDevC00131725. Loading an Access shotlist composed of Low Res Encode
generated clips results in PMM/Insufficient Media errors. This has been fixed.

»  Bug Number: UDevC00133240. Manager allowed you to duplicate clips in the Archive
Manager. This has been fixed. You can no longer duplicate clips in the Archive Manager.

»  Bug Number: UDevC00121434. 64-Bit Media Indexer Install: Updating the 64-Bit Media
Indexer software does not remove the previous version. This has been fixed.

Fixed in v2.0.1

The following problems are fixed in Interplay v2.0.1.

»  Bug Number: UDevC00129418. Extended searching for published media ("Streamable media
is published") returned only master clips and to filter out other media types. This has been fixed
by renaming the search expression to “Streamable Masterclips”. It is still not possible to search
for streamable sequences and subclips.

»  Bug Number: UDevC00130335. The shortcut for deleting locators (Ctrl+Shift+Delete in
Windows, or Shift+Command+Delete in Mac OSX) did not work when the keyboard focus was
on the Monitor. This has been fixed.

»  Bug Number: UDevC00130501. Versions of Interplay Access earlier than V2.0 might not

display timecode for locators in a clip that is checked into an Interplay V2.0 database. This has
been fixed.
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»  Bug Number: UDevC00130711. Applying settings for Pro Tools Import on folders other than
the root resulted in an error message. This has been fixed.

»  Bug Number: UDevC00130852. An audio-only clip in Access could be used a subclip or as the
first shot in a shotlist only if the In mark is on the first frame. This has been fixed.

»  Bug Number: UDevC00130229. If you double-clicked a published clip, the clip loaded in the
Monitor but did not play. This has been fixed.

»  Bug Number: UDevC00130850. Opening a shotlist in Media Composer that was created in
Interplay Access from subclips created in Media Composer or Interplay Assist resulted in an
exception (Sequence refers to non-existent track in clip). This has been fixed.

Limitations

This section describes existing limitations and problems.

For International Character Set (ICS) limitations, see “International Character Support
Limitations” on page 119.

Limitations for Version v2.7

>

Bug Number: UDevC00171474, UDevC00173048 . (Avid editing systems) You cannot
dynamically relink to DNxHD 100 or DNxHD 85 media using the following settings:

*  Ifno match is found: Relink to Offline
*  Relink Method: Specific Resolution
* Relink if quality: is equal to DNxHD 100 or DNxHD 85

This problem applies to both in-progress media (edit while capture, or EWC) and completed
clips.

Workaround: Set the “If no match is found:” option to Use Closest Media.

Bug Number: UDevC00172604. Interplay Sphere install option for Delivery Receiver: If you
perform an upgrade of the Delivery Receiver software, the installer does not upgrade or install
Web Services (required for Sphere support).

Workaround: When upgrading Delivery Receiver software to include Sphere support, uninstall
Delivery Receiver first and then perform the installation
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Bug Number: UDevC00170276. (Standalone Interplay Transfer and Airspeed Multi Stream)
Interplay Transfer includes an option “Allow Ancillary Data Tracks” when creating a profile for
Send to Playback. If you do not select this option, and you try to send a sequence containing a
data track to an AirSpeed Multi Stream server, the ancillary data track is not correctly removed.
If you then use a standalone editor to ingest the clip stored on the server, Interplay Transfer
hangs and times out.

Workaround: Change the profile, or create a new profile, with the option “Allow Ancillary Data
Tracks” selected.

Bug Number: UDevC0017305. (ProEncode) By default, the ProEncode client installer installs
Java version 6 Update 5. The current Windows 7 client supports only version 9 of Internet
Explorer. If you use Internet Explorer 9 with Java version 6 update 5, an Internet Explorer dialog
is displayed and causes Internet Explorer to crash. This causes the Submit to ProEncode to fail

Workaround: Uninstall Java version 6 Update 5 and replace it with Java 6 Update 33 — 32bit.

Bug Number: UDevC00171161. The Media Indexer reports an error situation if there is less
than 10 GB of space left on the drive that hosts the log files. This is usually the C: drive. This is
not a critical error but the MI will only keep the current day’s log files when this occurs.

Starting at Interplay v2.6, the MI automatically zips and stores its log files. If there is less than 10
GB free space on the drive that stores the log and cache files, the MI starts removing zip files,
oldest first, until more than 10 GB is free. Note that the current day’s archive is not removed. For
additional information, see What’s New for Interplay v2.6 on the Avid Knowledge Base.

Bug Number: UDevC00172309. Interplay Sphere: After you upload a clip, the original clip
may not show the local media path in Access.

Workaround: After you perform a remote upload of a clip, check the original clip into Interplay
from the editor and then check it out. Now when you view the clip in Access the clip will show
the local media path in the Access Object Inspector.

Bug Number: UDevC00158274, UDevC00157438 . STP with Studio can fail if one TM in the
Studio stops running. This problem can occur if you send one of the following jobs to an
AirSpeed Multi Stream Studio:

* Any sequence sent as a foreground encode job

e STP Encode of an XDCAM HD sequence

If the Interplay Transfer service on any of the AirSpeed Multi Stream systems in the Studio
stops, the job will fail with either a “kCancel” or “Transfer Failed” error. This happens even if
the Interplay Transfer service on the system processing the job is still running.
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Bug Number: UDevC00170420. Interplay Access: The Help menu is not active until you select
an item in the Access window.

Workaround: Select a database in the tree view and the Help menu becomes active.

Bug Number: UDevC00161587. (ProEncode and Telestream Flip Factory) On an AS3000
running Windows 7, Flip Factory v7.2 fails to start the Flip Engine if Gold Disk policies are
enabled. This blocks operation of Flip Factory and ProEncode.

Bug Number: UDevC00171517. (ProEncode and Telestream Flip Factory) If you send a
sequence composed of DNxHD 100 media to ProEncode, the job fails with an error in the Media
Services and Transfer Status tool stating the encoder threw an error. Flip Factory does not seem
to currently support DNxHD 100 media.

Bug Number: UDevC00172782. (ProEncode and Telestream Flip Factory) When using the
Telestream Flip Factory v7.2 Post to Web tool, .avi files and .wmf files fail with an “Invalid
source file for conversion” error. Workaround: Perform a Direct Export in the Post to Web tool,
then submit the job manually to Flip Factory.

Bug Number: UDevC00163110. If you uninstall any of the Media Services Auto Services, then
open the Avid System Framework Workgroup Properties, an error message is displayed, saying
that the auto services are not properly registered. Workaround: Use regedit to delete the
following registry keys:

«  HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Prefs\avid\workgroups\avid

technology incorporated\data\com\avid\workgroup\activation\windows\services\autoarchive

«  HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Prefs\avid\workgroups\avid
technology incorporated\data\com\avid\workgroup\activation\windows\services\
avidinterplayautomediaservices

*  HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JavaSoft\Prefs\avid\workgroups\av
id technology incorporated\data\com\avid\workgroup\activation\windows\services\
autoarchive

* HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JavaSoft\Prefs\avid\workgroups\av
id technology incorporated\data\com\avid\workgroup\activation\windows\services\
avidinterplayautomediaservices

Bug Number: UDevC00170654. (Avid editing systems) You might receive an error “Unable to
delete database node” when trying to delete a resolution for a dynamically relinked clip.

1. If a clip is associated with several resolutions, dynamically relink to resolution A.

2. Right-click the clip and select Reveal File, then delete the media file that is associated with
resolution A.
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3. Dynamically relink to resolution B.
4. Transcode the clip to resolution A and check it in.

5. Right-click the clip and select Reveal File, then attempt to delete the media file that is
associated with resolution A.

An error “Unable to delete database node” is displayed. This occurs because the editor is trying
to delete media using the old file location that is offline. Workaround: use Interplay Access to
delete the media file.

Bug Number: UDevC00171248. (Capture Manager) If a folder name in Capture Manager
contains more than 25 characters, the folder name is trimmed to 25 characters after the folder is
checked into Interplay. This occurs because Capture Manager limits folder names to 25
characters.

Bug Number: UDevC00171874. (Interplay Archive/Restore) A duplicated clip (new metadata
that points to the same media as another clip) that has not been archived cannot be restored.

Workaround: Archive the duplicate clip.

Bug Number: UDevC00172084. (Interplay Archive and FlashNet) For a configuration in which
a FlashNet client is directly connected to ISIS shared storage, job status in the Media Services
and Transfer Status Tool is not consistently accurate. For example, when a job is completed in
FlashNet, the progress bar reads approximately 75 percent for awhile. Then it jumps to 98
percent, and eventually to 100 percent, depending on the size of the job.

Also, for a sequence that is composed of three archived clips, the first part restored will display
the progress bar at 100 percent green while the other two parts are still processing in FlashNet.
The user might think the job is done and load the sequence, but some media could be offline.

Bug Number: UDevC00172470. When sending clips with Chinese characters in the .mxf
filename or workspace name, the job fails with a third-party error from the FlashNet client. This
occurs when the Interplay Archive provider is set to Simplified Chinese in the “Language for
non-Unicode programs” setting in the Administrative tab of the Region and Language Control
Panel. This is the correct method for the provider configuration.

Workaround: Set the “Language for non-Unicode programs” to English and retry the job.

Bug Number: UDevC00172798, ICTD-284. (Interplay Central) You cannot play H.264
2.0Mbps clips and DNxHD 100 clips in Interplay Central V1.2.1 or earlier.

Bug Number: UDevC00172934. (Interplay Assist and Avid Instinct) Assist and Instinct might
not launch after a clean install and might display the error “Initialized AME () failed.”
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Workaround: Check for NVIDIA driver version 275.89. If you still get an error, reinstall the
NVIDIA driver.

Interplay Assist and Avid Instinct must be installed and launched for the first time by a user with
Administrator rights.
To check the NVIDIA display driver version:

1. Right-click the desktop and select NVIDIA Control Panel.

You can also open the Windows Control Panel and double-click the NVIDIA Control Panel
icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare
version line.

To install the NVIDIA display driver:
1. Navigate to Program Files\Avid\Utilities\nVidia.
2. Double-click the file for the applicable driver.
3. Follow the on-screen instructions to unzip the file and install the driver.

4. When the installation is finished, restart your system.

Limitations for Version 2.6

>

Bug Number: UDevC00170686. When you upgrade STP Encode or the Interplay Transfer
client, use the Add Remove Programs tool in the Control Panel to uninstall the applications
before you upgrade. If you perform the installation over the existing application, the installer
leaves older registry keys behind. These are visible in the Add Remove Programs tool as
additional versions of the Application.

Workaround: If you perform the install over the existing applications and see both versions in
the Add Remove Programs tool, uninstall both versions and then reinstall the v2.6 version of the
application.

Bug Number: UDevC00168988. (Interplay Access on Macintosh) You cannot install Interplay
Access on a Macintosh system if Media Composer is installed first.

1. Install Media Composer v6.1 on a Macintosh system running MacOS v10.7.3.

2. After the installation is completed, try to install Interplay Access v2.6. The installation fails
with the following message in the Install Complete window:
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“The installation of Avid Interplay Access is finished, but some errors occurred during the
install. Please see the installation log at /Applications/Avid/Avid Interplay
Access/log/AvidInterplayAccess_install.log for details.”

If you check the above path, there is no Interplay Access installed and no log files.
Workaround: This bug occurs because Media Composer creates an Avid folder first, and

installs the Codecs PE folder in the Avid folder. This seems to prevent Interplay Access from
adding to the folder. To avoid this problem:

1. After installing Media Composer, rename the Avid folder.
2. Install Interplay Access.

The Interplay Access installer creates a new Avid folder and installs Interplay Access
correctly.

3. Copy the Codecs PE folder from the renamed folder to the Avid folder that the Interplay
Access installer created.

Bug Number: UDevC00168989. (Avid editing applications and Interplay on Macintosh) If you
try to change the name of the Lookup Server (LUS) listed in the Workgroup Properties on an
Apple Macintosh system, the following error is displayed after you click the Apply button:

“unexpected failure to store workgroups”

To change the name of the LUS:

1. Uninstall Media Indexer. See the Avid Interplay Installation and Configuration Guide or the
Interplay Help for instructions.

2. Delete the following file:
/Library/Preferences/avid.workgroups.avid technology incorporated.plist

3. Reinstall Media Indexer as described in the documentation listed in step 1. Make sure you
enter the correct name of the LUS.

Bug Number: UDevC00171686. (Interplay Administrator) Custom backup paths that use the
long UNC format (for example, \\?\d:\backup) are not accepted. A message tells you to specify a
valid path for a custom location.

Workaround: Use a UNC path that is less than 260 characters.
Bug Number: UDevC00167507. (Avid editing systems) In Media Composer v6.1, when the

user right-clicks an object in a bin and selects Media Services > service_name, if the Interplay
workgroup includes a large number of Media Services profiles, some profiles could be offscreen.
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Workaround: Drag the bin to a different location, then try the operation again. Alternatively,
select the bin object, then select File > Media Services > service_name.

Bug Number: UDevC00168120. (Avid editing systems) Stereoscopic clips created from a
simultaneous left/right capture do not load in an editing system if dynamic relink is enabled. An
error message is displayed. As a workaround, disable dynamic relink. Note: Clips created
manually or from QuickTime movies load and play correctly.

Bug Number: UDevC00170548. (Interplay Access) Only 8 tracks are available for setting the
default local mixing in the Preferences > Options > Audio Settings tab. For more than eight
tracks, use the global audio mixing defaults that are set in the Application Defaults tab of the
Interplay Administrator.

Bug Number: UDevC00170454. (Interplay Access) If you use Interplay Access to copy a folder
that contains emulated rendered effects on an Interplay v2.3 or later database, the copying
process will stop and the following error is displayed: “Rendered Effects cannot be copied.”

Bug Number: UDevC00170453. (Interplay Administrator) If a Metadata Only backup is
executed on a new database without previous backups, an exception message is displayed in the
Schedule Backups view of the Interplay Administrator and nothing is displayed in the Backup
History.

Bug Number: UDevC00170424. (Interplay Transcode) If you send a stereoscopic sequence
with more than one track to Interplay Transcode for Full Stereoscopic mixdown, and you play
the resulting .mix file in an Avid editing application, you see only track V1.

Bug Number: UDevC00170490. (Interplay Assist) If you add a restriction with a comment to a
stereoscopic clip in Interplay Assist and save the file, then open the file again in Assist or an
Avid editing application, the restriction markers are displayed but the comment is not displayed.

Bug Number: UDevC00170817. (Documentation) The following keyboard shortcuts are
incorrectly documented in the Avid Interplay Access User’s Guide and the Interplay Help.

*  With focus in the monitor: “Enter” starts playback from beginning instead of adding a
locator.

*  With focus in the monitor: “5” edits the timecode overlay instead of starting playback

«  With focus in the monitor: Up Arrow causes jump to previous locator instead of next one
and Down Arrow causes jump to next locator instead of previous one.

Bug Number: UDevC00170515. Archive Engine upgrade install problem: If you cancel an
upgrade installation of the Archive Engine, the existing Archive Engine will have problems
starting and you will not be able to import your Interplay licenses. The problem occurs if you
cancel the installation at the Welcome screen for the installer.
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Workaround: Reinstall the Archive Engine and reboot as usual.

Bug Number: UDevC00163110. Auto Media Services: After you uninstall Auto Media
Services, the Avid Service Framework displays a message that the application is still registered.
This is because the uninstaller leaves the following four registry keys behind:

HKEY_LOCAL_MACHINE\SOFTWARE\avaSoft\Prefs\avid\workgroups\avid technology
incorporated\data\com\avid\workgroup\activation\windows\services\autoarchive

HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Prefs\avid\workgroups\avid technology
incorporated\data\com\avid\workgroup\activation\windows\services\
avidinterplayautomediaservices

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JavaSoft\Prefs\avid\workgroups\
avid technology incorporated\data\com\avid\workgroup\activation\windows\
services\autoarchive

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\JavaSoft\Prefs\avid\workgroups
\avid technology incorporated\data\com\avid\workgroup\activation\windows\services\
avidinterplayautomediaservices

Workaround: Ask an administrator or your Avid representative to remove the four registry keys.

Bug Number: UDevC00169950. Workgroup to Workgroup Transfers occasionally fail and
leave media files in the following temp directory on the sending workgroup:

<drive>:\Avid MediaFiles\MXF\<TM_Name>\temp

Bug Number: UDevC00170653. When you click on the Pro Tools Interplay Client installer, the
system displays the following error:

On Preload, Line10: attempt to concatenate global_PTGUID

Workaround: Click OK and continue with the installation. The problem is only related to
starting the installer.

Bug Number: UDevC00165058. Interplay Transfer: When configuring FTP servers, you must
edit the Interplay Transfer Configuration tool as an Administrator. Otherwise the registry keys
created from the FTP servers will be placed in the wrong directory and Transfer Manager will be
unable to use them.

Bug Number: UDevC00149462, UDevC00166857. FTP Media Browse strips ICS characters

from the name when sending to a K2 server. The problem occurs for both single byte and multi
byte characters.
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Bug Number: UDevC00161489. Send to Playback of an XDCAM HD sequence fails if it
contains either 8 or 16 audio tracks The problem also occurs for XDCAM HD sequences with a
surround sound track.

Workaround: For the 8 or 16 track sequences, mixing down two or more for a total of 7 or 15
works. For the surround sound track, if you split the surround sound track to mono (6 tracks),
you can send the sequence successfully.

Bug Number: UDevC00168889. The Interplay Transfer Status window in Access does not
show the correct status for a transferred clip. It shows as offline status even though the job
transfers successfully.

Media Indexer Limitations for Interplay v2.6

>

Bug Number: UDevC00171147. The UTest Tabledump report is missing some entries and other
entries are duplicated. The UTest tool is typically used by Avid Customer Support as a diagnostic
tool. The following problems exist for the Interplay v2.6 version of UTest:

* Information about media files in the indexed workspace subfolders is duplicated.

*  The reports don’t include information about files in the root of the indexed local workspace.

Bug Number: UDevC00171148. Media Indexer web user interface: In the Storage Browser
panel, the Quality Description popup does not display details about the Quality ID when you
right-click the entry in the list. Instead it displays “Undefined”.

Bug Number: UDevC00171161. Media indexer Archived Log Files: The What’s New for
Interplay v2.6 guide describes how Media Indexer automatically archives log files to a separate
folder. If there is less than 10 GB free space on the drive that hosts the log files, Media Indexer
reports an error situation and will only retain the current day’s log.

Bug Number: UDevC00169997. Avid editing applications: You cannot delete local media from
a bin after the clip was consolidated to an ISIS workspace in Interplay.

Workaround: The media can be deleted using the Avid editing application Media tool and the
media can be deleted from the bin if you are in disconnected mode.

Bug Number: UDevC00170600. Avid editing applications: Media can become offline in the
Avid editing application when moving media files between different ISIS workspaces (same or
different ISIS) when the path information of source and target file below the workspace folder is
the same. Media will come online again when reopening the project in the editing application
after the move operation.
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»  Bug Number: UDevC00171149. Media Indexer does not report indexed file locations properly
when they contain international characters in their file or folder names and are indexed locally on
a Macintosh system.

»  Bug Number: UDevC00171152. Media Indexer v2.6 ignores files or folders for indexation
when the path name is Longer than 256 Characters on Windows. In earlier releases the Media
Indexer crashed when it encountered a long path name. Now it ignores it

»  Bug Number: UDevC00171162. You cannot use the Media Indexer web user interface to
manage the order of priority for Storage Locations.

Workaround: Use the Avid Service Framework Service Configuration tool for this operation.

»  Bug Number: UDevC00171168. Media Indexer: The Media Indexer logs Java runtime garbage
collector output to a file at the following location:

%Program Files%/Avid/AvidMI/bin/garbage-collector.log

For Interplay v2.6, the file will keep on growing in size as long as the MI process is running.
Upon restart, the file will be set back to zero length (0 bytes) and start growing again. When the
MI process is running for a very long time, this could fill up the local drive.

Workaround: If you restart the Media Indexer at the recommended intervals (once a month) the
file will be automatically deleted. In an emergency situation, do the following:

*  Open the file in a text file editor such as Notepad.

* Delete the content in the text file editor

e Save the file.

Note that moving the file is not possible while the Media Indexer is running.

Limitations for Version 2.5
For 24p proxy limitations, see “Limitations for 24p Proxy Resolutions (Version 2.5)” on page 77.

»  Bug Number: UDevC00145287. After sending a sequence with an ancillary data track to a K2
Media Server, if you bring the sequence back to Interplay via FTP Media Browse, the sequence
no longer contains VANC data in the D-track.

»  Bug Number: UDevC00161432. Using EWC on a Mac editor: After an EWC clip completes
recording you must select it and choose Update from Interplay in order to display the completed
clip icon in the bin. If you do this on a Mac editor, the system may display an "Exception: MXF
DIDMapper" error. If this happens, the clip will not play.
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Workaround: Do one of the following and the clip should appear correctly in the bin:
*  Close and reopen the bin:

*  Close and restart the editing application.

Bug Number: UDevC00149861. If you perform a Send to Workgroup operation and specify
"Other" workgroup option, only the first clip will transfer correctly. The remainder of the clips
will return an error stating that the TM doesn't have information for the specified device.

Workaround: Send one clip at a time using the "Other" option or define a specific device for
workgroup Transfers and specify that device.

Bug Number: UDevC00161485. Interplay Access on Mac OS 10.7 does not have an uninstaller.

Workaround: Do the following to remove the Access application:

* Delete the entire Interplay Access folder from the following location:
Applications\Avid\Avid Interplay Access

* Delete the Access shortcut from the Dock.

Bug Number: UDevC00149984. If you link to the low res proxy during an EWC and use the
JKL keys to move across the edge of the recording, the system may become stuck on the Capture
in Progress slide. If this happens you cannot recover until you reload the clip.

Workaround: Do one the following:

» Ifthe recording is still in progress, link to the high res media and then switch back to low res.
Or toggle the video monitor on and off.

» Ifthe recording has completed you may receive Assertion Failed or Decomp errors when
you attempt to use Update from Interplay. In this case, restart the editing application.

Bug Number: UDevC00164931. Windows 7: Can't locate Media Indexer on Avid editor after
first install. After an initial installation of the editor and Interplay support software, the editing
application may fail to locate the Media Indexer. This can happen if some of the Avid Service

Framework services have not started correctly.

Workaround: Open the Workgroup Properties tool on the editor and check whether any of the
services are not running. Restart any services as required. Then restart the Avid editing
application again. You may have to do this the first few times that you start the editor. After a few
times the services will begin starting automatically, even after a reboot.
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Bug Number: UDevC00149917. EWC and IPV material: Using JKL keys or playing backwards
in an EWC clip can result in DecompStream errors. This happens with material being captured
using the IPV Low Res Encoder. When the error occurs, that portion of the clip will continue to
generate Decomp errors if you try and work with it. Once the EWC completes and you perform
an Update from Interplay, the clip should appear correctly in the bin and play with no problem.

Bug Number: UDevC00164639. Partial Restore and Partial Delivery do not support DNxHD
444 resolutions. A partial restore or partial delivery restores the entire clip.

Bug Number: UDevC00157027. In some cases, an online audio clip is displayed as partially
online (blue dot). This might occur with audio clips that were imported into an editing system
from a CD. If you play the clip and check it in to the Interplay database, it is displayed as fully
online (green dot). After you select “Update Status from Media Indexer” the clip appears
partially online. The audio plays correctly in either case.

Bug Number: UDevC00163282. Interplay Assist cannot play sequences created in an Avid
editing system that contain surround sound clips if the Audio Monitoring Mix Mode is set to
Direct Out.

Workaround: Set the Audio Monitoring Mix Mode to Mono or Stereo.

Interplay Assist can play surround sound clips as Direct Out, and can create and play shotlists
that contain surround sound clips.

Limitations for 24p Proxy Resolutions (Version 2.5)

>

Bug Number: UDevC00163299. Clips and sequences that use 720p/23.976p proxy media
cannot be streamed in the Interplay Access monitor. These clips and sequences can be played in
Avid editing systems.

Bug Number: UDevC00163297. Proxy media created from clips imported into a 720p/23.976
project on an Avid editing system (such as an .mov file) is not fully streamable in Interplay
Access.

Workaround: Import the file into a 1080p/23.976 project, transcode the clip to 720p/23.976
HD, and then transcode it to 720p/23.976 proxy.

Bug Number: UDevC00165576. 10801 /59.94 clips that you transcode to 720p/23.976 on an
Avid editing system do not support multirez or dynamic relink. Media Services Transcode fails
to transcode the 720p/23.976 media to a different resolution. In an Avid editing system, you can
transcode to a different resolution but you can only link to the newly created resolution.
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Workaround: Use a Media Services Transcode CROSSRATE profile to transcode the
1080i/59.94 clips to 720p/23.976.

Bug Number: UDevC00165842. AMA clips that you transcode in a 720p/23.976 project on an
Avid editing system cannot link to partially restored media. For example, in a 720p/23.976
project, transcode a P2 or XDCAM clip to DNxHD 60, use Interplay Transcode to transcode to
H.264, archive the DNxHD media, delete the DNxHD media, and dynamically relink to the
H.264 media. If you then create a sequence using the clip and do a partial restore of the DNxHD
media, the sequence does not dynamically relink to the restored DNxHD media.

Workaround: Do a full restore of the clips.

Bug Number: UDevC00165784. You receive errors if you try to render a sequence converted
from 720p/23.976 to 10801/59.94. For example, in a 720p project on an Avid editing system,
create a sequence from AMA clips converted from 10801, change the format of the sequence to
10801/59.94, and open the sequence in a 10801/59.94 project. If you then try to render the
sequence, the render fails and displays an assertion failure message.

Limitations for Version 2.4

>

Bug Number: UDevC00161315. Ancillary data monitoring in the timeline is not supported
while editing with Edit While Capture (EWC) clips. To disable Ancillary data monitoring,
deselect the D track monitor icon in the timeline. Note that the data track will work correctly
once the EWC clip is completed and updated from Interplay.

Bug Number: UDevC00158050. (Interplay Engine on Windows Server 2008 R2 systems)
When you use the Manage Databases view in the Interplay Administrator to activate a
deactivated database, you cannot browse for the .pro file. If you click the Browse button, the
Open dialog is not displayed. An error message with the headline “0xC00000BB” is displayed at
the bottom of the view.

Workaround: Type the full UNC path. For more information and an example, see “Activating
the Database” on page 32.

Bug Number: UDevC00157069. (Streaming Server, Macintosh) For Mac OS X 10.5, streaming
playback is supported only on Macintosh Intel Core 2 Duo systems that are capable of running
Java 1.6.

Bug Number: UDevC00158418. If you are using Interplay Access v2.4 to browse the database
of an Interplay v2.4 workgroup that uses an Interplay v2.3 Stream Server, a stream-while-capture
clip might stop and display “Not enough media. Capture in Progress.” The clip loads again, but
does not play until you click the Play button (or use a keyboard command). You might have to
click the Play button more than once.
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Bug Number: UDevC00158403. If you are using Interplay Access v2.4 to browse the database
of an Interplay v2.4 workgroup that uses an Interplay v2.3 Stream Server, all MPEG-4/H.263,
H.264, and MPEG1 Level 2 clips display a green icon to indicate that they are playable.
However, if you try to play a clip that is not published as a QuickTime reference movie, the
following message is displayed: “Streaming server or share is not registered.” Publishing the clip
lets you to play the clip correctly.

Bug Number: (no number). Do not install the STP Encode service provider and the Interplay
Transcode service provider on the same server. These providers cannot run on the same server.

Bug Number: UDevC00155898. Media Indexer: If you remove a workspace from the primary
MI, the workspace may not be immediately removed from the secondary MI. This can happen if
you delete a workspace from the primary MI while the secondary MI is busy indexing newly
added workspaces or is performing a startup index.

Bug Number: UDevC00149804. Media Indexer: The number of Unique Media Files and
Duplicated Files shown in the Health Monitor may vary between different MIs in the same HAG.
This is due to an error in the way the duplicated media files are counted. Usually the sum of
Unique Media Files and Duplicated Files together on each system match correctly. However, this
is not always guaranteed, especially if there are file system changes combined with moving and
deleting files and/or folders.

Bug Number: UDevC00155897. Media Indexer: An MI might sometimes show a negative
heartbeat time value in the Health Monitor, especially when the system did not yet issue a
heartbeat operation. The Heartbeat is a new feature for Interplay v2.4. See What’s New for
Interplay v2.4 or the Interplay Help for information on the Heartbeat value.

Bug Number: UDevC00156697. Media Indexer: The "Duplicate assets count" value in the
Media indexer log files can sometimes show a negative value for the per workspace file count.

Bug Number: UDevC00156698. Media Indexer: During an upgrade or uninstall of Media
Indexer, the Event log may show the following error: "StartServiceCtrlDispatcher failed".

Bug Number: UDevC00153537. (Avid editing systems, Macintosh) If you drag an asset from a
bin into a folder in the folder tree (the left pane of the Interplay Window), the following error is
displayed: "Error moving asset: An internal client error has occurred.

java.lang.illegal ArgumentException:invalid object moniker." The error message appears
because you cannot drag an asset into a folder in the folder tree. You can click OK in the error
dialog and correctly drag an asset to a folder in the right pane of the Interplay Window.
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»  Bug Number: UDevC00157373. (Avid editing systems) Sequences with rendered video
transition effects might become unrendered when selecting "Update from Interplay." The
following actions will cause this problem:

1. User on system 1 creates a sequence with rendered video transition effects and checks it into
Interplay.

2. User on system 2 checks out the sequence, adds an additional rendered video transition
effect, and checks it into Interplay.

3. User on system 1 opens the sequence in the Timeline, right-clicks the sequence in a bin, then
selects Update from Interplay.

The first rendered effect in the sequence becomes unrendered. In complex sequences, this
unrendered effect could cause other rendered effects to become unrendered.

Workaround: On system 1, close the bin that holds the sequence, open a new bin, and check out
the sequence from the Interplay window. This version of the sequence should have all effects
correctly rendered.

»  Bug Number: UDevC00151575. (Avid editing systems). If a user of an Avid editing application
transcodes a clip, deletes the transcoded media, transcodes again to the same resolution, and
again deletes the media, the editing application reports the following error: "Error deleting
shared media (path to .mxf file). Unable to delete database node (0x89901a5)." However, the
media is correctly deleted.

»  Bug Number: UDevC00147601. (Avid editing systems) If you send an XDCAM sequence to an
AirSpeed Multi Stream server, the audio might be noticeably hotter on the AirSpeed Multi
Stream server. This problem could affect sequences sent from Media Composer v5.0, Symphony
v5.0, and NewsCutter v9.0 and later, because the default setting for mono tracks changed from
Alternating L/R to All Tracks Centered.

Workaround: In the Audio settings, set the default pan as Alternating L/R.

»  Bug Number: UDevC00158375. (Avid editing systems) If you create a sequence that includes
clips with mixed audio bit rates, you cannot use STP Encode to send the sequence to a LongGOP
playback device. For example, a sequence includes clips with 16-bit audio and 24-bit audio. If
you select Send to Playback, and then select STP Encode, the following error is displayed:
"Sequence contains clips with mixed audio bit depth. Send to Playback will not continue."
Workaround: Do one of the following:

* Select Send to Playback but do not select STP Encode.

»  Transcode the sequence to one audio rate, select Send to Playback, and select STP Encode.
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»  Bug Number: UDevC00154920. (Avid Instinct) If you use a USB headset microphone to record
a voice-over on a Windows XP system, the recording is garbled. This is not a problem on Vista
or Windows 7 systems.

Workaround: Use a microphone that connects through the computer's microphone connector.

»  Bug Number: UDevC00142814. DNxHD clips that are ingested from an Omneon server during
an edit-while-capture ingest from Omneon do not display a separate Data (D) track in Avid
editing applications or in an Interplay environment. To display the D track, you must use the
Extract DNxHD Data command in the Avid editing application.

ProEncode Limitations

»  Bug Number: UDevC00148253. If you are using a fiber-attached editor in a MediaNetwork
environment, you cannot send to ProEncode. The job fails with the following error message:
“Prefilter failed:Error [5]:Input file error detected (unable to extract audio track).”

Telestream Support

»  Bug Number: UDevC00154077. ProEncode v2.5 and Telestream FlipFactory v7.2 are
supported on AS3000 systems. However, to avoid port conflicts, do the following:

1. Do not install Avid Service Framework on the ProEncode provider unless necessary. If it is
installed, open the Avid Workgroup Properties application, click the Services tab, click
Advanced, and disable the Avid Service Framework services.

2. In the Services section of the Windows Computer Management window, disable the ATTO
ConfigTool Service if it is present and started. Then restart the Flip Engine so that it obtains
the correct port.

3. Start the ProEncode provider.

4. If you want to use Avid Service Framework services, use the Avid Workgroup Properties
application to enable the services.

»  Bug Number: UDevC00155890. Telestream FlipFactory v7.2 supports Interplay Transfer DHM
features for Interplay Transfer v2.1 and Interplay Transfer v2.2. If you use the Telestream
FlipFactory Playback service, you need to use one of the following:

*  Telestream Playback Service v2.1 along with Interplay Transfer v2.1
*  Telestream Playback Service v2.2 along with Interplay Transfer v2.2

FlipFactory users can download the software from the Telestream site www.telestream.net.

Contact Telestream for additional information.
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Anystream Support

>

>

Bug Number: UDevC00091058. ProEncode does not properly encode master clips with
Anystream Agility v5.8.1 software. ProEncode installs the current version of the Avid codec
AvidAVdnCodec.qtx, however, Anystream Agility requires a previous version.

Workaround: Contact your technical representative at Anystream and obtain the appropriate
versions of codecs to operate with your version of Anystream. Follow their instructions for
proper installation and configuration.

Bug Number: UDevC00155915. ProEncode with Anystream Agility v1.5.1 is not supported.

Limitations for Version 2.3

>

Bug Number: no number. In an ISIS environment, Media Indexer v2.3 servers require the ISIS
v2.3 or greater client.

Bug Number: UDevC00149782. (Avid editing applications) On an 8400 dual-quad system,
playback of H.264 proxies is very choppy when you view them in a different format project. The
following are examples:

*  Transcode an HD master clip (10801 59.94 DNxHD) to create SD proxy media (H.264
800Kbs Proxy 525) and load the clip into a 1080i 59.94 HD project.

* Ingest HD proxy media (H.264 800Kbs Proxy 1080i 29.97) from an AirSpeed Multi Stream
system and load the clip into an NTSC 30i project.

Then, with the Quality Menu set to Full Quality (green), play the clip. The playback is choppy
and sometimes is not responsive to user control. If you let the choppy playback continue, you
eventually see the following error: Exception: StreamingPlayConsumer::ExecutePass
TIMEOUT....

(The same problem results on a faster system (such as a Z800) with the Quality Menu set to Full
Quality 10-bit).

Workaround: For Media Composer and Symphony, set the Quality Menu to Draft Quality
(green/yellow) or Best Performance (yellow/yellow). For Symphony Classic, change the project
format.

Bug Number: UDevC00132305. (Avid editing systems) In a workflow that includes MultiRez
and Dynamic Relink, if you consolidate a clip that is associated with more than one resolution,
and check in the clip, Interplay Access is aware of only the resolution that was linked to the
consolidated clip when you checked it in. This limitation can prevent you from publishing the
clip for streaming. For example, if you transcode a high-res clip to MPEG-4 low-res media while
the working resolution is set to the high-res media, and check in the clip, Interplay Access
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displays only the high-res media. If you run a Stream Publish job on the clip, Stream Publish
fails with the error message "Internal Error: no valid media tracks are found or proxy media files
are offline."

Workaround: In the editor, dynamically relink the clip to each resolution and then check in the
clip while it is linked to that resolution.

Bug Number: UDevC00147992. On a Mac OS X system, if you open the Avid Service
Configuration application from Interplay Access or the Interplay Administrator, the Hosts tree
might not show any entries.

Workaround: Do not select the option “Automatically Join the Preferred Workgroup.” You can
clear this option in the Login tab of the Avid Workgroup Properties.

Bug Number: UDevC00149466. (Interplay Access, Interplay Window) Subclips of audio-only
master clips do not show a headframe and use the subclip icon, instead of a smaller version of the
audio-only master clip icon.

Bug Number: UDevC00142955. (Avid editing systems) Locators on data-only mixdowns
checked out to an editing system do not appear on the Timecode track. For example, if you create
a mixdown of a track that contains only ancillary data, add a locator, check it into Interplay, then
check it out again, the locator does not appear on the D track, but instead appears on the
Timecode track.

Bug Number: UDevC00144301. On Mac OS X systems, there is no uninstaller for the Interplay
Transfer client.

Workaround: Delete the following file:
/Library/Application Support/Avid/xfermgrapi.bundle

Then reboot your system.

Bug Number: UDevC00099531. (Interplay Assist) If you want to send a source clip or
sequence to playback, the STP operation uses the target resolutions of the loaded shotlist or, if
there is no loaded shotlist, the target resolutions set on the database root folder. If the target
resolutions displayed are not the target resolutions you want to use, you must create or open a
shotlist in a folder that is set with the desired target resolutions.

Bug Number: UDevC00151810. (Interplay Access) If you right-click on a clip while it is being
ingested, you cannot open the clip in Interplay Assist (the command Open in Assist is not
displayed). Workaround: Open the clip in an Avid editing application, or wait until the clip stops
ingesting, then open the clip in Interplay Assist.
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AVC-Intra Limitations

>

Bug Number: . Interplay v2.x supports capture, import, playback, transcode, and consolidation
of AVC-Intra resolutions. The following limitations apply:

e UDevC00116685 You cannot export a QuickTime movie using the Same as Source option
with AVC-Intra material

*  ProEncode does not work with AVC-Intra material for this release. This is related to the
QuickTime problem because ProEncode creates a QuickTime Reference movie as part of its
process.

Bug Number: . Performance will vary with AVC-Intra media played on HP Z400 Single Quad
Core systems, due to the processing power of the systems.

Bug Number: . (Playback of AVC-Intra is not supported with HP xw8400 or HP xw4600.
Newer hardware does support playback.

Bug Number: UDevC001137818. ((Interplay Assist, Avid Instinct, Avid editing systems)
AVC-Intra media will not play or will stutter when playing on systems less capable than an HP
xw8600.

Assist and Instinct Hardware Support

For a list of qualified workstations and video cards, see the Avid Knowledge Base at
http://www.avid.com/onlinesupport and search for “Qualified PC Workstations Assist.”

Ancillary Data Limitations

The following limitations pertain to using Ancillary Data with Interplay v2.2.

Bug Number: UDevC00161432. Ancillary data monitoring in the timeline is not supported
while editing with Edit While Capture (EWC) clips. To disable Ancillary data monitoring,
deselect the D track monitor icon in the timeline. Note that the data track will work correctly
once the EWC clip is completed and updated from Interplay.

Bug Number: UDev00145071. Ancillary Data: Problems working with Edit While Capture
feature during ingest of 10801 60 XDCAM HD that contain ancillary data. The following error is
generated:

AncDataPacketCvtr::ExecuteRequest - ANC Essence Data Key not found at expected sample
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Workaround: Allow the ingest to complete. Then right-click the clip in the editing application
and select Update from Interplay. Now the clip should have a complete icon and it should be
ready to work with.

Bug Number: UDevC00140395. (Interplay Access) Limitation: Resync will not recreate the
D-track if the metadata is lost or overwritten. If an editor uses the Extract DNxHD Data feature
with a clip or sequence, and checks the clip or sequence into Interplay, the D track is preserved in
the local bin. If the clip or sequence is deleted in the local bin, or the metadata in the database is
lost through a failure, Resync will not recreate the D track.

Workaround: Extract the D track again in the editing application.

Omneon, K2 and Ancillary Data

>

Bug Number: UDevC00142013. D Track gets stripped off 720p60 XDCAM editor sequences
sent to Omneon via TM.

ISIS Client Bandwidth for Copy Provider

>

Bug Number: no number. Copy Provider: Intermittent read timeout errors on Copy Provider
jobs.

Workaround: To prevent read timeout errors on a Copy Provider, set the ISIS bandwidth on
each Copy Provider to 250 MB per second. You can set the value in the Devices list in the Avid
ISIS management Console..

Recording Across Midnight

>

Bug Number: UDevC00133312. Ingest recordings that begin at midnight report media offline
errors in Access and editing applications.

Workaround: Begin recordings one or more minutes before or after midnight. It is preferable to
begin the recording after midnight because you can have problems if you consolidate a sequence
that contains clips recorded over the midnight boundary. If the portion of the clip you are using
was recorded after midnight but the beginning of the clip is before midnight, Dynamic Relink
may determine that the clip is offline.

Bug Number: no number. Partial restore of media recorded across midnight can cause media

offline errors in Access and editing applications. This can happen if you attempt to restore a
portion that was recorded after midnight.
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Workaround: If you have a clip that was recorded across midnight and you want a partial
restore of a portion that occurred after midnight, you must specify a beginning timecode that
starts before midnight.

Limitations for Interplay v2.2.1

>

Bug Number: UDevC00143638. To use Interplay Transfer from an Avid editing system, you
need to configure settings in Transfer Settings dialog box. In the TMClient.ini tab, make sure
you use the correct case when you enter the server name and workgroup name. Server names are
typically lower case. Workgroup names can use a mix of upper case and lower case. The name
you enter must match the name entered in the Avid Service Framework.

Bug Number: UDevC00145564. Avid Editing Applications on Macintosh: If you uninstall both
Interplay components from a Mac OS X system, you still receive a message when starting the
Avid editing application that asks if you want to run in disconnected mode.

Workaround: Delete the following file:

/Library/Preferences/avid.workgroups.avid technology incorporated.plist

Bug Number: UDev00144835. SGL Archive to Disk: Partial restore of a sequence from disk
may fail. The job fails with a third party software error. The problem is related to the position of
the clip in the sequence. If you encounter the problem for a particular clip in a sequence you will
not be able to partially restore that clip from the sequence.

Workaround: To restore that particular clip, restore the entire sequence.

Bug Number: UDevC00133312. Ingest recordings that begin at midnight report media offline
errors in Access and editing applications.

Workaround: Begin recordings one or more minutes before or after midnight. It is preferable to
begin the recording after midnight because you can have problems if you consolidate a sequence
that contains clips recorded over the midnight boundary. If the portion of the clip you are using
was recorded after midnight but the beginning of the clip is before midnight, Dynamic Relink
may determine that the clip is offline.

Bug Number: UDevC00144241. Macintosh Editor Bins limitation: Opening a bin that displays
video resolution dots column can cause a Macintosh editor application to crash.

Workaround: Do not display columns for video resolution dots in a Macintosh editor bin. Note
that you can view video columns in Access.
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»  Bug Number: UDevC00145562. Send to Playback to XDCAM SD devices may fail with write
permission errors when using profile names.

Workaround: Change the FTP and Playback configurations in Interplay Transfer to be the
actual hostname of the device. A device can be given a "hostname" by adding its IP address and
name to the Window's hosts file residing on the Transfer Manager server.

»  Bug Number: UDevC00145468. Occasionally a 32-bit Media Indexer server may fail to launch
and may fail during use. The system displays a "Faulting application AvidMI.exe" error
message. This is usually related to an incorrect version of Avid Service Frame work or to a
problem with the Media Indexer cache files
Workaround: Do the following:

*  Check the version of Avid Service Framework on the Media Indexer (should be v1.3.8.1

e Ifthe framework version is correct, delete the Media Indexer cache files and restart the
Media Indexer. Note that this will cause the Media Indexer to rescan all of its storage
locations. This can take a long time if the Media Indexer is monitoring a large number of of
work spaces.

Limitations for Interplay v2.2

RED Camera Support

Currently, workflows that use media captured from RED cameras are not supported in an
Interplay environment.

MediaStream Server Support

The Avid MediaStream Server (also known as Media Stream server) is not supported for
Interplay Transfer v2.2 and higher. If your workflow requires a MediaStream server, use
Interplay Transfer v2.1 in your Interplay v2.2 environment.

Because the MediaStream server is no longer supported, the “Long GOP transfer enabled” check
box has been removed from the Interplay Transfer Configuration window for Interplay v2.3.
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Check in to Interplay for Pro Tools

The following limitations apply to the Check in to Interplay for Pro Tools command that is
available in the Avid editing application:

e Pro Tools v9.0 adds support for multi-channel audio tracks created in the Avid editing
application. If you are using an older version of Pro Tools, use the Split to Mono command
in the editor command to break the multi-channel audio files into mono files.

*  Pro Tools v9.0 supports RTAS effects created by Avid editing applications. Older versions of
Pro Tools ignore RTAS effects created by the Avid editing applications.

* Ifyou are working with Multicam or group clips, before you perform the Check in to
Interplay for Pro Tools command, right-click the sequence in the bin and select “Commit
Multicam Edits”. If you don’t use the Commit command, Pro Tools will accept the sequence
but when the Pro Tools editor attempts to check the sequence back into Interplay, the check
in will fail.

Copy Provider and ISIS Versions

You can use the Media Services Copy Provider to copy to an equal or higher version of ISIS, but
you cannot copy to a lower version of ISIS. For example, you can copy from an Interplay
environment running ISIS v1.6 to an environment running ISIS v2.1 but you cannot copy from
the ISIS v2.1 system to ISIS v1.6.

Multi-Channel Audio Tracks
Send to Playback

This section describes a best practice for sending a sequence containing multi-channel audio
tracks to playback when using Direct Out mode.

When using Direct Out mode, keep the multi-channel audio tracks at the bottom of your audio
tracks. When you send to playback in Direct Out mode the system expands the stereo tracks to
separate mono tracks. If there are single tracks at the bottom of the track list you may get
unexpected results after the top tracks expand. For example, a single track that was on track 5
may now be on a different track. If you keep the single tracks at the top you can avoid this kind
of problem. See the editing application What’s New documentation or Help for additional
information on multi-channel audio.

Assist and Instinct

»  Bug Number: UDevC00142943. (Interplay Assist and Avid Instinct) Multichannel audio tracks
from Avid editing systems are not supported by Interplay Assist or Avid Instinct. Workaround:
Avid editors should use the “Split to Mono” command before checking in sequences that will be
used in workflows with Interplay Assist or Avid Instinct.
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Check in to Pro Tools for Interplay
See “Check in to Interplay for Pro Tools” on page 88.

Final Cut Pro

»  Bug Number: UDevC00142462. Multichannel audio tracks from Avid editing systems are not
supported by Final Cut Pro. Final Cut Pro fails to import the audio tracks (through Automatic
Duck) and displays the error message “Unknown Audio Container Effect.”” Workaround: Avid
editors should use the “Split to Mono” command before checking in sequences that will be used
in workflows with Pro Tools or Final Cut Pro.

Media Indexer Limitations

This section describes limitations for Avid Interplay Media Indexer. For information on
installing and configuring Media Indexer on a Macintosh system, see the “Installing Software on
Interplay Clients” chapter of the Avid Interplay Software Installation and Configuration Guide or
the Interplay Help.

Uninstall Program for Media Indexer on Mac OS

Bug Number: UDevC00142377. The uninstaller for Media Indexer on Macintosh systems does
not use a graphical user interface. Also, the administrator account that you use to uninstall the
program must use a password.

To uninstall Media Indexer:

1. Navigate to Applications > Avid Uninstallers > Avid Media Indexer and double-click
AvidMedialndexerUninstaller.

A terminal window opens and asks for a password.
2. Enter a password for an administrator account and press Return. Media Indexer is

uninstalled.

If you close the terminal window without uninstalling the program, you can no longer use the
terminal window. Workaround: Restart the Macintosh system.

Stopping and Starting Media Indexer on a MacOS X System

To stop Media Indexer:
1. Open a Terminal window (select Applications > Utilities > Terminal).
2. At the prompt, type the following and press Return:
cd /Applications/Avid\ Media\ Indexer/bin
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3. Type the following and press Return:
sudo ./mi.sh remove
Media Indexer is stopped. To restart it, type the following and press Return:

sudo ./mi.sh install

General v2.2 Limitations

m

The following problems are present in the Interplay v2.2 release.

Bug Number: UDevC00142389. (Access, Macintosh) The Tools menu does not show the
correct keyboard shortcuts for the following commands. The correct keyboard shortcuts are
shown:

*  Check In AAF Sequence (Command+Option+I)
*  Export QuickTime Reference (Command-+Option+G)

* Import as QuickTime Reference (Command+Option+M)

The keyboard shortcuts are correct in the context (right-click) menu.

Bug Number: UDecC00143346. In the Property Layout View of the Interplay Administrator,
the following resolutions might be listed in the Resolutions tab:

* AVCIBP-BLL2.0 60
* AVCIBP-BLL2.0 50

Do not select these resolutions as available. They are reserved for future use and can cause
problems if selected as a working resolution for Interplay Assist. For AVCI proxy use, select the
following resolutions:

* AVCIBP-BLL3.0 60
* AVCIBP-BLL3.0 50

Bug Number: UDevC00143402. During installation of the Interplay Stream Server, the
installation instructions state that you must enter the user name in the form domain\username.
However, if you are using a local user, enter the username only.

The user name and password for the Stream Server Execution User must exactly match the user
name and password of the Server Execution User that is used to run the Interplay Engine.

Bug Number: UDevC00141484. If you want to create a Media Services profile for
dual-mixdown operations, make sure to select DUALMIXDOWN as the transcode mode. If you
select MIXDOWN as the mode, the dialog box allows you to enter targets for a dual mixdown,
but the profile will use only the first target.
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»  Bug Number: UDevC00143049. Assist incorrectly allows stories with offline D Tracks to be
sent to playback.

»  Bug Number: UDevC00142844. Interplay Access: You cannot add a drop-frame clip to a
non-drop-frame shotlist in Interplay Access (or vice versa).

»  Bug Number: UDevC00137852. Telestream FlipFactory TM Plugin fails to notify Interplay TM
2.2 and process a checkin to Interplay.

»  Bug Number: UDevC00142061. (Interplay Access) If you are working with consolidated
subclips or consolidated sequences, Access might show that the media files are online, but you
cannot delete the media because it is not displayed in the Delete dialog box. For more
information, search the Avid Interplay Access User’s Guide or the Interplay Help for
“Limitation: Media Files Displayed as Online but Not Available for Deletion.”

»  Bug Number: UDevC00142535. (Interplay Access) If you select a subfolder of the Deleted
Items folder, the Filters button remains enabled. You should not be able to change the filter
because a Deleted Items subfolder contains only file assets.

Transcode
»  Bug Number: UDevC00143164. Minimizing remote window during Transcode service launch

results in DSM_SERVER errors.

Workaround: If you use the Windows remote desktop feature to launch the Media Services
Transcode service, make sure the Transcode service is completely launched before minimizing
the window.

Omneon and K2 Media Servers

>

Bug Number: UDevC00142012. AVC-Intra resolutions are not supported for send to playback
with Generic FTP profile.

Bug Number: UDevC00126493. Failed K2 transfers leave behind a temp file that must be
manually deleted. Temporary OP1-A exported MXF files are not deleted from the shared storage
workspace if the transfer fails after the export. These files can accumulate and take up disk space
on shared storage.

Workaround: To delete the files, navigate to the Temp directory within the workspace that is
used to place temporary files. Select the files and delete them. For example, \\ <sharedstorage
server name>\<workspace name>\Temp
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Archive/Restore

»  Bug Number: UDevC00141961. If you enable the "no spanning" option in SGL FlashNet for a
group, jobs will hang in the Archive Provider during the "Backup Cache Fill: phase of the
archive. You can cancel the job but if you run it again it will fail again.

Workaround: Disable the FlashNet "no spanning" option.
Windows 7
»  Bug Number: UDevC00140504. Windows 7: Standalone Interplay Transfer cannot perform an

FTP ingest if the Firewall is turned on.

Workaround: If you have Windows Firewall turned on with Windows 7, you need to allow
Interplay Transfer through the firewall. When you start Interplay Transfer, you should get a
dialog like the one shown in the following illustration. Make sure to check off allowing Interplay
Transfer through the firewall on private networks, such as "home or work", and that will add an
exception for Interplay Transfer through the Firewall. This will allow Interplay Transfer to
operate normally with Windows Firewall turned on.

¥ Windows Security Alert

@ Windows Firewall has blocked some features of this program

Windows Firewall has blocked some features of Avid Interplay Transfer Engine on all public and
private networks,

. Ij Mame: Avid Interplay Transfer Engine
Publisher: &vid Technology, Inc.
Path: C:'\program files (x86)\avid\avid interplay transfer engine

wfermgrserver.exe
Allow Avid Interplay Transfer Engine to communicate on these networks:
[| Private networks, such as my home or work network

[] Public netwarks, such as those in airports and coffee shops (not recommended
because these networks often have lithe or no security)

What are the risks of allowing a program through a firewall?

[ @:lg.lluwaccess I I Cancel
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Macintosh Editors

>

Bug Number: UDevC00144800. You cannot perform Send to Playback to an AirSpeed Studio
on a Mac editor. If you add an AirSpeed Studio to the Mac editor’s transfer settings, the Studio
does not appear in the Send to Playback dropdown menu.

Bug Number: UDevC00132571. Macintosh editors on Interplay: If you open Workgroup
Properties on a Macintosh system, the Services tab does not include options to view the status of
the Avid services running on the local computer, or to start, stop, restart, enable, or disable local
services. Currently, the only service running on the Macintosh client is Media Indexer.

Workaround: In Workgroup Properties, click the Lookup tab. Click edit, then click Apply. The
service is stopped and restarted.

Bug Number: UDevC00142838. Mac editors and MPEG4 media: Mac editors cannot use
Dynamic Relink to link to MPEG4 media capture from a dual ingest. The system displays an
Assertion error. You can continue through the error dialog but the MPEG4 media does not link.

Limitations for Interplay v2.1

>

Bug Number: UDevC00135952. An Avid editing application running on a Macintosh system
unexpectedly quits if you disconnect the Avid Unity ISIS user. For example, if Media Composer
is running, and you want to change the logged in user, open the ISIS Client Manager, and, under
Username and Password, click the Disconnect button. A Media Composer error message is
displayed ("Bus Error" in thread "Main Thread"...). After you click OK, the application quits.

Workaround: Save your work and close the editing application before disconnecting the
current Avid Unity ISIS user.

Bug Number: UDevC00135035. Under some circumstances, if you try to delete transcoded
media in an Avid editing application, an error message is displayed ("Unable to delete database
node") and the media is not deleted. This could occur if you transcode a clip, check it into
Interplay, delete the transcoded media, transcode the clip again to the same resolution, and try to
delete it.

Workaround: Delete media for the transcoded resolution in Interplay Access.

Bug Number: UDevC00133649. When using FlipFactory v7.0, if you create a TMIngest
factory using the DNxHD codec, and submit a file to Interplay Transfer, when using Interplay
Access an incorrect frame rate is displayed.

Workaround: Use FlipFactory v6.1 to create a TMIngest factory using the DNxHD codec.
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Bug Number: UDevC00135065. Airspeed Multi Stream Studio -HD configurations: When
configuring an AirSpeed Multi Stream Studio -HD target for Instinct or Assist users, if the
Interplay Transfer Settings view does not contain a Transfer Engine, then Instinct and Assist
users will not see the studio-HD target in the Send to Playback menu.

Workaround: When setting up AirSpeed Multi Stream studio for -HD targets for Assist and
instinct users, always include a Transfer Engine in the Interplay Transfer Settings. Then restart
Instinct and Assist.

Bug Number: UDevC00135075. You must disable real-time scanning on Restore and Copy
providers or jobs will fail. When anti-virus software has real-time scanning enabled, Restore and
Restore jobs fail with "net.nxn.JXDK.CommandFailedException" errors.

Workaround: Disable real-time anti-virus scanning on Restore and Copy provider systems.

Bug Number: UDevC00135121. SGL Archive job errors: If a job fails in the FlashNet
application without an error, the FlashNet software does not log the error and does not return the
error to the Archive Provider. In this case the Archive Provider reports that there was a 3rd party
error and recommends that you check the 3rd party log. If you do check the log there is no record
of the problem. This problem occurs most often with large sequences.

Workaround: Try disabling the High Speed Support setting in the FlashNet application and
resend the job.

Bug Number: UDevC00131721, UDevC00134328. (Avid Low-Res Encoder and Interplay
Access) If your workflow includes publishing reference movies for streaming play, do not use
the Scene Change option in the Avid Low-Res Encoder. For example, do not create a shotlist
using subclips generated through this option. Reloading the shotlist could fail with an error.

Bug Number: no number. The Avid Interplay Engine and Avid Interplay Archive Engine
Administration Guide includes a topic "Using the InterplayRestore Tool to Restore Backups
Remotely." Beginning with the Interplay Engine version 2.1, you can no longer run the
InterplayRestore tool from another machine. You must run it on the engine on which you want to
restore a backup.

Bug Number: UDevC00134005. (Interplay Access) If you partially publish a master clip, you
might need to reload the clip two or more times before it will play. For example, if you create a
subclip from a clip, transcode the subclip to MPEG-4, and then publish the clip, the first time
you load the published clip, it will not play and will time out with an error message. If you load
it again, the published portion will not be correctly marked, and again the clip will not play. If
you load it a third time, the published portion is correctly marked, and the published portion
plays correctly.
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Bug Number: UDev00127524. (Interplay Access) Files of the following formats do not play
correctly in the Interplay Access monitor:- m3u, - asf, -avi, - wmv .

Bug Number: UDevC00132703. In Interplay Engine v1.6.x and Interplay Engine v2.0.x, if you
created a shortcut in Interplay Access, and then moved the target, the shortcut no longer worked.
This has been fixed for Interplay Engine v2.1.

Bug Number: UDevC00133400. Partial Restore of low res with offset: When you partially
restore a clip with a low res offset, you cannot not restore the offset portion even if you request
the highest available resolution. For example, if you start the low res portion of a dual ingest
capture two seconds before the high res capture begins, you cannot restore the first two seconds
of the low resolution material.

Bug Number: UDevC00106348. Configuring Media Indexers in an ISIS environment with
Mirrored and RAID storage: If you have some workspaces that use mirrored storage and some
that use RAID, put the Mirrored workspaces first in the list when configuring storage locations
for Media Indexer. This will ensure that Media Indexer indexes the storage locations with the
most bandwidth first.

Bug Number: UDevC00133056. Macintosh editors on Interplay: If you are working on a
Macintosh system in an Interplay environment, avoid using non-ASCII characters in file names
or machine names. For more information, see the topic "Characters to Avoid when Naming Avid
Elements" in the Help for your editing application.

Bug Number: UDevC00132571. Macintosh editors on Interplay: If you open Workgroup
Properties on a Macintosh system, the Services tab does not include options to view the status of
the Avid services running on the local computer, or to start, stop, restart, enable, or disable local
services. Currently, the only service running on the Macintosh client is Media Indexer.

Workaround: In Workgroup Properties, click the Lookup tab. Click edit, then click Apply. The
service is stopped and restarted.

Bug Number: no number. Macintosh editors on Interplay: The Workgroup Properties System
Check tab is not available on a Macintosh system.

Changing the Name of the Stream Server Execution User

UDevC00133111 (Interplay Stream Server) You might need to change the name of the Stream
Server Execution User. There are two methods, depending on the exact problem.
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If you added the incorrect user/password combination during installation, you need to uninstall
and reinstall the Interplay Stream Server with the correct user, because in this case the Interplay
Stream Server service is not added to the Windows Services list. For information about
uninstalling and reinstalling the Interplay Stream Server, see the Avid Interplay Software
Installation and Configuration Guide.

If the Stream Server was correctly installed, but the Stream Server Execution User is no longer
available or needs to be changed for any reason, you can change the name and password in the
Log On tab of the Stream Server service:

To change the name of the Stream Server Execution User:

1. Right-click My Computer, select Manage, double-click Services and Applications, then
double-click Services.

2. From the list of services, double-click Avid Interplay Stream Server.
3. Click the Log On tab.
4. Enter the correct user name and password.
- For local users, use the format .\<user>
- For domain users, use the format <domain>\<user>.
5. Click OK.

6. In the Services pane, click “Restart the service”.

Limitations found in Interplay v2.0.1

>

Bug Number: UDevC00127906. If you add locators to a clip in Interplay Access, the locators
are not displayed in an Avid editing application, Interplay Assist, or Avid Instinct until you load
a different clip in the Access Monitor. After loading a different clip in the Access Monitor, load
the original clip again in the Avid editing application, Assist, or Instinct. (Refreshing the clip,
pressing F5, or restarting the application does not display the locators).

Bug Number: UDevC00127773. Dragging the position indicator along the timeline in the
Access Monitor (scrubbing) does not update the monitor for every frame that you scrub through.
The number of frames displayed while scrubbing depends on how fast you drag the position
indicator.

Bug Number: UDevC00130431. If you mix clips with differently labeled audio tracks in a
shotlist in Access, the shotlist might play back the audio tracks on incorrect audio channels. For
example, mixing a clip with V1 A1 with V1 A2 in one shotlist results in a shotlist that plays back
only one audio track. The playback of the shotlist in Avid editing applications is correct.
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Bug Number: UDevC00130484. In some circumstances, Avid editing application users do not
receive an error message if a check-in fails. By design, a user cannot check out a sequence from
a read-only folder, edit it, and then check in the sequence. If the user uses a menu command to
check in the edited sequence, no error message informs the user that the check-in failed. An error
message does appear if you drag the sequence to a folder in the Interplay Window, and then
appears after that anytime the user tries to check in the sequence.

Bug Number: UDevC00131769. In the Interplay Administrator, the Select Workgroup option in
the Service Configuration view does not work correctly. The Service Configuration view always
shows the workgroup that was specified when first opening the view. If you enter information for
a different workgroup in the Select Workgroup dialog box, the selected workgroup is not
accepted. Workaround: Either use the Service Configuration tool in the Framework installation
or restart the Interplay Administrator client and log in to the desired workgroup.

Bug Number: UDevC00125918. When starting Avid Instinct, you might experience a delay of
20 seconds when connecting to Media Indexer. The message “Initializing Quality Manager”
might appear for longer than usual, and in some cases a message “Cannot connect to Media
Indexer” is displayed, followed by “Your connection to Media Indexer has been restored” a few
seconds later.

Bug Number: UdevC00129075. In Interplay Assist, reloading a clip might not refresh the clip.
For example, if an Assist user has a clip loaded, and an Avid editing application user adds
locators to the clip, reloading the clip in Assist might not display the locators. The Assist user
might need to press F5 or refresh the folder containing the sequence.

Bug Number: UDevC00131839. When using Capture Manager and Interplay 2.x, changing the
duration of a clip after it has started to be ingested could cause two different clips to be created
with the same name. For example, you might schedule capture of clips using a template name
(Capture.n, such as Capture.10, Capture.11, Capture.12). If you change the duration of
Capture.11 while it is ingesting, the completed clip is displayed in Interplay Access as
Capture.12 (even though Capture Manager displays the name as Capture.11). The next clip is
ingested and stored as Capture.12, which results in two different clips with the same name.

Bug Number: UDevC00128659. You cannot use the Update from Media Indexer command to
update the media status for a remote workgroup. You receive an error message that the user is
not connected to the Lookup service for that workgroup.

Workaround: Install the Avid Framework Service on the Interplay Access client. Open the
Avid Framework Service Workgroup Properties and configure the remote workgroup's lookup
service in the Workgroup Properties > Lookup tab.
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»  Bug Number: UDevC00132006. An Avid editing application earlier than Media Composer 4.0,
earlier than Symphony 4.0, or earlier than Avid Newscutter 8.0 might display duplicate
restrictions in the following circumstances:

1. Set a restriction on a clip with Interplay Assist (any version).

2. Check out the clip with Media Composer version 4.0.x (or Symphony 4.0.x or NewsCutter
8.0.x) and check it in.

3. Check out the clip with Media Composer earlier than version 4.0.x (or earlier than
Symphony 4.0.x or NewsCutter 8.0.x).

The Media Composer Restrictions tool displays two instances of the restriction.

If you check the clip in again, the restriction is duplicated in the database and duplicate
restrictions appear in any editing application that checks out the clip.

Limitations Found in Interplay v2.0

»  Bug Number: UDevC00128577. Partial Restore and Partial Delivery will not work with media
created by the following versions of the Avid editing applications:

e Media Composer v2.6.x and earlier
+  Symphony v1.6.x and earlier

¢ NewsCutter v6.6.x and earlier

Workaround: Use full restore or full delivery for this media.

»  Bug Number: UDevC00130628. In a mixed environment (Interplay 2.0 engine with Avid
editing applications earlier than Media Composer 4.0, earlier than Symphony 4.0, or earlier than
Avid Newscutter 8.0), if an Avid editing application user edits a locator and checks in the clip,
duplicate locators might be displayed in Interplay Access.

»  Bug Number: no number. Interplay v2.0 does not support locators created in Avid Airspeed.

Mount Workspaces for Long GOP STP (Assist and Instinct)

»  Bug Number: UDevC00123047. If your workflow includes sending Long GOP (XDCAM HD
or XDCAM EX) media to playback, you need to do the following:

1. Log in to the Client Manager (ISIS) or Connection Manager (MediaNetwork) with an
account that has write access to one or more workspaces.

2. In the Client Manager or Connection Manager, mount at least one of the workspaces to
which you have write access as a lettered drive. (All MediaNetwork workspaces are
mounted as lettered drives. For ISIS workspaces, you need to specify lettered drives.)
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When you send to playback, the application searches the workspaces to which you have write
access and writes a temporary file to a Temp folder at the top level of the workspace with the
most free storage space. If you do not have workspaces mounted as lettered drives, you get an
error message “Unable to find a shared storage volume for media transfer.”

Relinking Offline Media for Precomputes

>

Bug Number: UDevC00116797. The term precomputes refers to the media files created when
you render an effect or title. The precomputes associated with a sequence can appear offline in
the following cases:

*  After restoring the sequence from an archive

*  After moving the media files associated with a sequence to a different workspace

To refresh the links for offline precomputes:
1. Select Reset Offline Info from the Bin Fast menu

The system refreshes the links to all of the precomputes in the project. If a sequence is
loaded in the monitor, the system automatically reloads the sequence.

Interplay Access and Force-Delete Locked Media

>

Bug Number: UDevC00117091. The “Force-delete locked media” option was introduced in
Interplay Access version 1.4.2. If you connect Access to an Interplay Engine running a version
earlier than 1.4.2, the option is visible in the Delete dialog box but does not work. If you select
the option and attempt to delete files, the files are not deleted and “access denied” is displayed in
the Delete Summary dialog box.

Workaround: In the Avid editing system, locate the clip you want to delete in a bin. If it is not
in a bin, drag and drop it from the Interplay Window. Select the clip in the bin and then select
Clip > Unlock Bin Selection. You should then be able to delete the clip and the media from
Interplay Access.

Changing Source Information for a Clip in Interplay

There are two types of source information that usually should not be changed for a master clip in
an Interplay environment:

*  Source tape name
*  Timecode format (changing between drop frame and non-drop frame)
The tape name and timecode format are part of the source information for a clip and changing

them may cause the clip to become offline whenever Dynamic Relink is activated. Once this
happens, the relation of the clip to its media can be permanently lost.
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If it is necessary to change the tape name or timecode format for a master clip in an Interplay
environment, use the procedure described in this section.
You only need to perform this procedure if both of the following statements apply:

* Ifyour site uses Dynamic Relink. If your site does not use Dynamic Relink there is no need
to perform the procedure.

» Ifyou are associating a master clip with a different tape name or timecode format. If you are
simply changing the name of an existing tape you don’t have to perform the procedure.
To change the tape name or timecode format for a clip in an Interplay environment:

1. Disable Dynamic Relink. See the Avid editing application Help or the Interplay Help for
information on Dynamic Relink.

2. Right-click the master clip in the bin and select Modify > Set Source.
3. To change the tape name, do the following:

a. Select Set Source from the Modify dialog box popup menu. The Select Tape dialog box
opens.

b. Change the source tape name. Use an existing tape name or create a new one.

4. To change the timecode format to drop or non-drop frame, do the following:
a. Select ”Set Timecode Drop/Non-drop” from the Modify dialog box popup menu.
b. Select the format and click OK.

The media will remain online at this point because Dynamic Relink is turned off.

5. Consolidate the clip to generate new media that will be associated with the newly selected
tape name. Use the following options:
- Uncheck “Skip media files already on the target drive”
- (Option) check “Delete original media files when done”
- Use the default settings for all other conversion parameters

The system generates new media files that will reference the correct tape name or timecode
format. See the Avid editing application Help for additional information on the Consolidate
command.

6. Re-enable Dynamic Relink.

7. Double-click the clip in the bin to trigger the relink. The media will be online and linked
correctly to the adjusted tape name.
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Automatic Reservation Limitations

You can set the value for automatic reservations in the Avid Interplay Administration tool using

the Editor Database Settings view. This section specifies the behavior of automatic reservations
for this release.

Automatic reservations now work correctly for the following situations:

e Ifyou duplicate metadata (such as a master clip or sequence) in the Avid editor application
bin and then check it into Interplay.

* Ifyou create new metadata such as a new sequence, subclip, or title and check it into
Interplay.

« Ifyou create new media in a bin and then check it in. This includes operations such as
import, capture, and consolidate.

Write Permission in Interplay Applications

»  Bug Number: UDevC00099462. Interplay Access has different rules for allowing a user to
modify a clip in a folder that they do not have write permission to. The rules are different from
Assist, Instinct, and the Interplay Window. For this discussion, assume the following:

« The user has been given write access in the Instinct/Assist User Settings window of the
Interplay Administrator tool. For example, the user is allowed to modify locators or to
modify column properties.

« The clip exists in at least one folder that the user has write permission to.

In Access, the system checks whether the user has write permission on the current folder. If the
user does not have write permission to this folder, the user cannot modify the asset in that folder.

In Assist, Instinct, and the Interplay Window, the system checks whether the user has write
permission to any folder that contains the clip. As long as the user has write permission to at least
one folder that contains the clip, the user can modify that clip in any folder.

Viewing Referenced Assets in Assist

In Assist, you cannot view the master clip associated with a subclip in the same folder. In the
Avid editing application and in Access, you have the option of displaying referenced assets in the
same bin or folder. You do not have this option in Assist. This is not usually a problem. For
example, if you are working with a subclip in Assist, you usually have no need to see the master
clip it was created from. You may encounter this problem if you move subclips and their
associated masterclips in and out of folders in Access. Masterclips will not be visible in Assist if
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that folder once held the same clips as referenced assets. Once a subclip goes into an Assist
folder, the display for the referenced asset is turned off. You may also receive a message telling
you the clip already exists in that folder.

To view a referenced clip in Assist:

P Inthe Avid editing application, check the referenced master clip(s) into Interplay, using the
"Show Reference Clips" option in the editing application bin.

Now the master clip is an unreferenced asset and an Assist user can view the master clip.

General

See the following ReadMe files for additional information:

*  Avid Service Framework
*  Avid CaptureManager

* Interplay Transfer

* Interplay Media Services
* Interplay Assist

*  Avid Instinct

»  Bug Number: UDevC00121515. Low-Res Encoder and Avid editing systems: If you
consolidate an MPEG 2 clip captured through the Avid Low Res Encoder, or a sequence that
uses the clip, you might get an error “Range specified for Dup is outside range of component.”
This occurs only if you use the first 2:10 of the clip.

Workaround: Consolidate the high-res version of the clip.

»  Bug Number: UDevC00106180. Interplay and Avid editing systems: If Auto-reservation is
enabled (in the Interplay Administrator), but reservations are deactivated for a particular folder
("Allow creation of reservations" is deselected in the Security options for the folder in Interplay
Access), a user on an Avid editing system can check an asset into that folder but there is no
message to warn the user that the asset is checked in without a reservation. This could be a
problem if the user assumes auto-reservation is enabled for the folder but in fact the content of
that folder is not protected.

»  Bug Number: UDevC00119218. Partial restore is not supported when OMF media or MXF
media are transcoded using an Avid editing application. A full restore is performed instead.
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Bug Number: UDevC00113195. Media Indexer Quarantine: If you use Windows Explorer to
copy a large MXF media file (larger than 1 GB) from an external drive to shared storage, the
Media Indexer may quarantine the file before it is finished copying. The problem occurs if the
Media Indexer starts scanning the drive before the copy operation is completed.

Workaround: When copying large MXF files to shared storage, do not copy the file directly to
the Avid MediaFiles\MXF folder. Copy the file to another folder on the workspace (such as the
Creating subfolder within the Avid MediaFiles folder) and then move the file into the MXF
folder. This way the copy operation will be fast enough so that the Media Indexer won’t move the
file into the Quarantine folder.

Bug Number: UDevC00113305. Media Indexer: If you try to use Windows Explorer to copy
media from a network share or any folder not indexed by Media Indexer to an indexed folder
(OMFI MediaFiles or Avid MediaFiles), you might get an Access Denied message.

Workaround: Copy the media files to the Creating subfolder (within the OMFI MediaFiles or
Avid MediaFiles folder) and then move them to the media folder.

Also, if you were able to copy media to an indexed folder and then need to move or delete the
files, or if they are quarantined and need to be deleted, you might get an Access Denied message.
Workaround: Wait a few minutes and try the operation again.

Bug Number: UDevC00121042. Assist: If you load a clip that is being captured (an
Edit-While-Capture or EWC clip), and then modify the Audio/Video Monitoring preferences
and click OK, the preferences do not persist. If you then load a completed clip, you can scrub
through the clip but you cannot play it, and you need to relaunch the application.

Workaround: Change the Audio/Video Monitoring Preferences before loading the EWC clip.
This problem does not occur if you change the Audio/Video Monitoring preferences while the
EWC clip is playing.

Bug Number: UDevC00120939. Interplay and Avid editing application): If the working
resolution is not set in the Instinct/Assist User Settings in the Interplay Administrator, the
following error message appears when you log in to Interplay: “No Working Video Resolution
Set, Dynamic Relink will be disabled.” This message is incorrect, because this setting does not
apply to an Avid editing application.

Workaround: Close the error message and continue working. To avoid display of the error
message, set the working resolution in the Instinct/Assist User Settings in the Interplay
Administrator.
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Bug Number: UDevC00118842. Edit while capture with AirSpeed Multi-Stream. If you play a
currently ingesting HD clip in an editing application, the audio might drop out while the video
continues to play. When the dropout occurs depends on the compression of the clip, but it can be
up to a minute after the live feed begins.

Workaround: Precut the clip to the head frame in the editing application and restart play.

Bug Number: UDevC00121373. Interplay Assist and Avid editing applications: In Assist,
when you apply a locator to an audio-only sequence, or to a sequence without a V1 track, the
locator appears on an empty V1 track in the Avid editing application timeline.

Bug Number: UDevC00116644. Interplay Assist and Avid Instinct: If you start the application
shortly after quitting, you might see an "Unknown Exception" error message

Workaround: Wait 10 seconds and log in again. If you still see the error message, close the
application and relaunch it.

Bug Number: UDevC00118600. Interplay Assist, Avid Instinct, Interplay Window: If you
create a subclip from a master clip with the resolution displayed as "XDCam HD 50mb 10801
60," the resolution of the subclip will be displayed in the Current Video Resolution column as
"XDCam HD 50mb."

Workaround: Assist and Instinct: If you need to determine the complete resolution for the
subclip, move the mouse pointer over the title of the clip (above the monitor) and the complete
resolution is displayed.

Bug Number: UDevC00106005. FTP ingest of 1080p 23.97 proxy files fail to import when
dragging and dropping the proxy only clip to a bin from FTPClipList.

Workaround: You can use a firewire connection to import the 1080p 23.97 proxy file.

Bug Number: UDevC00115806. Assist Locators: You can add multiple locators to the same
frame in Assist but you cannot view more than one locator in the Avid editing application
timeline.

Workaround: In the editor, click the Locator and select the Locator window from the Tools
menu.

Bug Number: UDevC00115457. Assist — You cannot use Assist to play back a sequence with
more than 16 tracks.

Workaround: Select Preferences > Audio/Video Monitoring and turn off the additional tracks.
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Bug Number: UDevC00115102. XDCAM EX and FTP Clip List — Ingest via FTPClip List
does not work correctly for XDCAM 720p 5994 EX 35Mbit.

Workaround: Imports via 1394 firewire works correctly. Also, 720p 5994 50 Mbit works
correctly for FTPClip List

Bug Number: UDevC00116120. Limitation: Dual ingest with 720p and Avid Low Res Encode
is not supported for this release because of timecode issues. The recording either fails or the
resulting media files have different timecode values.

Bug Number: UDevC00110280. On the Media Indexer server, if you change the language
locale option after you install Media Indexer and then restart the server, the MI service might
stop and restart constantly. Similarly, if you selected “Install files for East Asian Languages” in
the Languages tab of the Windows Regional and Language Options control panel and then
reinstall or update Media Indexer with an English locale selected, the MI service might stop and
restart constantly.

Workaround: Change the language locale before you install or update Media Indexer. If you
are going to use an English locale, deselect “Install files for East Asian Languages” before you
install or update Media Indexer.

Bug Number: UDevC00113671. If you increase the duration of a currently ingesting AirSpeed
Multi Stream clip in Capture Manager™, you might not be able to play the clip beyond the
original duration and you might see an error message.

Workaround: Make sure you set the initial duration of the clip to be longer than what you need.

Bug Number: UDevC00111283. When you import P2 media from a virtual volume, the system
adds a duplicate storage path for the Media Indexer. The additional path is visible in the Service
Framework Service Configuration tool.

Workaround: Open the Service Configuration tool, locate the local Media Indexer on the
editing system, and remove the extra storage location.

Bug Number: UDevC00116123. In Assist or Instinct, currently ingesting media from IPV
playback may stop after a couple a minutes or longer depending on the length of the ingest.

Bug Number: UDevC00115587. When archiving a folder which contains a sequence and it's
relatives, the job will display the sequence and each relatives as a separate transaction in the Job

Status window.

Bug Number: UDevC00111924. In Assist or Instinct, you may get play frame errors while
scrubbing currently ingesting media from Avid Low Res Encode.
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Bug Number: UDevC00105694. Custom fields from Assist do not appear in the editor bin.

Bug Number: UDevC00112360. You may encounter FILE_OTHER errors with dynamic relink
set to low res media captured by Avid Low Res Encode.

Workaround: Force quit the application using the Task Manager.

Bug Number: UDevC00107298. You may encounter "DecompStream::FillBuffer Invalid
Stream" errors in the editor with currently ingesting media from Avid Low Res Encode on Avid
Unity MediaNetwork.

Bug Number: UDevC00117478. The Archive Engine will display the incorrect size of an asset.

Bug Number: UDevC00117457. After a dual capture with Avid Low Res Encode, the low res
video may be out of sync with the low res audio.

Workaround: Use the low-res video and the high res audio for dual captures.

Bug Number: UDevC00116929. In the editor, you may encounter an error while trying to scrub
or playback currently ingesting media from Avid Low Res Encode.

Bug Number: UDevC00117286. If you import media from a P2 drive and create a sequence
with the media that is still on the drive, performing a Send to Playback operation consolidates the
media to an incorrect drive.

Workaround: Consolidate the media from the P2 drive before you send to playback.

Bug Number: UDevC00113856. If you check in a sequence that uses master clips that are
currently being ingested, then open Interplay Access, the sequence appears as partially online
(blue), although the sequence is actually online. This also applies to .transfer sequences.

Workaround: To update the status, select the items, right-click, and select Update Status from
Media Indexer.

Bug Number: UDevC00112191. Archive Restore: “No resolution found” errors after
performing a Restore from Archive operation.

Workaround: If you receive this type of error when performing a restore, right-click the clip
and select Update Status from Media Indexer, and perform the restore operation again.

Bug Number: UDevC00100643. If you connect an NLTEK drive to the same Firewire bus as

the Adrenaline hardware, the system competes for resources on the bus and video may stutter
when playing back from the NLTEK device.
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Workaround: When connecting an NLTEK drive to an Adrenaline system, connect the NLTEK
drive and Adrenaline hardware to different Firewire buses

Bug Number: UDevC00105508. When performing a “Check into Interplay for Pro Tools,” two
of the three options for Audio Mixdown do not work correctly if you apply the setting from the
Avid editor. Selecting "No Mixdown" results in a Stereo Audio Mixdown and selecting "Stereo
Mixdown" results in No Audio Mixdown. Selecting "Mono Mixdown" works properly.

Workaround: Select the option for the setting in the Interplay Administrator > Editor Export
Settings for Pro Tools view.

Bug Number: UDevC00096276. (Limitation with Interplay Media Services) Clip names
containing more than 255 characters are not supported when using Interplay Media Services.

Bug Number: UDevC00096276. (Limitation with Interplay Media Services) Clip names
containing more than 255 characters are not supported when using Interplay Media Services.

Bug Number: UDevC00099173. (Interplay Media Services) In an Avid editing application,
after you deselect and then reselect the Media Services setting "Media Services are Available,"
the list of providers in the Media Services sub-menu is not accessible.

Workaround: To provide access to the list of Media Services providers from the Avid editing
application you must exit the Avid editing application and restart it.

Bug Number: UDevC00099633. Do not use the Windows “Fast User Switching” feature in an
Interplay environment. It can lead to confusion about whether the correct drives are mounted for
each user. For example, if an Administrator logs on and mounts all drives and then switches to a
user that only has access to one or two drives, all drives will still be mounted.

Bug Number: UDevC00099012. Interplay Engine E-mail service might be unreliable if there
are too many event notices in a short time frame. Some events might be dropped. Workaround: A
large number of event notices indicates a problem, so the administrator needs to Investigate the
problem in any case.

Bug Number: UDevC00099003. Interplay Engine When the Interplay Engine server sends
e-mails, it uses the login of the Server Execution User. Make sure the mail server is aware of the
username and password of this account (usually a domain account). If not, the mail server might
reject the e-mail request. For information on email notification, see the Interplay Engine and
interplay Archive Engine Administration Guide
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Bug Number: UDevC00099458. Interplay Administrator: For best performance, a list of values
for a custom property (created in an XML file) should have fewer than 20 entries, and you should
not activate more five custom properties that use a list of values. For information on creating

custom properties, see the Interplay Engine and interplay Archive Engine Administration Guide.

Bug Number: UDevC00094813. Avid Low Res Encode Dual Ingest: If you lengthen the
duration of a dual ingest to longer than one hour after the ingest has started, the frame accuracy
between the high and low res material will be off by two frames at the original end point. This
only happens if the final duration is longer than one hour. For example, if you start a one hour
recording and then change the recording length to two hours, the high and low res material will
be off by two frames at the one hour mark. This happens each time you lengthen a dual ingest
clip that is currently recording. For example, if you lengthen the clip three times the final clip
will be off by a total of six frames.

Workaround: The problem does not happen when you shorten the duration during a record. If
you know you are going to change the length of a recording you could originally set it up as a
long recording and then shorten it after the recording begins.

Bug Number: UDevC00091738. Only applies to bootset 1660 CaptureManager dual ingest with
Avid Low Res Encode: If you change the name of a recording and extend the length of the
recording while it is in progress, the system flips back and forth between the old and new names
for the remainder the recording. The duration will also display incorrect values during the
recording. The final recorded media will have the new name and the correct duration. The
problem only happens during the recording. If you want to work with the clip before it finishes
capturing you may have trouble searching for it and if you drag the clip into a bin the duration
may be incorrect until the clip finishes capturing.

Workaround: If you change the name and the capture duration of a clip while it is still being
captured, you may have to wait until the capture is complete before you work with the clip.

Bug Number: UdevC00096607. During AutoArchive any failed archives are submitted
continuously and exceed the maximum number set by the retry setting in the Avid Interplay
Service Configuration > Service Settings > Configure AutoArchive window.

Workaround: Set the maximum number of retries for a failed job to 1. When a job fails it is
moved to the failed folder.

Bug Number: UDevC00089277. VC-1 Resolutions are not supported in Interplay v1.2.x or
Interplay v1.4.2. VC-1 support was added to the Avid editing applications at the x.8 release (for
example NewsCutter v6.8). However, VC-1 resolutions are not supported in an Interplay
environment. VC-1 is a SMPTE 421M video codec standard.
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Bug Number: UdevC00093731. Limitation When using Frame Chase Editing (EWC), if you try
to transcode subclips after the capture is complete, the transcode fails indicating the clip is still
being captured even though the master clips display “complete”.

Workaround: After the master clip of the subclip is complete, re-checkin the subclip to the
Interplay database before you start the transcode.

Bug Number: UDevC00096386. Interplay Assist Send to Playback: If you perform a “Send
Source to Playback” command on a source clip that contains restrictions, the system does not
warn you that the clip contains restrictions. Note that the system does display a restriction
message when you load the clip in the Source monitor so you are warned at least one time.

Bug Number: UDevC00093002. Installing from shared storage: At large sites it is often useful
to copy installers to a central shared storage location and run the installers from there.
Sometimes when you do this the installers may display an I/O error or complain of a bad or
corrupt file. If this problem occurs, copy the installer locally and run it or run the installer from
the Avid Interplay Installer.

Bug Number: UDevC00092387. Interplay Access license: When you use up all of your Access
licenses and try to log in, the system displays an incorrect error message. The error message
states that the evaluation period has expired. It should state that you cannot log in because there
are no more licenses available.

Bug Number: UDevC00093257. You might receive an access violation error while dragging
multiple clips from the Interplay Window into a bin. This occurs if you select an individual clip,
drag it to the bin and then repeat the process quickly.

Workaround: Select multiple clips and drag them to the bin.

Bug Number: UdevC00093580. When performing a partial restore of a large sequence, the Job
Status and progress bar displays a percentage of the completed job until the Restore Provider is
finished processing the job. The process might appear hung during this time.

Workaround: You can monitor the Restore Provider to check the job's activity.

Bug Number: . Avid Interplay v1.2 and Interplay v1.4 do not support MXF media encoded
using the VC-1 resolution and codec. The VC-1 codec was initially developed by Microsoft and
has been standardized as SMPTE 421-M. The vx.8 versions of the Avid editing applications
support editing and playback of MXF media encoded using the VC-1 resolution and codec.
Interplay does not support the resolution for this release.
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Bug Number: . Interplay Archive and Restore upgrades: Before starting the upgraded
archive/restore provider applications, delete the contents of the C:\Temp folder. Perform the task
when the archive/restore provider applications are not running. You can perform the deletion
before or after you upgrade the software.

Bug Number: UDevC00092202. If you have used the NXNServerUser.exe tool to change the
Server Execution user, the Interplay Engine installer uses the old value when you upgrade to this
release. In this case, if you don’t use Custom install and supply the correct value, you will have
problems with the cluster. For example, the cluster will not be able to fail over.

Workaround: On a cluster, use the Custom install option and make sure you supply the correct
Server Execution user when prompted. See “Checking the Server Execution User Account on a
Cluster System” on page 30.

Bug Number: UDevC00092128. Checking a Bin into Interplay while a capture is in progress: If
you check in a bin while a capture is in progress, the clip associated with the capture may not be
checked into the Interplay database.

Workaround: Perform an Update Status from Media Indexer command in Interplay Access and
the status will be correct.

Bug Number: UDevC00086972. Media Services Transcode: If you submit two transcode jobs
for the same source file, and each job uses a different provider, the transcode might fail with a
DISK FILE NOTE FOUND error.

Workaround: Try the operation again. If you get the same error message, check if the source
clip is corrupted, that your configuration is correct, and that all Interplay components are running
correctly.

Bug Number: UDevC00087103. Media Indexer: If the media indexer service does not start after
a reboot you will need to manually start it using the Avid Interplay Workgroup Properties tool.
For information on starting the service automatically, see “Additional Information for the Service
Framework Lookup Service” on page 38.

You must use Interplay Service Configuration tool to ensure that the Avid Service Starter Service
automatically restarts other services, such as the Interplay Media Indexer service. For more
information, see the Interplay Software Installation and Configuration Guide.

Bug Number: UDevC00091228. Selecting Check In All Open Bins from the Fast menu in the
bin might not check in the open bins.

Workaround: To check in all open bins, select Check In All Open Bins from the File menu.
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Bug Number: UDEV00091445. “Check into Interplay for Pro Tools” command: Automatic
renders occurring during command execution appear offline for the Pro Tools editor if the source
media is on a local drive.

Workaround: If you have a sequence that contains local media and you apply effects to it,
render the sequence in to out and explicitly select a shared Unity volume during your manual
render. After the render is complete, use the Check into Interplay for Pro Tools command.

Bug Number: UdevC00090469. Disconnect mode: If you are working on an editing system that
is disconnected from Avid Interplay (using Disconnected Client mode), you cannot create OMF
audio. If OMF is selected as the media type in the Media Creation settings, and you open the
Audio Project setting, the Audio File format is set to PCM and cannot be changed.

Bug Number: UDEVC00090431. In Interplay Assist, if you change the name of a clip and then
archive it, the original name (not the new name) appears in the Job tab of the Interplay Media
Services window. The name appears correctly in the Archive Manager and is archived correctly.

Bug Number: UDevC00091115. If you use ProEncode to encode a clip that has already been
encoded, you get a message that states that the movie file already exists and asks if you want to
overwrite it. If you answer yes, ProEncode overwrites the movie file but does not overwrite any
associated audio files. Existing audio files are saved with a version number.

Workaround: Delete the old files manually.

Bug Number: UDevC00090855. In Interplay Access, the Disk Label field does not display the
XDCam disk label.

Bug Number: UdevC00090905. The Migration Tool supports the default SQL server setup. The
tool does not support a SQL server using an instance name or port other than the defaults.

Workaround: You can either reinstall the SQL server using the default setup or run the
Migration Tool from another SQL server. To use a non-standard port number, you need to enter
the hostname in the Migration Tool using one of the following formats:

mySQLserver:4027 or mySQLserver/portNumber=4027

In this example, mySQLserver is the hostname of the SQL server, and the port number used is
4027.

Bug Number: . You cannot perform a partial restore operation with OMFI media files. If you
want to take advantage of partial restore with material that you have migrated from a
MediaManager environment, you must re-archive the material in an Interplay archive.
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Bug Number: UDevC00088720. Interplay Assist memory problems and sluggishness. If
Interplay Assist encounters .pmr files in the Avid MediaFiles folder on shared storage, it will
attempt to work with the files. This can interfere with the application’s use of the Media Indexer
to locate files and can cause Assist to have memory problems and sluggishness. The .pmr files
are used by standalone Avid editing applications (editors that are not connected to Interplay).

Workaround: Check the shared storage areas used by Assist for .pmr files. Look in the Avid
MediaFiles folder. Either delete the .pmr files or point Assist to another workspace.

Bug Number: UDevC00090952. In Interplay Assist, if you select Media > Mount Volumes, the
Scanning for New Volumes window opens and does not close. You can continue to work by
clicking in the Assist application, but the Scanning for New Volumes window stays open behind
the application.

Workaround: Mount the drives you need before you start Interplay Assist.

Bug Number: UDevC00081178. FTP Ingest of XDCAM HD 24p is not supported.

Workaround: Use the Firewire ingest method. For details, search for “Connecting the XDCAM
Device” in the Help for your Avid editing application.

Avid MediaStream™ native ingest is not supported for this release.

Bug Number: UDevC00090719. Audio clips that are online may display a partially online icon
in the bin. You can play and edit the media normally and the clips appear correctly in the
Timeline.

Bug Number: UDevC00090212. Clips captured from an Airspeed system through Capture
Manager might display the Creation Date as the completion time instead of the start time. This is
possible with clips 30 minutes or longer.

Bug Number: UDEVC00090615. Using 720p media with Assist: If Dynamic Relink is turned
on for Assist and Instinct, you cannot hear the audio portion of a 720p clip that was captured by
AirSpeed.

Workaround: Turn off Dynamic Relink for Assist and Instinct as follows: Open the Interplay
Administration tool, open the Editor Database Settings view, and select False to disable Dynamic
Relink. Note that this turns off Dynamic Relink for all Assist and Instinct users.

Bug Number: UDEVCO00088720. Avid Assist and .pmr files: If there are .pmr files present on a
shared storage workspace, Assist can have performance problems because it attempts to use the
.pmr files and Media Indexer information at the same time. Note that .pmr files are created by
standalone Avid editing applications that are not part of the Interplay environment.
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Workaround: Check the workspace for an Avid MediaFiles folder or an OMFI MediaFiles
folder containing .pmr files. Determine whether you should delete the folder or have the Assist
applications use a workspace that does not contain those folders.

Bug Number: UDevC00089372. In Avid INEWS, you cannot use the German characters “p” or
its uppercase equivalent “M” in the directory tree for folder or queue names.

Bug Number: UDevC00085343. If you run multimedia third-party software on your Interplay
Assist system, you might not be able to play video and audio, even though you can see the video
when you shuttle through.

Bug Number: UDevC00088912. If you create locators in Interplay Assist and then update them
in an Avid editing application, the locators don't update within Assist even if you press F5 to
refresh the application.

Workaround: Workaround: Reload the shotlist to see the updated locators.

Bug Number: UDevC00086432. Dynamic Relink, FlightPlan, and 720p 59.94 and 50 media:
The audio can go offline for these resolutions if you have dynamic relink turned on and set to the
default “if no match is found, Relink to Offline”. This only happens when you use FlightPlan to
transfer Airspeed-captured media to a bin.

Workaround: If the audio goes offline in this case, change the Dynamic Relink setting to
“Closest Media”. Then right-click the clip in the bin and select “Update from Interplay” to
update the clip.

Bug Number: UDevC00085624. Checking out a sequence while the original sequence is loaded
in the source monitor might crash the Avid editing application. This only happens if you have the
sequence loaded and are in either Effects mode or Color Correction mode.

Bug Number: UDevC00081218. ProEncode Provider disk full errors: You might have to restart
the ProEncode provider and Telestream FlipFactory™ systems if jobs fail due to a lack of disk
space. Even if you make room on the disc, the jobs will fail until you restart the systems.

Workaround: As part of your normal disk management operations, periodically check the size
of the following folder:

Program Files\Telestream\FlipFactory\http\Media

Telestream copies work files to this folder and does not automatically delete them. Periodically
delete the files in this folder.

Bug Number: UDEVC00078370. Sequence with Color limiter effect on filler might crash Avid
Assist.
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Workaround: Render the effect in the Avid editing application.

Bug Number: UDEVC00080383. Cannot save Boris Effects templates to bin after checkout
from Interplay.

Workaround: Save the template to a bin before checking the sequence into Interplay.

Bug Number: UDEVC00054142. Bin display settings for the Interplay Window do not persist
when changing folders.

Workaround: You can select the media search tab and then go to the bin menu and select Set
Default Interplay Window Display. However, by doing so, you change all folders views within
interplay.

Bug Number: UDevC0081331. The Interplay Media Services status window is not reliable
when you submit a ProEncode job that performs several encode jobs (for example, convert one
source file to .mov, .wmv, and .mp4). The following problems occur:

*  The status bar might turn green before all of the encode jobs are completed.
* Even if one of the subsequent encode jobs times out and fails, the bar stays green.

*  The status bar might hang at 100% yellow indicating that an encode job is not finished, even
though ProEncode has moved on to process the second job. Then it might turn green before
all the jobs are complete.

Workaround: Do not create monitors in Flip Factory when you are creating profiles for
ProEncode. If ProEncode is processing the job and Flip Factory picks up the same job, a conflict
can occur.

Bug Number: UDevC00078381. Transcode with Interplay Access: You cannot use Interplay
Access to transcode a motion effect clip. Access does not display the Transcode option for
motion effect clips.

Workaround: Use the Bin > Consolidate/Transcode command in the Avid editing application.

Bug Number: UDevC00079824. AutoArchive: If you attempt to perform an AutoArchive
operation with a profile that does not exist, the system returns the following error: “Unable to
start job...ProviderException: 20...Parameter missing...” This can happen if you assign a profile
to an Autoarchive folder and then delete the profile later on.

Workaround: Assign or create a new profile for the autoarchive folder.

Bug Number: UDevC00078380. Media Services Transcode: You cannot use Media Services
Transcode to transcode a motion effect clip. The system displays the error “Invalid Media Type.
Transcode Failed.”
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Workaround: Do one of the following:

P Use the Bin > Consolidate/Transcode command in the Avid editing application to transcode
the motion effect clip.

p Transcode the source master clip that makes up the motion effect using either Media
Services or Avid editor transcode.

Bug Number: UDEVC00050258. If you restart the Media Services engine while the Archive,
Restore, or Transcode providers are running, the services do not start up automatically, even if
you have configured them to do so.

Workaround: Quit and restart the services.

Bug Number: UDEVC00051583. Checking in a Duplicate clip with a restriction: If you create a
duplicate of a clip that contains a restriction, and then check the clip into the Interplay database,
the red triangle doesn’t automatically appear on the duplicated clip.

Workaround: Click the duplicated clip in the Interplay Window (to set focus to the window)
and press F5 (to refresh). The red triangle appears.

Bug Number: . Custom Metadata fields: If you create custom metadata fields in the Interplay
Administrator, Interplay Access, or Interplay Assist, you cannot delete them or turn them off for
this release. However, you can now turn off the display of individual custom metadata fields. See
the Avid Interplay Access User’s Guide for more information.

Bug Number: UDevC00090853. 720p — 220/185x Rolling Crawling Titles and Dynamic
Relink: When using 720p — 220/185x, you cannot use the “relink to offline” and “specific
resolution/dnx220x” Dynamic Relink settings with a rolling title that is more than two pages
long. The system displays a wrong format error when you load the title in the source monitor.
The title becomes corrupt and must be recreated.

Workaround: Turn off Dynamic Relink and recreate the title media. The problem does not
occur if you use the “Use Closet Media” value in the “if no match is found” setting.

Bug Number: UDEVC0051900. Rendered titles show two resolutions in Interplay Access. This
is as designed. When the Avid editing application renders a title, it creates two media files: one in
the target resolution, and a second in MXF 1:1 resolution. When you check the title in to Avid
Interplay, both media files are checked in. Interplay Access lists the MXF 1:1 resolution as the
current video resolution. When you delete a rendered title from Interplay Access, select both
resolutions.
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Bug Number: UDEVC0025865. If you perform a Bin View Save As operation for a bin that
contains resolution columns, the resolution columns are not saved. Any other columns you saved
will work correctly. When you apply that Bin View to another bin, the system displays the
following error message:

“One or more columns in the view are not relevant in this kind of project and will not be
displayed.”

Workaround: Manually add the resolution column to the bin.

Bug Number: UDEVC00052480. Batch Import of files containing Alpha: This problem occurs
if you want to batch import files in SD and HD formats and then use Dynamic Relink to switch
between the different formats. The problem occurs with QuickTime movies, graphics, and
sequences that contain alpha. You can batch import the files and relink to the different formats,
but if you exit and then restart the Avid editing application, you can no longer relink to the HD
format. The system displays an “Exception: NO Compressed Data Format found” error message.

Workaround: You cannot use Dynamic Relink with HD and SD clips that contain alpha.
Import the HD files with alpha as individual clips. When you want to switch to HD format, edit
the HD versions into your sequence.

Bug Number: UDEV00230928 UDevC00026052. XDCAM HD imports: If the Avid editing
application is using more than 40% of available memory, importing XDCAM HD low-resolution
proxy clips into a bin might fail with a bad allocation exception error message.

Workaround: Close some bins to free up memory (especially bins containing many objects).
You can view the memory usage in the Bins tab of the Project Window.

Bug Number: . In Avid Interplay Assist and iNEWS Instinct, avoid displaying more resolution
columns than you need. The system frequently updates the status in the resolution columns and
having too many active can affect performance. Sequences can be especially slow to update
when there are many resolution columns. Once columns are displayed, they continue to impact
performance for that session even if you hide them. If you reduce the number of resolution
columns and save the column layout, you won’t see a performance improvement until you restart
the application.

Bug Number: UDEV00225692 UDevC00024104. Folders containing assets marked with
reservations appear in Interplay Assist, Instinct, and the Interplay Window with the reservation
marker, but the individual asset type icons in the Research panel do not display the marker.

Bug Number: UDEV00218247 UDevC00024136. Delete dialog box naming conventions:
Some of the naming conventions in the Interplay Access Delete dialog box do not match the
resolution names in the Avid editing application bin. For example, the following list shows some
differences.
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Media Composer bin Delete dialog box

Dnx145 DnX HD 6:1

1:1 Uncompressed
DVCPro HD DVCPro HD 9:1
Dnx220 DnX HD 4:1

Windows User Account Requirements
The following limitations exist for Interplay:

»  Bug Number: UDevC00052215. Avid editing applications such as NewsCutter, Media
Composer, and Symphony that are part of an Interplay environment can use a regular Windows
User login. However, when you install the application you must first log in as an Administrator,
install the application, and initially launch the application as an Administrator. See the Avid
editing application Readme for details.

»  Bug Number: UDevC00088970, 89118. Avid Assist and Avid Instinct have similar limitations:
When you install the application, you must first log in as an Administrator, install the
application, and initially launch the application as an Administrator. You may then subsequently
run the application as a regular User.

»  Bug Number: UDEVC00098723. Regular Windows user login and Media Creation tool: When
you select Auto-Indexing in the Avid editing application Media Creation tool, the system creates
duplicate storage items in the Media table for the local Media Indexer. This can happen every
time the Media Indexer scans the local storage drives or P2 drives. If it continues to occur the
Media Indexer can become unresponsive and you could get Media Offline messages.

Workaround: To determine whether you are experiencing this problem, open the Service
Configuration tool, select the editing system, and then select the Media Indexer process. Click
Configure, and see whether there are duplicate entries for your local storage locations. If there
are duplicate entries, delete the duplicate entries and do one of the following:

«  Periodically check the Service Configuration tool and delete the duplicate entries
* Log on as a Windows Power User or Administrator.

» Disable the auto-indexing feature. Instead, click on "Manual scan" every time changes are
made to the drives available to the editing system.

»  Bug Number: . In Avid Unity MediaNetwork, do not use the same login to log into Windows
and to log into the Connection Manager for Avid Unity.
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Bug Number: UDEVC00089275. Changing Users on MediaNetwork Fibre attached clients:
When you change users on a fibre attached client, do not use the Switch User function in the
Windows Log Off dialog box. When you log back in as the original user you may get the
following errors when you play media:

Exception: FILE_OTHER, filename:... Exception: SYS_ERROR, status:1317, msg:The
specified user does not exist.

Workaround: To fix the problem once it occurs, reboot the system. To avoid the problem,
before you switch users, log off completely and reboot the system.

Clips from the Same Tape That Have Overlapping Timecode

>

Bug Number: UDevC00055238, UDevC00055241, UDevC00055244, UDevC00055249. This
section describes several limitations that involve clips from the same tape that have overlapping
timecode. The problem is most evident when the two clips are captured at different resolutions.
This can happen when you do the following:

1. Use the Capture tool to capture a clip.
2. Change the capture resolution.

3. Back up the tape a little, and start capturing again at the new resolution.

Now you have two clips and two separate media files. The end of the first clip and the start of the
second clip share the same timecode.

You see the following problems with these clips:

* In the Interplay Access Object Inspector, each clip displays as a separate media file, each at
its captured resolution. However, the Avid editing application sees the clips as sharing
media. If you display the clips in an editor bin and display column headings for both
resolution types, both clips show at least a partially online status for each resolution.

» Ifyou send the low-resolution version of the clip to Media Services Transcode, the system
uses the high resolution for the Transcode. This produces a higher-quality result but takes
longer than transcoding a low-resolution version.

« Ifyou delete the media from the first clip and then load the clip into the editor Source
monitor, you see the media from the second clip. However, if you attempt to Transcode the
clip, you get an error message because the actual media for the clip has been deleted. This
can be confusing because you see an online version of the clip but can’t transcode it. The
clip is linking to a different media file in the editor Source monitor but the media is not
associated with the metadata for the clip.

In this last scenario, if you look at the clip in the Interplay Access window, you see a red X that
indicates that the media is not available. There is no corresponding display in the editor bin.
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Disabling the Onboard NIC on an HP xw8400 Causes System Instability

UDevC00055194 The Avid Interplay Software Installation and Configuration guide contains the
following information:

Computers with Multiple Network Interfaces

“If you have multiple network interfaces on a computer and one is not used, use the Device
Manager to disable the interface. If not, the computer may have problems communicating with

the Service Framework Multicast Repeater.

“«“

The following information should be added to that section regarding the HP xw8400:

Do not use the Device Manager to disable the onboard network interface card on an HP xw8400.
Doing so could cause intermittent hard hangs (no keyboard input or mouse movement) or other
system instability such as unexpected reboots. Instead, use the following procedure.

To disable the onboard network interface card via the BIOS:

1.
2
3
4,
5
6
7

8.
9.
10.
11.

Boot, or reboot, the system

. Press the F10 key when prompted to enter BIOS setup

. Choose your preferred language when prompted to enter Setup.

Once into the BIOS, use the right arrow to navigate to the Security Menu

. In the Security Menu, select Device Security
. In the Device Security selection window, use the down arrow to select the Network Adapter.

. Use the right arrow to change the option to read “Device Hidden” instead of “Device

Available.”

Press F10 to save your setting change.

Press F10 again to get to the Save Changes and Exit prompt.
Press Enter to select Save Changes and Exit.

Press F10 to Save and Exit.

International Character Support Limitations

>

Bug Number: UDevC00163794. Receiving workgroup transfers from a remote workgroup to a
workspace containing Chinese characters can fail. The transfer fails with a kNetwork error.

Workaround: When using Workgroup transfers, ensure that the name of the receiving
workspace does not contain Chinese characters.
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Bug Number: UDevC00148244. (Archive) In an SGL archive environment, you cannot archive
transcoded media that contains Japanese characters in the name. The .mxf files created have
Japanese characters in their names. To archive the files, underscores must replace the Japanese
characters.

Workaround: Do not use Japanese characters in the clip name when you transcode. Add
Japanese characters to the clip name after you transcode, or use ASCII characters.

Bug Number: UDevC00149617. (Avid editing systems) A sequence name is limited to 128
characters in Chinese.

Bug Number: UDevC00149616. (Interplay Access and Interplay Administrator) Drop-down
menus for selecting custom properties do not display multibyte characters after importing an
XML file containing multibyte characters.

Bug Number: UDev00089590. Workspace names: Workspace names that contain non-ASCII
characters can cause poor performance when working in a bin.

Workaround: Use only ASCII characters in workspace names.

Bug Number: UDevC00089671. Workspace names in Asian characters might appear truncated
at the end in any drive-selection list.

Workaround: Workaround: When using Asian characters, use no more than 10 characters for
workspace names.

Bug Number: . Archiving does not support ICS for this release.

Bug Number: UDevC00052231. If you enter Asian characters as restriction information, the
characters might appear as question marks when you view that restriction in another Avid
application.

Bug Number: UDevC00051974. If you capture a clip from a workspace with a French name
through CaptureManager, in the Avid editing application the bin heading Drive might be empty
where it should list the French name of the workspace.

Bug Number: UDevC00051060. If you change the font or font size of your input, and see
characters rotated 90 degrees, make sure you select the correct font. Do not use any font that
begins with the “@” symbol.

Bug Number: UDevC00052541. Do not create a Project using the Euro currency character

(ALT 0128). The Project fails to be created and a “Can't Open Project” error message is
displayed.

120



>

>

Limitations

Bug Number: UDevC00022395, 22346. Certain Asian characters might not appear in the
correct order in some text boxes in your Avid editing application.

Bug Number: UDevC00078651. Use only ASCII characters in passwords.

Interplay Access Limitations

>

Bug Number: none. Compatibility with prior versions: The Interplay Engine or Interplay
Archive Engine and the Interplay Access client must be updated at same time. Interplay Access
clients will not work with older Interplay Access Engines or Archive Engines and vice-versa.

Bug Number: UDEVC00035172. Multi selection drag and drop issue when one file asset
already exists in target folder: When a multi selection is dragged and dropped and one of the file
assets exists in the target folder already, no files are moved and the results are not as the user
would expect. This is the result of a rollback of the transaction and appears as follows:

*  Red check marks (indicating a check out) turn blue. The checkout path has already been
moved to the new location, so when the file is moved back to the original location but the
checkout path is not updated again, the check mark appears blue. These items can be
checked in again safely.

*  The local copies of not checked out assets seem to be deleted. The local copy of the asset is
not actually deleted, it is just not moved back to the original location.

* The file that exists in the target keeps its local copy.

Bug Number: UDEVC00039014. Working in a folder during an import causes problems: When
performing a large import, working in the same folder you are importing to might cause
problems with the import. You might be prompted to refresh your view, in which case the import
was successful. In other cases, a message indicates that the import failed and you need to
perform the import again, without touching the folder.

Bug Number: UDEVC00038766. Get latest on extremely large folder causes problems for user
Administrator: When the user Administrator performs a Get Latest on a folder that contains
assets in number approaching 50,000, a potential problem might occur; the client slows down,
but the operation actually continues. If the client reaches the free memory limit, a corresponding
message is shown and the operation is cancelled. This does not occur if another user (not
Administrator) has performed a Get Latest on the same machine already.

Workaround: Users should perform a Get Latest on the smallest range of items possible, such
as a subfolder.
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Bug Number: UDEVC00039061. Internally used file name appears for Avid Assets renamed to
blank name: If a blank name or only spaces is entered in the Rename dialog for an Avid asset, the
internally used file name (mob id) appears as the name instead (long string of numbers and
letters).

Bug Number: none. Tree state is only remembered on the same machine: The tree state upon
logout is remembered the next time you log onto Interplay only on the same machine (stored per
user, per machine).

Bug Number: UDEVC00007386. Issues with preview of large text files: Text files over IMB
are not shown in the Preview by default, however, if you explicitly click the Show File button for
these large files, low memory problems may occur.

Interplay Administrator Limitations

>

Bug Number: UDEV00210720, UDEVC00037618. Limited number of clients per user per
machine: Only one Interplay Access instance and one Interplay Administrator instance can run
at a time on one machine per user. This software will not support terminalserver sessions.

Bug Number: none. Low disk space issues: In low-disk-space situations, the Administrator
cannot log on and shut down the server, and move databases by normal means. There are tools
provided to solve such problems (available in the Installation CD’s Tools directory or installed
by default in the Server installation directory):

¢ NxNServerLock.exe
¢ NxNServerUnlock.exe

¢ NxNServerShutdown.exe

To move databases under low disk space conditions:
1. Lock the server using NxNServerLock.exe.
2. Shut down the server using NxNServerShutdown.exe, if necessary.
3. Move the databases to another drive or free up some disk space.
4. Unlock the server by doing one of the following:

- Use the Interplay Administrator’s Lock Server view (see the Avid Interplay Engine and
Avid Interplay Access Administration Guide for details)

- Use NxNServerUnlock.exe
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5. Deactivate any moved databases using the Interplay Administrator’s Manage Databases
view (see the Avid Interplay Engine and Avid Interplay Access Administration Guide for
details).

6. Activate any moved databases in the correct location using the Interplay Administrator’s
Manage Databases view (see the Avid Interplay Engine and Avid Interplay Access
Administration Guide for details).

Bug Number: UDEVC00039474. Passwords should only include ASCII character set: User
passwords should only include the ASCII character set. Multibyte passwords might cause logon
problems.

Workaround: If logon with a multibyte password fails, the administrator should reset the
password in the User Management view of Avid Interplay Administrator.

Bug Number: UDEVC00006908. Limitation: Browse for new data location does not show
mounted workspaces on Avid ISIS in the tree: In the Create Database view in the Interplay
Administrator, when you click Browse in the New Data Location (Assets) section, the mounted
workspaces on a Avid Unity™ ISIS® shared storage might not be shown.

Workaround: Type the path manually.

Bug Number: UDevC00007123, UDEVC00039984. Voice over target workspace field says
“No Items to Show”: An administrator logged in to the Avid Interplay Administrator may see
“There are no items to show” in the Editor Database Settings view in the field Voice over target
workspace field instead of the drives. This is intended behavior: the administrator must also be a
Avid Unity user with the same credentials in order to see the workspaces of the Avid Unity. If the
workspaces are not visible, check that:

*  The user is a user on the Avid Unity.

e The user has the same password as the user on the Avid Unity.
*  The Avid Unity is reachable.

* The user is allowed to see the workspaces.

*  There are actually workspaces at all.

Configuring Remote Workgroups

>

Bug Number: UDevC00051760. In order to use the Configure Remote Workgroup view in the
Interplay Administrator tool, you must have matching Administrator accounts on both
workgroups. The accounts must have the same user names and case-sensitive passwords. For
more information on user names and passwords, see the Avid Interplay Software Installation and
Configuration Guide.
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Archive and Restore

>

Bug Number: UDEVC00052832. Archive Provider: Windows Message Queuing software must
be enabled on the Archive Provider. If you perform a clean install on a system that will run the
SGL FlashNet client, you must enable the Windows Message Queuing software. This applies to
any system running the Interplay Media Services Archive Provider. If the Windows Message
Queuing software is not running, jobs fail to archive. For details, see the Interplay Media
Services Readme.

Bug Number: . Archive Provider: The Archive Provider also requires the SQL Native client
software. This is usually installed and configured by your SGL representative. For more
information, see the Interplay Media Services Readme.

Avid Low Res Encode

When you are using Avid AirSpeed and Avid Low Res Encode to perform a dual ingest, it is
important that you lock your video signal to your timecode source. For example, you can connect
a video feed and a Time of Day timecode device into a sync device to lock the incoming video
and audio with timecode.

It is also important that the two capture devices are in sync. If the captured high-res video and
low-res video are off by a few frames, you should delay the video signal going to one of the
capture devices in order to ensure that the two video signals match.

Bug Number: . An Avid Low Res Encode system can capture a clip up to four hours in length.

Bug Number: UDEV00226140 UDevC00039921. You must specify a valid NTP time server
when configuring an Avid Low Res Encoder. You can specify the NTP servers in the Avid Low
Res Encode web page configuration. Many of the commands that are issued from the
CaptureManager server to the Avid Low Resolution encoder are based on the system time of the
CaptureManager clock. If the two clocks drift far enough apart, the Avid Low Resolution
encoder-received commands could be interpreted as being too early or too late to be performed

properly.

Bug Number: UDEV00220820 UDevC00039193. Dual IPV and AirSpeed ingest: The first
second and the last second of the capture are offline.

Bug Number: UDEV00221170 UDevC00023600. Instinct and low res MPEG2 media: In the
Instinct Research panel, you can edit the information in the MPEG2-MPML352x250 & 288
column. The system should not allow you to write in this column. Normally there should just be
a dot in the column indicating whether the resolution is online or offline.
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Bug Number: UDevC00089384. When performing a dual ingest with CaptureManager and
Low Res Encode, you will occasionally get more low res frames than high res frames.

Workaround: Ifthe CaptureManager cannot sync exactly with the Low res Encode system, it
may intentionally capture additional low resolution frames. This ensures that you will be able to
link the high resolution media with the correct amount of low res media.

Checking in Avid Assets

>

Bug Number: UdevC00092889. When creating and checking in a clip or finding a clip in the
Avid editing application's Interplay Window, if the clip name contains a slash (\ or /), the
application hangs for about one minute then returns to normal.

Workaround: Remove the slash from the clip name.

Bug Number: UDevC00089019. Checking in bins with deleted clips: When you check in a bin,
the Avid editing application determines whether clips need to be checked in based on whether
you have modified them or added them to the bin since the last check in. If clips have been
deleted from Interplay since the last check in, checking in the bin will not check in the deleted
clips again. You need to force a check in of the deleted clips. To force a check in, select the clips
and then select Check In To Interplay from the File menu or bin context menu. To force a check
in of an entire bin, select all clips in the bin and select Check In to Interplay.

Bug Number: . When you check a large sequence into the Interplay database from the Avid
editing application, the check in can take several minutes. The system provides an initial
progress bar to let you know that the checkin has initiated and that you can now get back to work
with the application. However, there is no additional indication to tell you when the checkin has
completed. This can be a problem if you check in a large sequence or a bin with many sequences
and you don’t see it appear right away in the Interplay Window.

Workaround: Ifyou check in a large sequence and it doesn’t appear right away in the Interplay
Window or Access, return to the window in a few minutes to see if the checkin has completed.

Deleting Files from the Interplay Database

>

Bug Number: UDevC00025736. Try to schedule large file deletions (for example, over 300 GB)
during off hours. A large delete operation can slow down the response time on the Avid Interplay
Engine. This also slows down the response times on Avid editing applications that are working
with the Interplay Window.
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Bug Number: . If you create shared media using a local bin, and later delete that media without
ever checking the clips into the Interplay Window, the clips’ metadata is not deleted from the
“Unchecked in Avid Assets” folder. An administrator can delete this metadata as part of normal
system maintenance. This only happens to clips that have not been checked in to a folder in the
Interplay window.

Dynamic Relink and Clips with Pulldown

>

Bug Number: . Dynamic relink is not currently supported for media that requires pulldown.
Therefore, you can only use it with clips where the media has been acquired at the native frame
rate (without pulldown).

Dynamic Relink and Mixed Frame Rates

>

Editing

>

Bug Number: . All resolutions that are eligible for dynamic relink must use the same frame rate.
For example, you cannot dynamically relink a 30i master clip in the Timeline to 24p media. You
can, however, dynamically relink a 30i master clip to a 10801/59.94 master clip.

Bug Number: UDevC00083980. Viewing media folders in the Interplay database from Assist,
Instinct, and Interplay Window: Occasionally when you launch Assist, Instinct, or one of the
Avid editors, the following occurs:

* In Assist and Instinct, no media folders are visible in the Directory panel.
* In the Avid editing application, no project folders are visible in the Interplay Window.

Workaround: Restart Assist or Instinct. For the Avid editing applications, log out of the
Interplay Window and log back in.

Bug Number: UDEVC00021278. Transcoding Titles: You cannot transcode the titles in a
sequence to another resolution. If you transcode a sequence with a title in it, the sequence is
transcoded but the title is not transcoded.

Workaround: Recreate the title in the new resolution or reimport the original matte key.

Bug Number: UDevC00025855. Creating subclips - After you drag a clip to a local bin from the
Interplay Window, you cannot use the simple drag-and-drop method to create a subclip. The
simple drag-and-drop method involves loading the clip into the monitor and then dragging it
from the monitor to the bin.

Workaround: Alt+drag the clip from the monitor to the bin or use the Subclip button.
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Bug Number: UDevC00036994. Deleting media from a master clip might not update the
online/offline status of the associated group clips or subclips in Interplay Access.

Workaround: Return to the Avid editing application bin and check the group clip in to
Interplay Access again by dragging it into the Interplay Window.

Bug Number: UDevC00021148. When you search for non-alphabetic characters in clip names
in the Interplay Window of an Avid editing application, the search results might not be accurate.

Workaround: Searching in Interplay Access finds the non-alphabetic characters correctly.

Bug Number: UDevC00024672. If you drag an unnamed clip into the Interplay Window in an
Avid editing application, the clip might appear in the Interplay Window with no name or with its
original name and might appear in Interplay Access with a numeric name.

Workaround: Name clips before you drag them into the Interplay Window.

Bug Number: UDevC00052609. Editing apps If you import a graphic from your local drive into
a project in an Avid editing application, change the original name of the clip to a name of your
choice, and check that clip into a folder in the Interplay Window, the new name does not appear
in the Interplay Window even when you refresh the window. You see only the original name.

Bug Number: UDEV00217606 UDevC00023944 Editing Apps. In the Avid editing application,
the Record Track monitor buttons might be deselected if the following happens:

1. On System 1, you create a sequence and check it into a folder in the Interplay Window.
2. On System 2, you check out the sequence and load it into the Timeline.
3. On System 1, you edit the sequence and check it into the Interplay folder again.

4. On System 2, you refresh the Interplay window then check out the same sequence again.

Workaround: Select the Record Track buttons again.

Bug Number: UDEV00216346 UDevC00023435 Editing Apps. If you consolidate a MultiRez
master clip at a particular resolution, and either drag it into the Interplay Window or check it into
Interplay Access, it might be available at only the resolution you had set when you consolidated
the clip.

Bug Number: . The Avid editing applications might encounter the following errors using
AVX™ plug-ins:

*  Running out of memory with AVX plug-ins

¢ Check-in and check-out errors with sequences containing AVX plug-ins

¢ Unable to render AVX plug-ins
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Bug Number: UDEV00215167 UDevC00023009 (as designed) . Avid editing application: The
OMF" option is not available in the Media Creation settings on a system that is part of an Avid
Interplay environment.

Edit While Capture (Frame Chase Editing)

>

Bug Number: UDevC00086768. You may see the following error message when loading a clip
captured by Frame Chase capture in the editor:

“Error encountered during relink process: New track length does not equal original track length.”

Workaround: In the editing application, right click the clip and sequence and select Update
from Interplay. In Assist, refresh the clip from the Interplay database by selecting the clip and
pressing F5.

Bug Number: UDevC00080038. When you perform a Frame Chase capture of a DNxHD 45
clip, the master clip displays incorrectly in Interplay Access as 1080 36.

Workaround: The clip is still useful as DNxHD 45. Subclips created from the masterclip show
as DNxHD 45. The clips show the correct resolution in the Avid editing application.

Bug Number: . You cannot perform a Send to Playback operation while capturing from
AirSPACE.

Workaround: Wait until the capture is complete and then do the Send to Playback.

Bug Number: UDevC00035776. Frame Chase Editing: The system returns a Disk Space Error
if you attempt to perform a workgroup transfer on a sequence that contains a clip that is currently
being captured.

Workaround: Wait until the system finishes capturing the clip, and then perform the workgroup
transfer operation.

For more information on Frame Chase Editing, see the Avid Interplay Transfer ReadMe.

Folder Limitations for the Interplay Database

>

Bug Number: none. It is important that you do not store more than 20,000 assets in Interplay
database folders. In general, you can keep up to 5,000 assets in a folder without affecting system
performance. One of the problems with storing many assets in a folder is the amount of time it
takes to list the items in the folder when you open the folder for browsing.
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Periodically check that folders do not contain more than 5,000 assets. Delete or move assets to
other folders. If a folder must contain a large number of assets it is more efficient to add multiple
subfolders for storing the assets. For additional information, see see the Best Practices Guide.

This limitation also applies to ingest folders. If you know that you will have recurring ingests,
you could set up folders for those ingests. For example, you could name folders for the days of
the week or for specific types of ingest.

Film Projects

»  Bug Number: UDEVC00080131. Media Services Transcode does not support progressive film
resolutions.

Workaround: Use the Consolidate/Transcode command in the Avid editing application.

You can use Media Services Transcode to transcode progressive HD resolutions 720p and 59.94.
Those are not film resolutions.

»  Bug Number: UDevC00025645. Editing Apps In a film project, if you capture a clip at one
resolution and then try to batch capture it at a different resolution, the media is not deleted and
the clip links to only one resolution (dynamic relink is not available for film projects). This can
cause orphan media files.

»  Bug Number: UDevC00083571. If you have film projects and non-film projects on the same
Interplay database, do not check film clips into the non-film projects. For example, the following
scenario causes problems:

1. Check a film clip that contains audio and video into an 23.976 NTSC project.
2. Check the clip out and then check it into a 23.976 NTSC 35mm 4 perf project.
3. Check the clip out to the film project.

In this scenario, the system strips away the video.
Importing File Assets

»  Bug Number: UDevC00038006. If you check a Marquee™ Settings File (*.mqp) and/or an
Image File (e.g., PNG, JPG, PCT, TIFF, PSD) into Avid Interplay Access, you can’t drag the
newly created asset into a bin.
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Workaround: Do the following:

1. Select the graphics file in Interplay Access and then select Get Latest from the context menu.
The file is copied to the working path on the local drive.

2. Use the Avid editing system's Import feature to import the graphic from the working path.

For more information, see the Avid Interplay Access User's Guide.

Media Indexer

>

Bug Number: . For important installation information, see “Additional Information for Media
Indexer” on page 38.

Bug Number: UDevC00085031. Assist: If you start Interplay Assist while the Media Indexer
that monitors shared storage is not available, Assist displays the following error message:

A program error has occurred. If you need assistance record the following information and call
Avid costumer support. Error assertion failed m_pointer

Workaround: Make sure that the Media Indexer is online and correctly identified in the
Interplay Administration tool Server Hostname Settings view. Then restart Interplay Assist.

Bug Number: UDevC00017894 as designed. Media Indexers that are part of a redundancy
group must all be on the same subnet or VLAN. You can use the Service Framework Unicast
Discovery feature to communicate with Media Indexers on different subnets or VLANS.
However, if the Media Indexers are part of a redundancy group, they must be on the same subnet
or VLAN. See the Interplay Software Installation and Configuration Guide for details on
Unicast Discovery.

Migration from MediaManager to Interplay

The MediaManager to Interplay Migration tools and related documentation are available on a
separate CD. See your Avid representative for more information.

Bug Number: UDevC00040002 as designed. Some master clips and subclips imported from a
MediaManager environment (also known as Workgroup 4) might appear offline or partially
offline.

Workaround: Open an Avid editing application, locate the clips in the Interplay Window, and

drag the clips to a bin. Then check the files back into the Interplay Window. The clips should
now appear online.
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MultiRez

>

Bug Number: . The following features are not available for this release:
¢  Multirez relink by tape name and key number.

*  Multirez support for pre-Interplay precomputes. This means that if you bring existing
sequences into an Interplay environment, you must rerender effects.

*  Media files created by rendering effects (precomputes) are not dynamically relinked. If you
render effects when they are linked to target settings and then switch back to working
settings, the rendered effects will be lost. You can create effects in either mode, but render
them only when they are linked to target settings as the last step before output. Render
effects in the target resolution only as the last step before output.

Send to Playback

>

Bug Number: UDevC00058307 Limitation. When you send media to playback, the Send to
Playback dialog box lists two separate bit depth settings: the Target Audio Resolution Bit Depth
in the Relink Settings (Input) area, and the Bit Depth in the Audio Mix Settings (Output) area.
The Relink Settings indicate the audio bit depth of your target resolution as set in the Interplay
Administrator. The Audio Mix Settings match the bit depth settings of your playback device.
Since the audio bit depth used by your media must match the bit depth settings of your playback
device, your audio bit depth might be converted twice during the send-to-playback operation,
first to the bit depth of your target resolution and then to the bit depth of your playback device.

For additional limitations and information on Sending to Playback, search for “playback” in this
Readme. Also see the Assist ReadMe and the Interplay Transfer ReadMe.

Send to Workgroup

>

Bug Number: UDevC00081706 Limitation. MediaManager to Interplay Transfer: To perform
transfers from a MediaManager workgroup to an Interplay v1.1.x environment, you must have
MediaManager v4.5.12 or higher and the related software versions (referred to as Bundle 10a).

Workaround: On MediaManager v4.5.10 (Bundle 9), you can use the Avid editing applications
to perform the transfer. You can’t use Interplay Access to perform the transfer on MediaManager
v4.5.10.

Bug Number: UDevC00020533 Limitation. If you select multiple items to transfer to another
workgroup, the system might perform more transfers than you expect. For example, if you select
three clips and each has two resolutions online, the system performs 6 transfers, one for each
resolution.
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Workaround: Use the resolution bin columns in the Avid editing application so you can tell
how many resolutions are online for clips that you want to transfer. Then you can select all of the
clips that you want to transfer at a particular set of resolutions. When you transfer multiple clips
in this way, the system displays a dialog box that allows you to choose the resolutions that you
want to transfer. If you have performed a lot of transcode or redigitize operations, there might be
a large number of resolutions associated with a particular master clip.
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